Network Video Recording Software
RM Series

Administrator Manual

Make sure you read this manual before using the software.
For support information, including software updates (patch installer),
user manuals, and operating environments, see the Canon Web site.

ENGLISH

Thank you for purchasing RM-64/RM-25/RM-9 v3.2
Network Video Recording Software (hereafter referred to
as “RM-64/25/9” or “this software”).
This manual also explains how to use RM-Lite v3.2
Network Video Recording Software (hereafter referred to
as “RM-Lite”). For the difference between RM-64/25/9 and
RM-Lite, see “About RM-Lite” (p. 34).
Please read this manual before using the software. After
reading this manual, keep it in a safe place for future
reference.
Some cameras are not sold in some countries or regions.
In addition, please read the license agreement before
using the software. The license agreement can be found
in the LICENSE folder on the setup CD-ROM.

Request to Customers
1.
2.
3.

4.

All rights reserved.
The contents of this manual are subject to change
without any prior notice.
This document has been prepared with the utmost
attention to accuracy. If you have any comments,
however, please contact a Canon sales
representative.
Canon shall assume no liability for any outcome of
using this product, regardless of Items 2 and 3
above.

Disclaimer
Flaws or other problems with this software may result in
recording failure or destruction or loss of recorded data.
Canon shall have no liability whatsoever for any loss or
damages incurred by the user as a result of such
problems.

Copyright Information
Videos, images or sounds recorded with your camera
may not be utilized or published without consent of
copyright holders, if any, except in such a way as
permitted for personal use under the relevant copyright
law.

Trademark notices
• Canon and the Canon logo are registered trademarks
of Canon Inc.
• Microsoft, Windows, Windows Server, Windows Vista,
Internet Explorer, SQL Server and Visual C++ are
registered trademarks or trademarks of Microsoft
Corporation in the United States and other countries.
• Windows is legally recognized as Microsoft Windows
Operating System.
• QuickTime is a trademark of Apple Inc.
• Apache is a trademark of the Apache Software
Foundation.
• Pentium, Intel Core and Xeon are trademarks of Intel
Corporation in the United States or other countries (or
both).
• NVIDIA and GeForce are registered trademarks or
trademarks of NVIDIA Corporation in the United States
and other countries.
• Oracle and Java are registered trademarks of Oracle
and/or its affiliates. Other names may be trademarks of
their respective owners.
• All other company or product names used in this
manual are trademarks or registered trademarks of
their respective holders.
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THIS PRODUCT IS LICENSED FROM MPEGLA, LLC.
UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO
LICENSE FOR THE PERSONAL AND NON-COMMERCIAL
USE OF A CONSUMER TO (i) ENCODING VIDEO IN
COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD
(“MPEG-4 VIDEO”) AND/OR (ii) DECODING MPEG-4
VIDEO THAT WAS ENCODED BY A CONSUMER
ENGAGED IN A PERSONAL AND NON-COMMERCIAL
ACTIVITY. NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE. ADDITIONAL
INFORMATION INCLUDING THAT RELATING TO
PROMOTIONAL, INTERNAL AND COMMERCIAL USES
AND ADDITIONAL LICENSING MAY BE OBTAINED
FROM MPEG LA, LLC. SEE http://www.mpegla.com.
This product is licensed under AT&T patents for the
MPEG-4 standard and may be used for encoding MPEG-4
compliant video and/or decoding MPEG-4 compliant
video that was encoded only (1) for a personal and noncommercial purpose or (2) by a video provider licensed
under the AT&T patents to provide MPEG-4 compliant
video. No license is granted or implied for any other use
for MPEG-4 standard.

About Third Party Software
This product contains third party software modules.
Each module’s license conditions are also available in the
OpenSourceSoftware folder in the LICENSE folder on the
accompanying set-up CD-ROM.
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About the Manuals
This product has the following manuals:
• Administrator Manual (this guide)
This manual is intended for the system administrator and provides information on how to operate this software product.
• Viewer Operation Guide
This simplified manual is intended for general users and explains how to operate the Viewer.
Please also read the manuals provided with each camera, as required.

This manual assumes that you display and read it on your computer’s screen.

About Sample Screens Unique to This Software
In this manual, some screens that are unique to this software are used as examples to illustrate operations. Please note that
they may differ from the actual screens.
The VB-M40, VB-H41, and VB-S30D are mainly used as the example cameras in this manual. In addition, screens using
Windows 7 Basic theme are displayed as samples to describe operations.

 Icons in This Manual
The following icons indicate descriptions you should pay close attention to.
Icon

Meaning

Important

Cautions and restrictions during operation. Make sure to read these carefully.

Note

Supplementary descriptions and reference information.

Hint

Information useful for operation.

 Icons Indicating Camera Models
The following icons indicate information unique to that camera model.
Icon

Camera Model

Camera Model

VB-S30D

VB-M620VE and VB-M620D

VB-S31D

VB-M600VE and VB-M600D

VB-S800D and VB-S805D

VB-M720F

VB-S900F and VB-S905F

VB-M700F

VB-H43

VB-C500VD and VB-C500D

VB-H41

VB-C60

VB-H630VE and VB-H630D

VB-C300

VB-H610VE and VB-H610D

VB-C50Fi and VB-C50FSi

VB-H730F

VB-C50i and VB-C50iR

VB-H710F
VB-M42
VB-M40
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Icon

About the Manuals

 Icons Indicating Products
The following icons indicate information that is unique to the full product and the Lite version.
Icon

Meaning
Features unique to the RM-64/25/9. They cannot be used with RM-Lite.
Information unique to RM-Lite.
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Features
The RM-64/25/9 is a software product family used to
monitor multiple locations using network cameras and to
record and play back video from the cameras. It is
possible to set up a monitoring system with a maximum of
64 cameras (when using RM-64).

User access management with user groups
You can create user groups to more easily manage user
access. By assigning permissions for Viewer functionality
to a group, you automatically assign the same
permissions to each member of the group.

Flexible screen layout
You can arrange multiple video windows in the Viewer, so
you can compare video from different locations at the
same time. The Viewer lets you create multiple layouts
and organize them in tabs on the viewing area, so you can
easily switch between different camera video. You can
also operate up to two Viewer windows at the same time.
With an environment that supports multiple displays, you
can create a dual-display monitoring setup by locating a
Viewer on each of the displays.

Shade control
Shade control automatically compensates for the dark
regions in the video and can be used for both live and
recorded video.
Two-way audio*
Send and receive live audio and simultaneously record
audio with the video. You can also use this feature to
communicate with a location that has a camera.
* Only available for cameras that support the feature.

Multiple recording modes
In addition to being able to record video for a specific
period, you also have recording modes, such as sensor
recording, motion detection recording, intelligent function
recording and volume detection recording, which start
recording when a particular type of camera event occurs.
Support for JPEG/MPEG-4 and H.264*
The JPEG, MPEG-4 and H.264 video formats are
supported for live view and recording. Using MPEG-4 or
H.264 formats decreases the load on the network
bandwidth, while maintaining high quality video and
saving hard disk space when recording.
* Only available for cameras that support the feature.
Camera tags
You can assign tags to a camera that give you information
about the camera, such as its location and camera type.
This is particularly useful when searching for cameras in a
large-scale system.
Dynamic layout
With this feature, you can automatically display videos on
a layout from cameras that meet specific criteria, such as
the camera status.
Direct camera operation*
You can change the camera angle and use the zoom
while watching the live view.
* Only available for cameras that support the feature.
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Record Now
Use this feature to immediately start recording when you
do not have a recording schedule set up.
Saving a segment of a recording
You can extract part of a recording and save it as a video
file that can be played on a computer.
Viewer PTZ
You can instantly crop a region of live video or recorded
video during playback using an intuitive operation to
zoom in on that region.
You can also crop and zoom several videos
simultaneously for side-by-side comparison.
Some features have limited functionality. For details,
see “About RM-Lite” (p. 34).

Setup Flow
The flow from preparation before introducing the system, to operation management and maintenance is shown below.

Step 1
Prepare for introducing the system

Consider the video storage period and recording conditions, determine
the hard disk capacity required for recording and prepare the
equipment.

See “System Design” in Chapter 1: Introduction.

Step 2
Set up your cameras

Step 3
Install

Step 4
Set up the Storage Servers

Step 5
Add cameras

Step 6
Configure the Viewer

Step 7
Set a recording schedule

Step 8
Day-to-day operation

Step 9
Operation management and
maintenance

Set up your cameras for live video display or recording.

See your camera manuals.

Install this software product on your computer.

See Chapter 2: Setup.

Set up the Storage Server Group and Storage Servers.

See Chapter 3: Storage Server Settings.

Add cameras to the Storage Server Groups.

See Chapter 3: Storage Server Settings.

Configure the Viewer to match your environment and use.

See Chapter 4: Viewer Settings.

Set the recording conditions for using the cameras, including regular
recording and motion detection recording.

See Chapter 5: Setting a Recording Schedule.

Control cameras while viewing live video, check events, and play back
recorded video. You can set up your own layouts for the video windows.

See Chapter 6: Day-to-Day Operations.

We recommend that you set up a management and maintenance
process, such as taking regular backups of recording files, to reduce
the impact of network failures on system operation.

See Chapter 7: Operation and Management and Chapter 8:
Backup.
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Introduction

❏ System requirements (operating environment, supported cameras, license conditions)
❏ System configuration and design guidelines
❏ RM-Lite specification comparison

Operating Environment
For High-reliability/H.264 Video Format Systems
Storage Server
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Viewer

CPU

Intel Xeon 3060, Intel Core 2 Duo 2.4 GHz or
higher, or an Intel CPU of equivalent class that
meets the following requirements:
Clock: 2.4 GHz or higher
L2 cache: 4 MB or greater
Number of cores: 2 or more

Intel Core i5 750 2.67 GHz or higher
– Intel Core i7 3.5 GHz or higher
recommended when displaying 1920 x
1080 video

Memory

2 GB or greater

Hard disk

Interface: SAS / SATA
Cache: 16 MB or greater
Spindle speed: 7200 rpm or faster
100 MB is required for installation (an additional
500 MB is required if .NET Framework 3.5 SP1 or
.NET Framework 4.5 is not installed)
Additional space for recording files and other files
(the actual space required depends on the
number of cameras and the recording settings)
We recommend that you use separate hard disk
drives for the OS and the recording data.
The hard disk drive for the recording data should
have a capacity of 1 GB or greater.

Network controller

1000 BASE-T or similar, 1 Gbps transfer speed

Display

—

1280 × 1024 resolution or higher
16-bit colors or greater
– Required to display all user interfaces of the
Viewer

Graphics

—

NVIDIA GeForce GT 220 or higher, or a graphics
card of equivalent class that meets the following
requirements:
Video memory size: 1 GB or greater
Memory interface width: 128-bit or larger
Memory clock: 790 MHz or higher
– NVIDIA GeForce GTX 660 or higher
recommended when displaying 1920 x
1080 video

Others

—

Audio support is required for audio playback
(p. 107).

Operating system

Windows Vista Ultimate/Business/Enterprise SP2 32/64-bit
Windows Vista Ultimate/Business/Enterprise/Home Premium SP2 32/64-bit
Windows 7 Ultimate/Professional/Enterprise SP1 32/64-bit
Windows 7 Ultimate/Professional/Enterprise/Home Premium SP1 32/64-bit
Windows 8/Windows 8 Pro/Windows 8 Enterprise 32/64-bit
Windows 8.1/Windows 8.1 Pro/Windows 8.1 Enterprise 32/64-bit
Windows Server 2008 Standard SP2 32/64-bit
Windows Server 2008 R2 Standard SP1 64-bit
Windows Server 2012 Standard 64-bit
Windows Server 2012 R2 Standard 64-bit
– When a highly reliable system (such as 24 hours of uninterrupted use) is required, server
operating systems are recommended.

Operating system language

English, German, Spanish, French, Italian, and Japanese
– Environment languages switched using language-packs are not supported.

100 MB is required for installation (an additional
500 MB is required if .NET Framework 3.5 SP1 or
.NET Framework 4.5 is not installed)
Additional space for saving extracted video files,
as required.

Operating Environment
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Storage Server

Viewer

Maximum recording/playback data rate

80 Mbps *1

Overall recording frame rate

1280 fps or slower *2

Maximum number of cameras with motion
detection *3

10

Maximum events processed *4

20,000 events per day

Estimated display frame rate *
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• The system requirements described above are the minimum configuration, assuming the following operating environment:

When using recommended Intel i5 + GT 220
For 1920 x 1080 display size: 20 fps
(15 fps for H.264)*6
For 1280 x 720 display size: 40 fps
For 1280 x 960 display size: 40 fps
For 960 x 540 display size: 45 fps
For 640 x 360 display size: 80 fps
For 640 x 480 display size: 80 fps
For 480 x 270 display size: 160 fps
For 320 x 180 display size: 320 fps
For 320 x 240 display size: 320 fps
When using Intel i7 + GTX 660
For 1920 x 1080 display size: 30 fps
(15 fps for H.264)*6
For 1280 x 720 display size: 40 fps
For 1280 x 960 display size: 40 fps
For 960 x 540 display size: 45 fps
For 640 x 360 display size: 80 fps
For 640 x 480 display size: 80 fps
For 480 x 270 display size: 160 fps
For 320 x 180 display size: 320 fps
For 320 x 240 display size: 320 fps

Total number of simultaneously displayable
MPEG-4 and H.264 videos

6 or less *7

*1 If the volume per second of recording and playback data handled by one Storage Server is 80 Mbps or greater, you should review
your recording requirements to ensure system stability. The following shows an estimate of the recording and playback data volume
per second for various video formats.

JPEG

320 x 240

640 x 480

1920 x 1080

810 fps

280 fps

50 fps

MPEG-4
80 Mbps
H.264
For standard resolution ([Video Quality] set to 3), the JPEG video frame rates will result in an estimated data rate of 80 Mbps.
Audio data requires a Storage Server of 64 Kbps, regardless of the type of camera.
See “System Information” (p. 113) for details on the recording/playback data volume per second during operation.
*2 The data size of recorded audio is calculated using a frame rate of 10 fps per camera.
*3 Number of cameras selected in [Motion Detection Using] > [Storage Server] for motion detection recording.
*4 Total number of all types of events.
*5 Assumes a standard resolution ([Image Quality] setting is [3]) and that the receive size and display size are the same. If the receive
size and display size are different, performance may decrease due to an increase in processing load.
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*6 When multiple video sizes are combined, they will be equivalent to the following: 1920 x 1080 will be equivalent to 14 320 x 240 size
videos, 1280 x 720 will be equivalent to 8 320 x 240 size videos, 1280 x 960 will be equivalent to 8 320 x 240 size videos, 960 x 540
will be equivalent to 7 320 x 240 size videos, 640 x 360 will be equivalent to 5 320 x 240 size videos, 640 x 480 will be equivalent to
5 320 x 240 size videos, 480 x 270 will be equivalent to 2 320 x 240 size videos, 320 x 180 will be equivalent to 1 320 x 240 size
videos.
For example, the following combinations will result in a total equivalent of 320 x 240 at 320 fps.
1920 x 1080, 5 fps

 320 x 240, 5 fps x 14 = 70 fps equivalent

1280 x 960, 5 fps

 320 x 240, 5 fps x 8 = 40 fps equivalent

960 x 540, 8 fps

 320 x 240, 8 fps x 7 = 56 fps equivalent

640 x 480, 8 fps

 320 x 240, 8 fps x 5 = 40 fps equivalent

480 x 270, 25 fps

 320 x 240, 25 fps x 2 = 50 fps equivalent

320 x 240, 64 fps
Total: 320 x 240, 320 fps equivalent
(70 + 40 + 56 + 40 + 50 + 64)
*7 The number of videos you can display at once depends on the amount of memory available. If there is not enough memory, you will
not be able to display videos.

• In a system environment with a large number of cameras and connected viewers and where the number of events that
may occur is also likely to be high, the Storage Server must come with the specifications that meet the needs of that
environment for stable operation.
• If you need to operate a high-reliability system (such as for 24-hour operation) in a system environment, we recommend
that you use a server operating system on the computer that is used for the Storage Server.
• When high-reliability operation is required (such as for 24-hour operation, and high frequency disk access) we strongly
recommend that you use a high-reliability SAS hard disk. Using a low-reliability SATA hard disk may result in a disk error
in a one to two year period. Therefore, you may need to check the disk for errors on a regular basis, using features such
as scan disk. In such a case, recording performance may suffer during checking, due to the increased load on the disk.
• With systems intended for users requiring high-reliability/H.264, when operating both the Storage Server and the Viewer
on one computer, the operating environment must satisfy the requirements for both the Storage Server and the Viewer.
However, to help ensure stable operation, we recommend that you use separate computers for the Storage Server and for
the Viewer.

For Small-scale Systems (Both Storage Server and Viewer Installed)
Storage Server
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CPU

Intel Pentium G6950 2.80 GHz or higher, or an Intel CPU of equivalent class that meets the following
requirements:
Clock: 2.4 GHz or greater
L2 cache: 512 KB or greater
L3 cache: 3 MB or higher (only required if the L2 cache is less than 3 MB)
Number of cores: 2 or more

Memory

2 GB or greater

Hard disk

Interface: SAS / SATA
Cache: 16 MB or greater
Spindle speed: 7200 rpm or faster
200 MB is required for installation (an additional 500 MB is required if .NET Framework 3.5 SP1 or
.NET Framework 4.5 is not installed)
Additional space for recording files and other files (the actual space required depends on the number
of cameras and the recording settings)
Additional space for saving extracted video files, as required.
The hard disk drive for the recording data should have a capacity of 1 GB or greater.

Network controller

100 BASE-TX or similar, 100 Mbps transfer speed

Display

1280 × 1024 resolution or higher
16-bit colors or greater

Others

Audio support is required for audio playback (p. 107).

Operating Environment

1

Operating system

Windows Vista Ultimate/Business/Enterprise SP2 32/64-bit
Windows Vista Ultimate/Business/Enterprise/Home Premium SP2 32/64-bit
Windows 7 Ultimate/Professional/Enterprise SP1 32/64-bit
Windows 7 Ultimate/Professional/Enterprise/Home Premium SP1 32/64-bit
Windows 8/Windows 8 Pro/Windows 8 Enterprise 32/64-bit
Windows 8.1/Windows 8.1 Pro/Windows 8.1 Enterprise 32/64-bit
Windows Server 2008 Standard SP2 32/64-bit
Windows Server 2008 R2 Standard SP1 64-bit
Windows Server 2012 Standard 64-bit
Windows Server 2012 R2 Standard 64-bit

Operating system language

English, German, Spanish, French, Italian, and Japanese
– Environment languages switched using language-packs are not supported.

Introduction

Storage Server

• The system requirements described above are the minimum configuration, assuming the following operating environment:
Storage Server

Viewer

Maximum recording/playback data rate

16 Mbps *1

Recording frame rate

256 fps or slower *2

Maximum number of cameras with motion
detection

0

Maximum events processed *3

10,000 events per day

Estimated display frame rate *4

1920 x 1080: 1 fps
1280 x 960: 2 fps
960 x 540: 5 fps
640 x 480: 10 fps
480 x 270: 15 fps
320 x 240: 30 fps

Total number of simultaneously displayable
MPEG-4 and H.264 videos

6 or less*5

*1 Do not use H.264 in small-scale systems, as this can have a negative effect on system operation.
*2 The data size of recorded audio is calculated using a frame rate of 10 fps per camera.
*3 Total number of all types of events.
*4 Assumes a standard resolution ([Image Quality] setting is [3]) and that the receive size and display size are the same. If the receive
size and display size are different, performance may decrease due to an increase in processing load.
*5 The number of videos you can display at once depends on the amount of memory available. If there is not enough memory, you will
not be able to display videos.

• The following are guidelines for implementing a system for a small-scale user.
System components

•

Guideline

Number of cameras

Approx. 9 cameras (assuming RM-9 is used for operation)

Recording frame rate

5 fps x 9 cameras with 320 x 240 standard resolution (approx. 8 Mbps in terms of data rate)

Live view frame rate

3 fps x 9 cameras ( = 27 fps) with 320 x 240 standard resolution

Playback

5 fps for each camera with 320 x 240 standard resolution
Maximum number of playable cameras:
Up to 6 (30 fps total) with a playback-dedicated layout
Up to 1 with the live view layout (see above) (3 fps x 8 live view cameras + 5 fps x 1 playback
camera)

Others

H.264 is not used

The Viewer computer specifications on p. 14 are required even for small scale systems (up to four cameras) using
RM-Lite, if you want to display H.264 video.
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Important Notes Concerning System Requirements
• This software does not support external storage, such as USB hard disks and NAS.
• We recommend that you operate this software in its own dedicated LAN environment.
• The software may not be able to record video if you use an environment where the IP addresses of the cameras are
occasionally changed. Use fixed IP addresses to ensure proper operation.
• Be sure to operate the cameras, Storage Servers and Viewers over networks using the same network protocol (e.g. all
over IPv4 networks, or all over IPv6 networks).
• For details on the operating system, see “Additional Considerations” in “Operating Environment” (p. 18).
•
Audio cannot be transmitted from a Viewer if you use the Viewer on a computer running Windows 7,
Windows 8, Windows 8.1, Windows Server 2008 R2, Windows Server 2012 or Windows Server 2012 R2.
• Before applying a service pack or updating the operating system, please refer to the Canon Web site).
• Running Windows Update may cause the system operation to become unstable, the operating system to restart, or
recording to stop.
• Using anti-virus software or a firewall may affect the performance of the Storage Server and Viewer.
• Running software other than this product or compatible camera management software may cause system operation to
become unstable.
• When there is a high load on the CPU or hard disk, video may not be recorded or displayed at the specified frame rate,
recording may be interrupted, or the Viewer operation speed may decrease. In addition, recording may be interrupted
when the available hard disk space is low.
• Operation may slow down if the amount of stored data (number of recording files) becomes large.
• Depending on the performance of the computer and the network environment, changes in the recording environment
(such as the time of day and the weather) may result in it not being possible to display recorded or live video according
to the specified settings.
• Using IPsec may degrade the performance for recording and displaying video.
• You can use the camera audio feature (except for the VB-C50Fi, which does not support the function). Review the
following items before using the feature.
– The Viewer supports transmission and reception of audio data.
– Audio data cannot be recorded separately, and is always recorded together with the video.
– Synchronization is enabled only when playing back recorded video (JPEG) and recorded audio. However, the audio
and video may not be synchronized, depending on the operating environment (p. 82).
– The audio stream may be interrupted, depending on the performance of your computer and network environment.
– Audio may be interrupted when using anti-virus software.
• Be sure to test the system under your operating environment before starting regular operation.

Note
• The system environment of the Storage Server will depend on your operating conditions (number of cameras, recording frame rate
settings, etc.), as well as the pre-event recording settings. For details, contact your local supplier.
• Microsoft .NET Framework 3.5 SP1 or .NET Framework 4.5 is required for this software to operate. .NET Framework 3.5 SP1 is
automatically installed when installing RM-64/25/9. For RM-Lite, install it from the included CD-ROM before installing RM-Lite. Enable
.NET Framework 4.5 if it is currently disabled.
• The following runtime module is installed automatically with RM-64/25/9 and RM-Lite. Do not uninstall this module.
– Microsoft Visual C++ 2008 Redistributable
• Microsoft .NET Framework 4.0 is not supported.

Additional Considerations
• Do not specify the Windows folder or the Program Files folder on the system drive as the destination for snapshots or
recording files. You cannot save images or videos to those folders.
• You cannot use the shadow backup feature with this software. For example, once you delete the configuration file for this
software, the file cannot be restored with the shadow backup feature.
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Supported Cameras
Camera

Firmware Version

VB-S30D

Ver. 1.1.0 or later

VB-S31D

Ver. 1.1.0 or later

VB-S800D

Ver. 1.1.0 or later

VB-S900F

Ver. 1.1.0 or later

VB-S805D

Ver. 1.0.0 or later

VB-S905F

Ver. 1.0.0 or later

VB-H43

Ver. 1.0.0 or later

VB-H630VE

Ver. 1.0.0 or later

VB-H630D

Ver. 1.0.0 or later

VB-H730F

Ver. 1.0.0 or later

VB-H41

Ver. 1.1.1 or later

VB-H610VE

Ver. 1.2.1 or later

VB-H610D

Ver. 1.2.1 or later

VB-H710F

Ver. 1.2.1 or later

VB-M42

Ver. 1.0.0 or later

VB-M620VE

Ver. 1.0.0 or later

VB-M620D

Ver. 1.0.0 or later

VB-M720F

Ver. 1.0.0 or later

VB-M40

Ver. 1.1.1 or later

VB-M600VE

Ver. 1.1.1 or later

VB-M600D

Ver. 1.1.1 or later

VB-M700F

Ver. 1.1.1 or later

VB-C500VD/VB-C500D

Ver. 1.1.2 or later

VB-C60

Ver. 1.1.3 or later

VB-C300

Ver. 1.1 Rev. 5 or later

VB-C50i/VB-C50iR

Ver. 1.2 Rev. 77 or later

VB-C50FSi/VB-C50Fi

Ver. 1.0 Rev. 77 or later

Note
See “Using the AXIS Q7404/Q7401” (p. 137) for details on limitations when using the AXIS Q7404/Q7401.
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Camera Video Sizes
Camera
VB-S30D/VB-S31D/ VB-S800D/VB-S900F/
VB-S805D/VB-S905F/VB-H43/VB-H630VE/
VB-H630D/VB-H730F/VB-M42/VB-M620VE/
VB-M620D/VB-M720F

Category*1
2

Video Size

1080p*

–

480×270

960×540

1920×1080

720p

–

320×180

640×360

1280×720

4:3

–

320×240

640×480

1280×960

VB-H41/VB-H610VE/VB-H610D/VB-H710F

320×240

480×270

960×540

1920×1080

VB-M40/VB-M600VE/VB-M600D/VB-M700F

160×120

320×240

640×480

1280×960

VB-C500VD/VB-C500D/VB-C60/VB-C300/VB-C50i/VB-C50iR/
VB-C50FSi

160×120

320×240

640×480

*1 Categories are switched on the camera’s setting page.
*2 VB-S805D/VB-S905F/VB-M42/VB-M620VE/VB-M620D/VB-M720F not supported.
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Product Type and Number of Licenses
The number of cameras that can be added to a Storage Server Group depends on the specific software product.
The following table describes the number of licenses required for servers and Viewers, as well as the number of Storage
Servers that can be configured as a Storage Server Group, for each product.
Software product

Number of server
licenses

Number of Storage
Server Groups

Maximum number of cameras that can be added
to a Storage Server Group

Number of
Viewer licenses

RM-64

1

1

64

1

RM-25

1

1

25

1

RM-9

1

1

9

1

RM-Lite

1

1

4

1

About Licenses
Each software product includes one license for the Storage Server and one license for the Viewer. The number of
computers that a product with one license can be installed on is described below.
Storage Servers
One server license allows you to install one Storage Server on a computer.
Viewers
One Viewer license allows you to install one Viewer on a computer.
Up to 6 Viewers can connect to a Storage Server at one time.
You are able to purchase individual Viewer licenses, therefore you must purchase the same number of licenses as you have
Viewer installations.

Maximum System Configuration
The following table describes the maximum system configuration supported by this software.
Number of Storage Server Groups

1

Number of Storage Servers

1

Number of cameras

Max. 64 (with RM-64)

Number of simultaneously connected Viewers

Max. 6

Number of cameras that can be used by a Viewer

Max. 64 (same as the max. number of cameras)

Number of camera video that can be simultaneously displayed by a Viewer

Max. 64
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Notes on the Software
 Compatibility with Network Video Recorder VK-64/16/Lite
Notes on Installation
This software cannot exist with VK-64/16/Lite on the same computer. Do not install this software onto a computer where
VK-64/16/Lite is installed. You can install this software after uninstalling VK-64/16/Lite. However, please be aware of the
following:
• You cannot use the cameras and recording schedule settings you added with VK-64/16/Lite. You must add and
configure the cameras and schedules again.
• You cannot use the recording files and event information associated with VK-64/16/Lite.
• You cannot play back recordings made with VK-64/16/Lite.
• This software requires a computer with specifications that are higher than those required for VK-64/16/Lite. The computer
used for VK-64/16/Lite may not meet the operation requirements for this software.
Notes on Protocol Compatibility
This software is not compatible with VK-64/16/Lite protocols, because the protocol used between the Viewer and the
Storage Server has been significantly changed. Therefore, you cannot connect to a VK-64/16/Lite Storage Server from the
Viewer in this software. Similarly, you cannot connect to this software’s Storage Server from the Viewer in VK-64/16/Lite.
Notes on Recording Data and Event Data Compatibility
This software uses event data and recording file formats that are different from VK-64/16/Lite. VK-64/16/Lite recordings can
be played back using QuickTime. However, the recordings for this software are not supported by QuickTime. Note,
however, that you can use QuickTime to play back a .mov file created using the [Extract Video] feature in this software.

22

1
Introduction

System Configuration Example
This software records video from cameras using an IP network, such as a LAN.

Important
• The load on the Storage Server may increase depending on the number of cameras connected and the recording settings. See
“Determining the Capacity of the Storage Server” (p. 25) to consider your configuration.
• Accessing one camera or Storage Server from many Viewers at the same time may affect system performance.
• Regularly check that the time setting is correct on the computers that are running the Storage Server and the Viewer. Also, before
changing the time setting on the computers, be sure to first stop the Storage Server and Viewer. See “Stopping the Storage Server”
(p. 119) for details about how to stop the Storage Server.

Configuration Example 1: Storage Server and Viewer Installed on One Computer
This example shows the simplest system configuration, where the Storage Server and Viewer are installed on one computer.
Video from the cameras is displayed or recorded using the same computer.
Storage Server Group
Storage Server/Viewer

Network
Video from the cameras
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Configuration Example 2: Storage Server and Viewers Installed on Multiple Networked
Computers
You can install Storage Servers and Viewers on multiple computers on the network.
Storage Server Group
Viewer

Network
Video from the cameras
Recorded video

Configuration Example 3: Viewers Installed on Multiple Networked Computers
By setting up more than one Viewer, you can simultaneously view a video at more than one location.
Storage Server Group

Viewer 1

Viewer 2

Viewer 6

Network
Video from the cameras
Recorded video
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System Design
Determining the Capacity of the Storage Server
You must determine the configuration of your Storage Server based on the recording and playback data volume per second
and the required hard disk capacity.

Important
The operating performance of this software varies depending on factors such as the usage conditions and the hardware specifications of
the Storage Server. Perform system design after referring to “For High-reliability/H.264 Video Format Systems” (p. 14).

 Hard disk capacity requirements
It is assumed that you use continuous recording at a fixed frame rate (number of video per second), video size and quality.
The size of the recording data varies depending on the camera configuration (video quality and video size settings). The
size of the recording data varies depending on the camera configuration (video quality and video size settings). Also, the
video data size used for calculating the recording data size may vary from the actual video.
Follow these steps to determine the required hard disk capacity.

1

Decide on the number of cameras and the video size for recording.

2

Decide on the video quality for each camera.
The higher the video quality setting, the higher the video quality and resulting data volume.

3

Decide on the frame rate required for recording.
For general security purposes, you can use 1 to 2 fps. Higher frame rates require more hard disk space.

4

Decide on the number of hours per day to record and the number of days to store the recorded data.

5

After deciding on the above parameters, calculate the required hard disk capacity based on the recording data size (in
KB).

6

If you will also record audio, be sure to calculate the additional amount of hard disk space required for the audio.

We recommend that you add more than 20% space to the calculated hard disk capacity.
Sample calculations for each video format are shown below, assuming 1000 Kbps = 1 Mbps for the network bandwidth,
and 1024 KB = 1 MB for the disk capacity.
Example 1: JPEG recording
• Video recording from 16 cameras (VB-S30D)
• Video size is 320 x 240 and video quality is 3 (data size per frame: 9.16 KB)
• Recording frame rate is 2 fps
• Data size per second is approximately 18.32 KB (= 9.16 KB x 2 fps)
Although the actual recording data size depends on the objects recorded by each camera, this calculation assumes the
typical sizes given above.
• Audio is recorded from 2 cameras
If JPEG videos from 16 cameras are recorded at 2 frames per second in continuous recording mode, the required hard disk
space is approximately 24.2 GB per day (= 18.32 KB x 16 cameras x 60 seconds x 60 minutes x 24 hours = 25,325,568 KB).
If audio data is recorded using 2 cameras, the required hard disk space is approximately 1.3 GB per day (= 8 KB x
2 cameras x 60 seconds x 60 minutes x 24 hours = 1,382,400 KB).

25

Example 2: MPEG-4 recording
• Video recording from 8 cameras (VB-C60).
• Video size is 320 x 240 and video quality is 3.
• Recording frame rate is 30 fps.
• Data size per second is approximately 150 KB.
Although the actual recording data size depends on the objects recorded by each camera, this calculation assumes the
typical sizes given above.
If MPEG-4 videos from 8 cameras are recorded at 30 frames per second in continuous recording mode, the required hard
disk space is approximately 99 GB per day (= 150 KB x 8 cameras x 60 seconds x 60 minutes x 24 hours =
103,680,000 KB).
Example 3: H.264 recording
• Video recording from 8 cameras (VB-M40).
• Video size is 320 x 240 and video quality is 3.
• Recording frame rate is 30 fps.
• Data size per second is approximately 84 KB.
Although the actual recording data size depends on the objects recorded by each camera, this calculation assumes the
typical sizes given above.
If H.264 videos from 8 cameras are recorded at 30 frames per second in continuous recording mode, the required hard
disk space is approximately 55 GB per day (= 84 KB x 8 cameras x 60 seconds x 60 minutes x 24 hours = 58,060,800 KB).
Note that the actual recording file size may be different from the size in the table, depending on the weather conditions and
the complexity of the scene. For example, video of an empty corridor would typically result in values smaller than the above
values. Conversely, complex scenes, such as a crowded shopping mall, would result in larger values.

 Data Size and Bit Rate Estimates
The following tables shows typical data sizes per frame (in KB) for various combinations of video quality and size settings.
Estimates of the Data Size for VB-S30D/VB-S31D/VB-S800D/VB-S900F/VB-S805D/VB-S905F (JPEG)
Video Size
Video
Quality

1080p Category*

720p Category

4:3 Category

480 × 270

960 × 540

1920 × 1080

320 x 180

640 x 360

1280 x 720

320 x 240

640 x 480

1280 x 960

1

8.61

27.20

88.29

4.81

13.53

44.73

5.72

17.65

59.38

2

12.74

39.21

122.03

7.03

19.85

63.67

8.30

25.56

82.81

3

16.21

49.54

153.13

8.86

25.31

80.23

10.48

32.32

103.27

4

21.23

65.16

206.25

11.43

33.45

105.81

13.64

42.51

137.26

5

35.95

117.00

392.44

18.85

57.50

192.90

22.84

74.73

256.15

(Unit: KB)
* VB-S805D/VB-S905F not supported.
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Estimates of the Bit Rate for VB-S30D/VB-S31D/VB-S800D/VB-S900F/VB-S805D/VB-S905F (H.264)
Firmware V1.2.0 or later
● Video Size: 1080p Category*
I-Frame Interval: 1 sec.
Video
Quality

Frame Rate: 10 fps

Frame Rate: 15 fps

Frame Rate: 30 fps

480 × 270

960 × 540

1920 × 1080

480 × 270

960 × 540

1920 × 1080

480 × 270

960 × 540

1920 × 1080

1

0.13

0.40

1.27

0.15

0.47

1.51

0.20

0.61

2.03

2

0.18

0.58

1.86

0.21

0.68

2.25

0.29

0.88

3.08

3

0.32

1.04

3.84

0.38

1.25

4.89

0.52

1.72

7.33

4

0.41

1.32

5.25

0.48

1.62

6.86

0.67

2.24

10.77

5

0.56

1.88

8.19

0.67

2.33

11.18

0.93

3.34

18.57

(Unit: Mbps)
* VB-S805D/VB-S905F not supported.
● Video Size: 720p Category
I-Frame Interval: 1 sec.
Video
Quality

Frame Rate: 10 fps

Frame Rate: 15 fps

Frame Rate: 30 fps

320 x 180

640 x 360

1280 x 720

320 x 180

640 x 360

1280 x 720

320 x 180

640 x 360

1280 x 720

1

0.07

0.21

0.67

0.08

0.24

0.78

0.12

0.32

1.02

2

0.09

0.30

0.96

0.11

0.34

1.15

0.16

0.46

1.52

3

0.16

0.53

1.88

0.20

0.63

2.30

0.27

0.86

3.26

4

0.20

0.67

2.47

0.25

0.80

3.16

0.34

1.09

4.58

5

0.28

0.92

3.81

0.33

1.11

4.94

0.46

1.55

7.83

(Unit: Mbps)
● Video Size: 4:3 Category
I-Frame Interval: 1 sec.
Video
Quality

Frame Rate: 10 fps

Frame Rate: 15 fps

Frame Rate: 30 fps

320 x 240

640 x 480

1280 x 960

320 x 240

640 x 480

1280 x 960

320 x 240

640 x 480

1280 x 960

1

0.09

0.25

0.78

0.11

0.30

0.95

0.15

0.41

1.27

2

0.12

0.36

1.12

0.14

0.42

1.37

0.20

0.57

1.86

3

0.21

0.63

2.20

0.25

0.77

2.78

0.35

1.04

4.11

4

0.25

0.79

2.92

0.31

0.97

3.82

0.44

1.34

5.98

5

0.34

1.10

4.42

0.41

1.34

5.92

0.59

1.92

9.95

(Unit: Mbps)
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Firmware older than V1.2.0
● Video Size: 1080p Category*
I-Frame Interval: 1 sec.
Video
Quality

Frame Rate: 10 fps

Frame Rate: 15 fps

Frame Rate: 30 fps

480 × 270

960 × 540

1920 × 1080

480 × 270

960 × 540

1920 × 1080

480 × 270

960 × 540

1920 × 1080

1

0.13

0.43

1.58

0.16

0.52

2.04

0.22

0.74

3.21

2

0.18

0.58

2.12

0.22

0.70

2.73

0.30

0.97

4.17

3

0.32

1.04

3.94

0.38

1.25

5.17

0.53

1.73

8.10

4

0.41

1.32

5.30

0.48

1.62

7.07

0.67

2.24

11.40

5

0.56

1.88

8.19

0.67

2.33

11.18

0.93

3.34

18.84

(Unit: Mbps)
* VB-S805D/VB-S905F not supported.
● Video Size: 720p Category
I-Frame Interval: 1 sec.
Video
Quality

Frame Rate: 10 fps

Frame Rate: 15 fps

Frame Rate: 30 fps

320 x 180

640 x 360

1280 x 720

320 x 180

640 x 360

1280 x 720

320 x 180

640 x 360

1280 x 720

1

0.07

0.22

0.74

0.08

0.26

0.92

0.12

0.36

1.35

2

0.10

0.30

1.02

0.11

0.36

1.26

0.16

0.49

1.78

3

0.16

0.53

1.90

0.20

0.63

2.34

0.28

0.86

3.43

4

0.20

0.67

2.47

0.25

0.80

3.16

0.34

1.09

4.67

5

0.28

0.92

3.81

0.33

1.11

4.94

0.47

1.55

7.83

(Unit: Mbps)
● Video Size: 4:3 Category
I-Frame Interval: 1 sec.
Video
Quality

Frame Rate: 10 fps

Frame Rate: 15 fps

Frame Rate: 30 fps

320 x 240

640 x 480

1280 x 960

320 x 240

640 x 480

1280 x 960

320 x 240

640 x 480

1280 x 960

1

0.09

0.27

0.95

0.11

0.34

1.23

0.16

0.48

1.95

2

0.12

0.37

1.25

0.15

0.45

1.60

0.21

0.63

2.45

3

0.21

0.63

2.20

0.25

0.77

2.88

0.35

1.06

4.48

4

0.25

0.79

2.92

0.31

0.97

3.82

0.44

1.35

6.07

5

0.34

1.10

4.42

0.41

1.34

5.92

0.59

1.92

9.95

(Unit: Mbps)
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Estimates of the Data Size for VB-H43/VB-H630VE/VB-H630D/VB-H730F/VB-M42/VB-M620VE/VB-M620D/VB-M720F
(JPEG)
Video Size
Video
Quality

1080p Category*

720p Category

4:3 Category

480 × 270

960 × 540

1920 × 1080

320 x 180

640 x 360

1280 x 720

320 x 240

640 x 480

1280 x 960

1

9.41

31.58

106.54

5.22

15.08

53.01

6.25

20.11

70.14

2

14.22

47.37

151.37

7.69

22.94

78.52

9.33

30.40

101.32

3

18.38

60.59

190.30

9.74

29.58

99.89

11.95

39.08

127.78

4

24.22

79.96

252.56

12.62

39.14

131.42

15.57

51.54

168.77

5

40.78

139.10

464.17

20.86

66.61

232.87

25.99

88.50

305.32

(Unit: KB)
* VB-M42/VB-M620VE/VB-M620D/VB-M720F not supported.
Estimates of the Bit Rate for VB-H43/VB-H630VE/VB-H630D/VB-H730F (H.264)
● Video Size: 1080p Category*
I-Frame Interval: 1 sec.
Video
Quality

Frame Rate: 10 fps

Frame Rate: 15 fps

Frame Rate: 30 fps

480 × 270

960 × 540

1920 × 1080

480 × 270

960 × 540

1920 × 1080

480 × 270

960 × 540

1920 × 1080

1

0.16

0.51

1.62

0.19

0.59

1.91

0.26

0.77

2.57

2

0.21

0.65

2.06

0.24

0.76

2.47

0.33

0.99

3.39

3

0.34

1.09

3.70

0.40

1.29

4.57

0.55

1.71

6.60

4

0.49

1.60

5.77

0.57

1.93

7.39

0.79

2.62

11.35

5

0.80

2.88

11.53

0.96

3.56

15.59

1.34

5.21

26.35

(Unit: Mbps)
Estimates of the Bit Rate for VB-H43/VB-H630VE/VB-H630D/VB-H730F/VB-M42/VB-M620VE/VB-M620D/VB-M720F
(H.264)
● Video Size: 720p Category
I-Frame Interval: 1 sec.
Video
Quality

Frame Rate: 10 fps

Frame Rate: 15 fps

Frame Rate: 30 fps

320 x 180

640 x 360

1280 x 720

320 x 180

640 x 360

1280 x 720

320 x 180

640 x 360

1280 x 720

1

0.08

0.26

0.84

0.10

0.31

0.99

0.14

0.41

1.30

2

0.11

0.34

1.08

0.13

0.39

1.27

0.18

0.52

1.68

3

0.17

0.56

1.86

0.21

0.66

2.24

0.28

0.88

3.06

4

0.24

0.80

2.81

0.29

0.95

3.47

0.39

1.29

5.01

5

0.39

1.35

5.55

0.48

1.63

7.16

0.65

2.27

11.42

(Unit: Mbps)
● Video Size: 4:3 Category
I-Frame Interval: 1 sec.
Video
Quality

Frame Rate: 10 fps

Frame Rate: 15 fps

Frame Rate: 30 fps

320 x 240

640 x 480

1280 x 960

320 x 240

640 x 480

1280 x 960

320 x 240

640 x 480

1280 x 960

1

0.11

0.33

1.03

0.13

0.39

1.24

0.19

0.52

1.67

2

0.14

0.42

1.31

0.16

0.49

1.58

0.23

0.65

2.16

3

0.22

0.68

2.22

0.26

0.80

2.77

0.37

1.08

4.02

4

0.30

0.96

3.46

0.36

1.15

4.41

0.51

1.59

6.73

5

0.48

1.66

6.72

0.59

2.03

9.03

0.83

2.90

15.05

(Unit: Mbps)
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Estimates of the Data Size for VB-H41/VB-H610VE/VB-H610D/VB-H710F (JPEG)
Video Size
Video Quality
320 × 240

480 × 270

960 × 540

1920 × 1080

1

5.61

9.55

32.89

114.04

2

8.09

14.50

49.92

164.28

3

10.02

18.74

64.10

210.29

4

12.91

24.75

84.59

285.32

5

20.91

41.63

148.50

528.67

(Unit: KB)
Estimates of the Bit Rate for VB-H41/VB-H610VE/VB-H610D/VB-H710F (H.264)
Firmware V1.3.0 or later
I-Frame Interval: 0.5 sec.
Video
Quality

Frame Rate: 10 fps

Frame Rate: 15 fps

Frame Rate: 30 fps

480 × 270

960 × 540

1920 × 1080

480 × 270

960 × 540

1920 × 1080

480 × 270

960 × 540

1920 × 1080

1

0.24

0.82

2.65

0.28

0.95

3.18

0.34

1.13

4.13

2

0.35

1.19

4.03

0.41

1.41

4.95

0.51

1.72

6.73

3

0.54

1.87

6.71

0.64

2.24

8.65

0.80

2.84

12.64

4

0.82

2.96

11.62

0.98

3.63

15.40

1.23

4.83

25.01

5

1.26

4.89

20.68

1.51

6.23

28.55

1.96

9.20

40.18

(Unit: Mbps)
Firmware older than V1.3.0
I-Frame Interval: 0.5 sec.
Video
Quality

Frame Rate: 10 fps

Frame Rate: 15 fps

Frame Rate: 30 fps

480 × 270

960 × 540

1920 × 1080

480 × 270

960 × 540

1920 × 1080

480 × 270

960 × 540

1920 × 1080

1

0.24

0.84

2.88

0.29

0.99

3.58

0.36

1.21

5.04

2

0.36

1.22

4.22

0.42

1.45

5.37

0.53

1.80

7.65

3

0.55

1.91

7.02

0.65

2.31

9.13

0.82

2.95

13.74

4

0.83

2.99

12.01

0.99

3.72

16.29

1.27

5.01

26.73

5

1.27

5.01

21.62

1.53

6.41

30.26

2.00

9.58

43.06

(Unit: Mbps)
Estimates of the Data Size for VB-M40/VB-M600VE/VB-M600D/VB-M700F (JPEG)
Video Size

Video
Quality

160 × 120

320 × 240

640 × 480

1280 × 960

1

2.33

5.89

19.73

69.59

2

3.55

10.01

33.82

111.71

3

4.37

12.83

43.37

141.96

4

5.47

16.76

57.03

190.44

5

8.65

27.72

97.08

338.58

(Unit: KB)
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Estimates of the Bit Rate for VB-M40/VB-M600VE/VB-M600D/VB-M700F (H.264)
Video Size and Frame Rate
Video
Quality

10 fps

15 fps

30 fps

320 × 240

640 × 480

1280 × 960

320 × 240

640 × 480

1280 × 960

320 × 240

640 × 480

1280 × 960

1

0.07

0.24

0.84

0.10

0.33

1.20

0.18

0.59

2.21

2

0.12

0.39

1.27

0.16

0.53

1.77

0.28

0.91

3.31

3

0.21

0.67

2.15

0.28

0.91

3.05

0.47

1.56

5.54

4

0.29

0.97

3.23

0.38

1.31

4.56

0.65

2.18

8.20

5

0.38

1.36

4.87

0.52

1.88

6.93

0.87

3.14

12.39

(Unit: Mbps)
Estimates of the Data Size for VB-C500VD/VB-C500D/VB-C60 (JPEG)
Video Size

Video
Quality

160 × 120

320 × 240

640 × 480

1

3.5

9.6

27.5

2

4.0

11.0

31.7

3

4.4

12.5

35.8

4

5.6

16.4

47.8

5

15.8

52.7

171.4

(Unit: KB)
Estimates of the Bit Rate for VB-C500VD/VB-C500D/VB-C60 (MPEG-4)
Video Size and Frame Rate
Video
Quality

10 fps

15 fps

30 fps

320 × 240

640 × 480

320 × 240

640 × 480

320 × 240

640 × 480

1

0.28

0.76

0.35

0.94

0.54

1.43

2

0.39

1.08

0.50

1.30

0.78

2.02

3

0.60

1.67

0.75

2.02

1.20

3.31

4

0.69

1.93

0.91

2.43

1.38

3.98

5

0.81

2.31

1.05

2.87

1.68

4.86

(Unit: Mbps)

Note
The data size for MPEG-4 video may increase when recording video with quick movements.

Estimates of the Data Size for VB-C300 (JPEG)
Video Size

Video
Quality

160 × 120

320 × 240

640 × 480

1

3.2

8.8

24.2

2

3.7

10.2

28.3

3

4.1

11.5

32.0

4

5.3

15.4

43.2

5

15.5

52.8

170.6

(Unit: KB)
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Estimates of the Data Size for VB-C50i/VB-C50iR/VB-C50FSi (JPEG)
Video Size

Video
Quality

160 × 120

320 × 240

640 × 480

30

3.1

8.2

24.7

40

3.6

9.7

29.8

50

4.1

10.9

34.2

60

4.6

12.5

40.3

70

5.3

14.8

49.7

80

6.5

18.8

64.9

90

9.4

28.4

106.4

(Unit: KB)

Important
The actual data size may increase or decrease depending on the objects being recorded. Make sure to confirm the data size for the
actual system environment before starting operation.

Note that the data size may increase significantly when the video quality is set to [100].

Select [View] > [Video Information] in the Viewer included with the camera to display the data size per frame.

Sensor Recording, Motion Detection Recording, Intelligent Function Recording and
Volume Detection Recording
 Notes on Using Sensor Recording, Motion Detection Recording, Intelligent Function Recording
and Volume Detection Recording
When an event occurs, data is saved in the Storage Server as an operation record. As the number of operation records
increases, operation during event detection and the search and Viewer response speeds may be affected.

Note
Use “Maximum events processed” (p. 15), described in “Operating Environment” > “For High-reliability/H.264 Video Format Systems,” as a
guide.

 Notes on Using Motion Detection Recording / Intelligent Function Recording
• The motion detection feature notifies you there is motion in an area when motion is not ordinarily expected. Do not use
this feature for busy areas where motion detection may be triggered frequently.
• Configure motion detection on the camera side. If you configure motion detection on the Storage Server side, the load on
the Storage Server may increase, resulting in decreased recording performance.
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 Notes on Storage Server Operation
We recommend that you dedicate the Storage Server computer exclusively to running this software.
Be sure to avoid the following on the Storage Server computer:
• Running Web server software on the computer
You cannot operate the Storage Server on a computer where Web server software such as Windows standard IIS
(Internet Information Server) or Apache is already installed.
The Storage Server uses HTTP protocol to communicate with cameras. Therefore, the Storage Server may not work
normally if other Web service applications exist on the same computer.
The HTTP port used by this software is 80 and cannot be changed.
• Running database server software (e.g., SQL Server, Oracle) on the computer
Database processing can place a load on the hard disk that may affect recording performance. Conversely, this
software may affect database server performance when it performs tasks that place a load on the hard disk.
• Using the computer as a file server
The hard disk is frequently accessed when the computer is used as a file server, and this may affect recording
performance. In addition, the Storage Server is more likely to run out of disk capacity if the computer is operated as a file
server.
• Running other applications on the computer
The additional processing load from running applications other than this software may affect recording performance.
This software uses the TCP port numbers 80, 443, 11080 and 2380. These ports should not be used by other
applications.

Calculating Network Bandwidth
You need to consider the network bandwidth if you want to use a network camera for both recording and live view.
You must calculate the network bandwidth both for the Storage Server and the Viewer.
When using the VB-H41 for example, calculate the bandwidth as follows if you use one Storage Server (320 x 240 1 fps) and
two Viewers (320 x 240 5 fps):
• Bandwidth for recording
10.8 (KB/frame) x 1 (frames/sec.) x 8 (bits) = 86.4 Kbps
• Bandwidth for live view (per Viewer)
10.8 (KB/frame) x 5 (frames/sec.) x 8 (bits) = 432 Kbps
Therefore, the required network bandwidth is calculated as follows:
86.4 Kbps x 1 + 432 Kbps x 2 = 950.4 Kbps (approx. 0.9 Mbps)
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About RM-Lite
RM-Lite is a simpler version of this software that is included with the camera. RM-Lite provides the same basic features as
the RM-64/25/9 product versions, but some of the functionality has be limited, as described below:

Important
• Files recorded using RM-Lite can be played back when an upgrade is made to RM-64/25/9. However, files recorded with RM-64/25/9
cannot be played back with RM-Lite.
• An RM-Lite viewer cannot connect to an RM-64/25/9 Storage Server. Similarly, an RM-64/25/9 viewer cannot connect to an RM-Lite
Storage Server.

 Functional limitations for RM-Lite
• You can add a maximum of four cameras.
• You can display a maximum of eight video windows in the Viewer. A warning message is displayed if you display nine or
more video windows.
• The maximum frame rate is as follows:
Recording
5 fps or lower (JPEG)
Record Now
5 fps
• The frame rate adjustment feature is always enabled under high load.
• The maximum file size is 1 GB (max. 24 hours).
• You cannot change the [Background] property in [Layout Properties], and live view is the only playback option.
• You cannot configure [Each Tag], [All Cameras] and [Recording Cameras] in [Organize Layouts].
• AXIS Q7404/Q7401 is not supported.

 Features that cannot be used in RM-Lite
Storage Server
• MPEG-4 and H.264 recording
• Motion detection recording
• Sensor recording
• Intelligent function recording
• Volume detection recording
• Special Day schedule recording
• Sending e-mail when an event occurs
• Customizing event priority
• Adding user groups and configuring access permissions
Viewer
• Multiple display support
• Layout sequences
• Display of multiple tabs
• Custom grid
• Dynamic layouts
• Searching using camera tags
• Advanced search feature of Event Search
• Event Notification - Operator Notification, Acknowledge Event
• Display of a video window when an event occurs.
RM-Lite is not included with the camera.
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About RM-Lite

1

Features
Connection to camera

RM-64/25/9

RM-Lite

Max. number of cameras

64/25/9

4

Supported cameras

VB-S30D, VB-S31D, VB-S800D,
VB-S900F, VB-S805D, VB-S905F,
VB-H43, VB-H630VE, VB-H630D,
VB-H730F, VB-H41, VB-H610VE,
VB-H610D, VB-H710F, VB-M42,
VB-M620VE, VB-M620D,
VB-M720F, VB-M40, VB-M600VE,
VB-M600D, VB-M700F,
VB-C500VD, VB-C500D, VB-C60,
VB-C300, VB-C50Fi, VB-C50FSi,
VB-C50i, VB-C50iR, AXIS Q7404/
Q7401

VB-S30D, VB-S31D, VB-S800D,
VB-S900F, VB-S805D, VB-S905F,
VB-H43, VB-H630VE, VB-H630D,
VB-H730F, VB-H41, VB-H610VE,
VB-H610D, VB-H710F, VB-M42,
VB-M620VE, VB-M620D,
VB-M720F, VB-M40, VB-M600VE,
VB-M600D, VB-M700F,
VB-C500VD, VB-C500D, VB-C60,
VB-C300, VB-C50Fi, VB-C50FSi,
VB-C50i, VB-C50iR

Automatic camera search
Storage Server

Viewer

Yes

Recording formats

JPEG, MPEG-4, H.264

JPEG only

1

5 fps

Max. recording frame rate

30 fps *

Recording schedule

Weekly schedule recording
Special Day schedule recording

Weekly schedule recording

Recording mode

Continuous recording
Sensor recording
Motion detection recording
Intelligent function recording
Volume detection recording
Manual recording (Record Now)

Continuous recording
Manual recording (Record Now)

Max. file size setting

Configurable 512 or 1024 MB, 1 to
24 hours (default: 1024 MB)

Fixed 1 GB (1024 MB), 24 hours

Max. storage period

99 weeks

90 days (12 weeks)

Others

—

The following features are not
supported:
• Sending e-mail when an event
occurs
• Customizing event priority

Supported live view formats

JPEG, MPEG-4, H.264
30 fps *1

Max. display frame rate
Multiple display support

Yes

Number of simultaneous video
windows

32 or fewer per layout *

Audio recording/playback
Layout sequence feature *

Introduction

 Specification comparison for RM-64/25/9 and RM-Lite

No
2

8 or less is recommended.
Yes

3

Yes

No

*1 The operational limits depend on factors, such as the number of cameras, Storage Server performance, hard disk
capacity, and network load.
*2 The maximum number of Dynamic Layout windows that can be displayed is 25.
*3 The layout sequence feature is a function for changing Viewer layouts at a specified interval.
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Setup

❏ How to install the software
❏ Settings after installation

Installation
Before Installation
About Licenses
You must have one license per installed computer.
To add Viewers, you must purchase the required number
of licenses separately (p. 21).

and install it, or use the installer in the [Applications] folder on
the setup CD-ROM included with the camera.

2

Click [Next].

3

Read the license agreement carefully. Click [I accept
the terms in the license agreement], if you accept
them, and then click [Next] to continue.

4

Enter your license key(s) and click [Next].

Use an NTFS Formatted Drive
The drive you install the software on and the drive for
saving recorded video must be in NTFS format.
Set Up the Cameras
You must set up any cameras that you will use with this
software before starting operation. For details, refer to the
camera manual.
Stop Other Applications
Stop other applications that are running on the computer,
such as anti-virus software, before installing the software.
Create a Backup
Before upgrading or reinstalling the software, it is
recommended that you create a backup. For details on
backup, see Chapter 8: Backup.

How to Install the Software
Important
You must log on to the computer as a computer administrator to
install this software.

1

The Storage Server, Viewer, or both are installed,
depending on the license key(s) you entered.

Insert the installation CD-ROM into the CD drive.
This starts the installer automatically. If the installer
does not automatically start, open the CD-ROM
directory using Windows Explorer and double-click
RM32setup.exe.

Note
•

Double-click RMLiteInstall.exe in the [Applications] folder
on the setup CD-ROM included with the camera.

• When the [User Account Control] dialog box appears, click
[Yes] or [Continue].
• On computers running Windows 7, Windows Vista or Windows
Server 2008, if .NET Framework 3.5 is not installed, a dialog
box is displayed asking you to install .NET Framework 3.5 Click
[Install] to start installation of .NET Framework 3.5.
.NET Framework 3.5 is not automatically installed.
Download the install file from the Microsoft download center
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The license key input dialog box is not displayed.
Instead, enter your name and affiliation in the dialog box
that is displayed and click [Next].

Installation

5

Click [Next].

Click [Install].

8

Click [Finish].

9

Click [Yes] to restart the computer.

2
Setup

7

Note
• You can click [Change] to change the destination folder.
However, we recommend that you do not change the
destination.
• To check the available disk space on each drive of the
computer and the disk space required for installation, click
[Space].
•

A dialog box asking you to specify the software to be
installed is displayed. If you click [Complete], proceed to the
step 6. If you click [Custom], the sample dialog box above is
displayed. Select which application to install, the Storage
Server or the Viewer. Click the application that you do not want
to install and select [This feature will not be available].

6

Click [Next].

An icon appears on your desktop when the installation is
complete.

Important
• You must restart the computer to enable the settings that
were made during the installation.

Note
• The IP address you set during installation can be changed
using the command line. See “Changing the Storage Server IP
Address” (p. 134) for details.
• When installing on a computer that has multiple network
interfaces, select the network interface to use in the [Network
adapter] list and the assigned IP address in the [IP address]
list.

• You must configure the operating system after installation.
For details, see “Settings After Installation” (p. 41).
•

If you reinstall this software after uninstalling it, the
setting configurations before uninstallation will not be
retained.

• When starting the Viewer, specify the IP address selected here
to connect to the Storage Server Group.
• If you clear the [Add storage server programs to the Windows
Firewall exception list.] check box, you need to configure
Windows Firewall after the installation is complete. For details,
see “Windows Firewall Settings” (p. 41).
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Upgrade from an Earlier Version
When upgrading, use the installer of the new version to
install the new version on top of the earlier version without
uninstalling the earlier version. This preserves the settings
such as the added camera information and recording
schedule, and recorded data.
Note that if you uninstall the earlier version before
installing the new version, you will need to redo all of your
camera and recording settings.

Note
License key entry is required when upgrading.

Upgrade from RM-Lite to RM-64/25/9
Installing RM-64/25/9 on a computer where RM-Lite is
installed will upgrade it to RM-64/25/9. This preserves the
settings such as the added camera information and
recording schedule, and recorded data.

Important
RM-Lite cannot exist with RM-64/25/9 on the same computer.
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Settings After Installation

Windows 7,
Windows Vista

Windows Server
2008, Windows 8,
Windows Server
2012

Windows Firewall
Setting

3

3

Security Level
Setting

—

3

Sound Settings for
Using the Audio
Feature

—

3

Warning When
Viewer Starts

3

3

(3: Required, —: Not required)

Windows Firewall Settings
If you install the Storage Server and the Viewer on
different computers, you must change the Windows
Firewall settings on the computer used for the Storage
Server.
The changes to the settings are already complete if you
selected the [Add storage server programs to the
Windows Firewall exception list.] check box during
installation. If you did not select the above check box
during installation, perform the following procedure to
change the Windows Firewall settings.
The following settings are not required if you install the
Storage Server and Viewer onto the same computer.

 When using Windows 7, Windows 8, Windows
Server 2008 R2, or Windows Server 2012

1

Click [System and Security] in the [Control Panel], and
then click [Windows Firewall].

2

Click [Advanced Settings] to display the [Windows
Firewall with Advanced Security] window.

3

Click [Inbound Rules] and select [New Rule] from the
[Action] menu to start the [New Inbound Rule Wizard].

4

Click [Port], and then click [Next].

5

Click [TCP] and [Specific local ports], and then enter
80 as the port number. Then click [Next].

6

Click [Allow the connection], and then click [Next].

7

Click [Next].

8

Enter a name (such as the Storage Server or Storage
Server Group name) in [Name] and click [Finish].

9

The added inbound rule should be displayed in the
[Windows Firewall with Advanced Security] window,
with a checkmark icon displayed next to the rule.

Setup

Configure the following settings after installing this
software according to the operating system you are using:

 When using Windows Vista or Windows Server
2008

1

Click [Start] > [Control Panel] to open the [Control
Panel].

2

Click [System Security] > [Windows Firewall].
If the [Control Panel] is set to [Classic View], double
click [Windows Firewall].

3

Click [Change settings].
If the [User Account Control] dialog box is displayed,
click [Continue].

4

Click the [Exceptions] tab and click [Add Port].

5

In the [Add a Port] dialog box, enter the name of the
Storage Server and 80 as the port number. Make sure
that [TCP] is selected and click [OK].

6

Confirm that the added Storage Server is now
displayed in the [Windows Firewall] dialog box and that
the check box is selected. Then, click [OK].
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Security Level Setting

Sound Settings for Using the Audio Feature

In Internet Explorer, the default security level setting for
Internet or intranet sites in Internet Explorer 9 or later, and
Windows Server 2008 is “High”. Therefore, you are not
able to configure settings in the configuration or top page
of the camera. Follow these steps to register the site as a
trusted site.

The sound feature is disabled by default in Windows
Server 2012, and 2008. To receive audio with the
camera’s Viewer, follow these steps to enable the sound
feature.

1

Start Internet Explorer and click [Tools] > [Internet
Options] to display the [Internet Options] dialog box.

2

Click the [Security] tab.

3

Click [Trusted Sites] and click [Sites].

4

Clear the [Require server verification (https:) for all
sites in this zone] check box.

5

Enter the IP address of your camera in [Add this
website to the zone] and click [Add].

Note
• For details on registration with trusted sites, click [Learn more
about Internet Explorer’s Enhanced Security Configuration] in
the [Internet Options] dialog box and refer to the displayed
summary.
• JavaScript may be disabled in the standard security setting,
even if a content block dialog box is not displayed. This may
limit the operation of the setting page or the camera’s Viewer.
The JavaScript setting is enabled automatically once trusted
site registration is complete.
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1

Click [Hardware and Sound] in the [Control Panel] and
then click [Sound].
If the [Control Panel] in Windows Server 2008 is set to
[Classic View], double-click [Sound] and proceed to
Step 3.

2

If the [Audio Service Not Running] dialog box is
displayed, click [Yes].

3

The [Sound] dialog box is displayed. Select the
[Playback] tab and confirm that an appropriate audio
device is installed.
If no audio device is installed, refer to the manual for
your computer on how to install an audio device.

Warning When Viewer Starts
If [User Account Control] is enabled, the [User Account
Control] screen will be displayed when you start the
Viewer. Click [Yes] (or [Continue]) to start the Viewer.

Chapter
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Storage Server Settings

❏ Adding cameras
❏ Configuring the Storage Server Group
❏ Adding users

Flow of Storage Server Settings
Start the Viewer (p. 45)

Configure a Storage Server Group
Display the [Storage Server Group Settings] dialog box (p. 47)

Change the Storage Server Group name (p. 47)
Configure the recording settings (p. 47)
Configure the event priority and e-mail notifications (p. 48)

Configure a Storage Server
Display the [Servers] tab (p. 51)

Specify the storage period for recorded video (p. 51)
Change the destination of the recording file and the maximum disk usage (p. 52)

Add a camera
Display the [Cameras] tab (p. 53)

Add cameras one at a time (p. 53)

Search for and add cameras (p. 54)

Add a user
Display the [Users] tab (p. 57)

Add a user (p. 58)

Add a user group and specify its
access permissions (p. 59)

Important
We strongly recommend that only one administrator configure the Storage Servers on each network.
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Start the Viewer

3

connection.

Important

• You must log on as a computer administrator to configure the
Storage Server from the Viewer.
• Check to make sure that other users are not connected to the
Storage Server before configuring it from the Viewer.

3

Click [Connect].

Storage Server Settings

• The Viewer cannot be started on its own. Be sure to start the
Viewer in an environment that allows it to connect to the
Storage Server.

Important
• You should change the password for the default user
(administrator) as a security measure. For details on how to
change the password, see “Add a User” (p. 57).
• Be sure to remember your password.

1

Double-click the [RM Viewer] icon on your desktop.

Double-click the [RM-Lite Viewer v3.2] icon on your
desktop

Note
If the [User Account Control] dialog box appears, click [Yes] (or
[Continue]).

2

Specify the information required to connect to the
Storage Server Group.

(1)

(2)

(3)
(4)
(5)
(1) [Host Name]
Enter the host name or the IP address of the Storage
Server Group. If the Viewer and the Storage Server
are installed on the same computer, enter “localhost”.

• You must start the Viewer while logged on as a user in the
Administrator user group to be able to set up the Storage
Server.

Note
• The first time you connect to the Storage Server Group, you
must enter the host name and port number. However, from the
second time onward, you can simply specify the Storage
Server Group name (p. 46).
• If there are no cameras added, a message is displayed asking
if you want to add a camera. Click [Yes] to display the [Add
Camera] dialog box and start adding a camera on the network.
For details, see “Add Cameras One at a Time” (p. 53).
• When there is a time difference of 5 seconds or longer
between the Storage Server and the Viewer computer, a
message prompting you to synchronize them will appear.
Adjust the system time of the Viewer computer to the time of
the Storage Server. You can disable the message display in
[Viewer Settings]. For details, see “Configure the Viewer
Display and Operation Settings” (p. 63).
• You can configure the Viewer to start without displaying the
startup screen or the [Connect to Storage Server Group] dialog
box. For details, see “Create a Shortcut Icon for Starting the
Viewer” (p. 134).

Note
Enter the Storage Server name or the IP address selected when
installing the Storage Server.

(2) [Port]
Normally, leave [80] unchanged.
(3) [User Name], [Password]
Enter your user name and password.
The default user name and password are:
User Name: administrator
Password: NVR
(4) [Remember user name]
Select the check box if you want the software to
remember the user name.
(5) [Use Group Name]
Click to specify a Storage Server Group name for the
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 Specify the Storage Server Group for Starting
the Viewer
You can start the Viewer using a Storage Server Group
name instead of the host name of the server.

1

Double-click the [RM Viewer] icon on the desktop.

Double-click the [RM-Lite Viewer v3.2] icon on your
desktop

Note
If the [User Account Control] dialog box appears, click [Yes] (or
[Continue]).

2

Click [Use Group Name].

3

Specify the information required to connect to the
Storage Server Group.

(1)
(2)
(3)
(4)
(1) [Group Name]
Display the Storage Server Group name.
(2) [User Name] and [Password]
Enter the use name and password.
The default user name and password are:
User Name: administrator
Password: NVR
(3) [Remember user name]
Select the check box if you want the software to
remember the user name.
(4) [Use Host Name]
Click to specify a host name of the Storage Server for
the connection.

4
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Click [Connect].

Configure a Storage Server Group
You can configure the recording method and event
priority.

2

Display the [Storage Server Group Settings]
Dialog Box

Configure the Recording Settings
Configure the recording settings, such as the maximum
recording file size.

1

Click the [Recording Settings] tab.

2

Configure the recording settings.

The [Storage Server Group Settings] dialog box is
displayed.

(1)

(2)
(4)

(1)
(3)

Storage Server Settings

1

Click [Settings] > [Storage Server Group].

3

Change the Storage Server name and click [OK].

(2)
(3)

(4)

(5)
(1) [Storage Server Group]
Display the Storage Server Group name.
(2) [Edit]
Change the name of Storage Server Group.
(3) [Recording Settings] tab
Make settings for recording files and notifications of
available disk space.
(4) [Events] tab
Configure the method for processing events for a
Storage Server.
(5) [OK] and [Cancel]
Close the dialog box.

(1) [Maximum File Size / Duration]
Specify the maximum size or the maximum recording
duration for the recording file.
You can set a maximum file size of 512 MB or 1024
MB, and a maximum recording duration of 1 to 24
hours.
(2) [Low Disk Space Warning Level]
Specify when to notify the user of low available disk
space as a percentage of the maximum disk usage.
(3) [Reduce recording frame rate when disk is under high
load]
Select the check box to decrease the frame rate
automatically when the system load is high.
(4) [OK] and [Cancel]
Close the dialog box.

3

Click [OK] to close the dialog box.

Change the Storage Server Group Name

1

Click [Edit] to display the [Edit Storage Server Group
Name] dialog box.

• The maximum size is fixed at 1 GB (1024 MB) and the
maximum duration is fixed at 24 hours.
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• [Reduce recording frame rate when disk is under high
load] is always enabled. You cannot disable it. You can
confirm whether the frame rate has been automatically
reduced by checking the [Live Events Log]. (An e-mail
notification is not sent.)

Important

Configure Event Priorities and E-mail
Notifications
Configure the priority of an event that occurs in the
Storage Server Group.

1

Select the [Events] tab.

An event is triggered when the available disk space reaches
the value specified in [Low Disk Space Warning Level].

Note
Select [Reduce recording frame rate when disk is under high
load] to trigger an event when the recording frame rate
decreases.

(1)

(2)

(3)

(4)

(5)
(1) [E-mail Notification]
Display a list of e-mail addresses for sending
notification messages when an event is triggered, and
the priority of the event.
(2) [Add], [Edit], and [Remove]
Add, edit or remove an e-mail notification destination.
(3) [Mail Server Settings]
Configure the mail server used for notifications.
(4) [Event Priorities]
Configure the event priorities.
(5) [OK] and [Cancel]
Close the dialog box.
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Configure a Storage Server Group

 Configure the Mail Server

 Add an E-mail Notification Destination

Click [Mail Server Settings] to display the [Mail Server
Settings] dialog box.

2

Configure the mail server settings.

1

Click [Add] in the [Events] tab of the [Storage Server
Group Settings] dialog box to display the [E-mail
Notification Settings] dialog box.

2

Configure the e-mail notification settings.

(1)
(2)
(3)
(4)
(5)

3
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1

(1)
(2)
(3)
(4)
(6)
(5)

(1) [SMTP Server] and [Port]
Enter an SMTP server name and change the port
number, as required.
(2) [Authentication]
Specify an SMTP server authentication method
([None], [POP before SMTP], [SMTP-AUTH]).
(3) [User Name]
If [POP before SMTP] or [SMTP-AUTH] is selected in
[Authentication], enter a user name to be used for
authentication.
(4) [Password]
Enter a password to be used for authentication with
the user name entered in (3).
(5) [POP Server] and [Port]
If [POP before SMTP] is selected in [Authentication],
enter the name of the POP server to be used for
authentication and the port number, as required.

(1) [To]
Enter an e-mail address as the destination.
(2) [From]
Enter the e-mail address of the sender.
(3) [Subject]
Enter the subject of the e-mail.
(4) [Min. Priority]
Specify the minimum event priority level which will
generate an e-mail notification.
(5) [OK] and [Cancel]
Close the dialog box.

3

Click [OK] to close the dialog box.
The e-mail address for the specified destination and
the event priority are added to the [E-mail Notification]
list.

(6) [OK] and [Cancel]
Close the dialog box.

3

Click [OK] to close the dialog box.

Note
If [POP before SMTP] is selected in [Authentication], the Storage
Server performs POP authentication before sending an e-mail
message.
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 Specify the Event Priority
Change the priority depending on the event type using
[Event Priorities] in the [Events] tab. E-mail notification is
performed according to the specified priorities.

Click or drag the slider for each event to change the
priority.
The priority can be set to one of the following five levels:
Level Value
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Color

Highest

Red

High

Orange

Medium

Yellow

Low

Light Green

Lowest

Green

Configure a Storage Server
You can specify the storage period of the recorded video
and the maximum disk usage.

1

Click [Settings] > [Storage Servers].

The [Servers] tab is displayed in the [Settings] dialog
box.

(1)

(2)
(3)

(4)

(5)
(1) [Storage Server Group]
Display the Storage Server Group name.
(2) List of Storage Servers
Display a list of Storage Servers.
(3) [Edit]
Edit a Storage Server.
(4) [Recorded Video Settings]
Specify the minimum and maximum storage period for
recorded video.
(5) [Close]
Close the dialog box.

Storage Server Settings

Display the [Servers] Tab

3

Specify the Storage Period for Recorded
Video
You can specify the storage period for video recorded on
the Storage Server.
• Specify a minimum storage period that is within the
maximum storage period. For example, if the
maximum storage period is 10 days, specify a
minimum storage period of 2 days.
• Recorded video is automatically deleted when it
exceeds the maximum storage period.
• The Storage Sever monitors available disk space for
recording video. When disk space falls below
“(Number of cameras + 1) x 64 MB” (threshold level),
recorded video will be deleted starting with the oldest
video, including video still within the maximum storage
period, until enough disk space above the threshold
level has been freed (p. 115). When this happens, a
“Delete recorded files (when disk space is low)” event
occurs.
• Video within the minimum storage period will be
deleted if enough disk space above the threshold level
cannot be freed, even if all the recorded video that has
exceeded the minimum storage period is deleted.
When this happens, a “Delete recorded files (when
disk space is insufficient)” event occurs, which
indicates insufficient disk space for the video recording
settings. Changes to the system configuration, such as
disk space, or video quality and frame rates for
recorded video, are recommended.
• To specify the minimum storage period, select the
[Ensure video is kept for at least] check box. Select the
units (day or week) of the storage period and enter the
number of days or weeks, up to a maximum of 99.
• To specify the maximum storage period, select the
[Ensure video is kept for upto] check box. Select the
units (day or week) of the storage period and enter the
number of days or weeks, up to a maximum of 99.
•
Select the units (days or weeks) of the storage
period and enter the number of days (1 to 90) or weeks
(1 to 12). [Ensure video is kept for upto] is always
enabled.

Important
Depending on the maximum disk usage setting for the Storage
Server (p. 52), recordings may not be stored for the full storage
period specified in this setting.
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Change the Destination of the Recording File
and the Maximum Disk Usage
Specify a drive for recording or change the maximum disk
usage.

1

Select a Storage Server from the list of Storage
Servers.

2

Click [Edit] to display the [Storage Server Settings]
dialog box.

3

Clear the check boxes next to the drives that are not
used for recording.

4

Specify the maximum disk usage.
Click [Do not limit] for each drive to display the
maximum disk usage. Select the [Maximum Disk
Space Used] check box and specify a maximum disk
usage that does not exceed the total disk capacity.

5

Click [OK] to close the dialog box.

Important
• We recommend that you do not specify the system drive
(typically the C drive) as the destination for the recording file.
• You cannot specify a drive that has a capacity of less than
1 GB.
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Add a Camera
You can add a camera to be used for displaying video or
recording to a Storage Server.

• The number of cameras you can add to a Storage Server
depends on the version of this software product.
You can add up to four cameras.

Display the [Cameras] Tab
Display the [Cameras] tab in the [Settings] dialog box to
start adding a camera.

1

Click [Settings] > [Cameras].

1

Click [Add] to display the [Add Camera] dialog box.

2

Enter the information required to add the camera.

Storage Server Settings

Add cameras one at a time to the list of cameras on the
[Cameras] tab.

Note

•

3

Add Cameras One at a Time

(2)

(1)
(3)
(4)
(5)
(6)

(8)

(7)

(1)

(9)
(1) [Host Name]
Enter the host name or IP address of the camera.
(2) [Port]
Enter the port number for communicating with the
camera. Typically, leave [80] unchanged.

(2)

(3) [User Name]
Enter the user name for the camera.
(4) [Password]
Enter the password for the user specified in (3).

(3)

(4)

(1) [Storage Server Group]
Display the Storage Server Group name.
(2) List of cameras
Displays a list of already added cameras.
(3) [Find]
Search for cameras on the network.
(4) [Add], [Edit], and [Remove]
Add, edit or remove a camera.

(5)

(5) [Storage Server Group]
Display the Storage Server Group name.
(6) [Tags]
Display the tags assigned to the camera.
(7) [Edit]
Specify a new tag and add it to the list in (6).
(8) [Remove]
Remove tags selected in (6).
(9) [OK] and [Cancel]
Close the dialog box.

(5) [Close]
Closes the dialog box.
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3

Click [OK] to close the dialog box.

 Using Camera Tags

The camera is added in the list of cameras on the
[Cameras] tab.

Camera tags help you organize cameras more easily.

Video from a camera connected to a multi-terminal VBEX50 cannot be displayed or recorded by this software.

Important
• Enter the camera’s user name and password in [User Name]
and [Password].
• If the host name or IP address of the camera is changed after
registration, you must also change the Storage Server
setting. For details, see “Edit Camera Information” (p. 55).

Assign Camera Tags
You can assign keywords, such as the installation
location, called camera tags, to the camera.
Click [Edit] in the [Add Camera] dialog box when you are
adding the camera to display the [Edit Tags] dialog box.

Selectively Displaying Cameras
You can use camera tags to selectively display cameras
in the following windows and dialog boxes:
• Camera Selector (p. 65)
• [Recording Schedule] window (p. 79)
• [System Information] window (p. 113)
Specifying a Camera
You can specify a camera using camera tags when doing
the following operations:
• Specifying a camera with access permissions for user
group operation (p. 59)
• Specifying a camera to be automatically displayed in
the dynamic layout (p. 73)

Search For and Add Cameras
You can search for cameras that are on the same network
as the Storage Server.

1

Click [Find].
The cameras on the subnet are displayed in the
[Camera Search Results] dialog box.

(1)

(2)

(3)
(1) List of camera tags
Displays a list of assigned camera tags. Select the
check box of the tag to assign it to the camera. You
can assign more than one camera tag.
(2) Add camera tag area
Add a new camera tag.
[Add]
Enter a tag name in the text box and click this button
to add the tag to the list.
(3) [OK] and [Cancel]
Close the dialog box.
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2

Select the check box of a camera you want to add. To
select all the cameras, click [Select All].
You can add more than one camera by selecting
multiple check boxes.

3

Click [Add].
The [Add Camera] dialog boxes for the cameras
selected in step 2 are displayed in the order of the
[Camera Search Results] list (from top to bottom).

4

Enter the information required to add the camera,
referring to step 2 in “Add Cameras One at a Time”
(p. 53).

5

Click [OK] to close the dialog box.

Add a Camera

6

Repeat steps 4 and 5.

(3) [Tags]
Displays the tags assigned to the camera.

7

When you finish adding cameras click [Cancel].

(4) [Edit]
Add a new tag to the list in (3).

3

Note
• You can only search for cameras on the same subnet as the
Storage Server. For details on how to add cameras on a
different subnet, see “Add Cameras One at a Time” (p. 53).
• The names of the cameras (stored on the camera) are
displayed in the list in the [Camera Search Results] dialog box.
However, the VB-C300 camera name is not displayed.
• Cameras that have already been added are also found.
However, a check box is not displayed next to the camera.
• If you cannot find the camera you are searching for, see “Add
Cameras One at a Time” (p. 53) and add the camera.

Storage Server Settings

(5) [Remove]
Remove tags selected in (4).
(6) [OK] and [Cancel]
Close the dialog box.
(7) [Apply]
Apply the settings in the dialog box.

Note
The camera name specified in the text box is only used by this
software product. The camera name stored on the camera is not
changed.

[Advanced] tab

• Host names or IPv4 addresses are displayed in the [Host
Name] column of the [Camera Search Results] dialog box.
(IPv6 addresses are not supported.)

(2)

(1)
(3)
(4)
(5)

Edit Camera Information
You can edit the camera registration information, such as
the camera name or the thumbnail image displayed in the
Viewer.

1

Select a camera in the list and click [Edit] in the
[Settings] dialog box to display the camera properties.

2

Configure the displayed settings.

(6)

(7)

[General] tab

(8)

(1) [Host Name]
Change the host name or IP address of the camera.

(1)

(2) [Port]
Change the port number used for communicating with
the camera. Typically, leave [80] unchanged.

(2)

(3) [User Name]
Change the user name of the camera.

(3)

(4) [Password]
Change the password for the user entered in (3).

(5)

(4)

(6)

(7)

(5) [Disable Camera]
Disables the camera temporarily. To enable the
camera, click [Enable Camera].
(6) [Storage Server Group]
Displays the Storage Server Group where the camera
is registered.

(1) Camera name box
Enter a camera name.

(7) [OK] and [Cancel]
Close the dialog box.

(2) [Update]
Update the thumbnail image in the camera selection
panel.

(8) [Apply]
Apply the settings in the dialog box.
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Note

2

Click [Remove].

3

A message is displayed asking if you want to remove
the camera. Click [Yes].

• Items (1) to (4) can only be changed if the camera is disabled
using [Disable Camera].
• If a camera is not working, you can disable it to prevent
communication error notifications from being sent repeatedly.
• If you replace a camera that is not working with another
camera, change the new camera’s host name, etc. to that of
the non-working camera so there will be no effect on existing
recording schedules and settings. (The replacement should be
the same model as the original camera.)

 Change the Thumbnail Image of a Camera
You can change the thumbnail image of a camera.
In the camera properties dialog box, click the [General]
tab and click [Update] to display the [Thumbnail] dialog
box.

(1)

(2)
(3)
(4)
(1) Preview video
Drag the slider to change the zoom position of the
camera. Click in the preview video to change the
camera position.
(2) [Select Preset]
Select a preset made with the camera.
(3) [Update]
Use the current preview video as the camera
thumbnail image. The [Thumbnail] dialog box closes
and the camera thumbnail image is updated.
(4) [Cancel]
Close the dialog box without updating the thumbnail
image.

Note
• You must configure the presets first before starting operation.
For details, see the camera manual.
• The pan/tilt/zoom operation and preset selection may be
disabled, depending on the camera in use.

Remove a Camera

1
56

Select a camera in the list of cameras on the
[Cameras] tab.

Important
If you remove a camera, you will no longer be able to play back
recordings made with the camera. If you need to play back the
recordings, use [Disable Camera] on the [Advanced] tab
instead of removing the camera.

Add a User
You can add users to the Viewer and place them in the
administrator group or the general user group.

3

Display the [Users] Tab

Storage Server Settings

1

Click [Settings] > [Users].

About User Groups
The Viewer provides the following two user groups, each
with different user permissions.
• Administrator
Users in this group can fully operate the Viewer.
• Operator
Users in this group have limited access to the features
of the Viewer. They cannot configure a camera or set a
recording schedule.

The [Users] tab is displayed in the [Settings] dialog
box.

(1)

You can specify the group to which the added user
belongs by selecting from [User Group].
You can create a new user group and specify permissions
for users that belong to the group.

(2)

Important
• A default user called “administrator” is created in the
Administrator user group. The password for this user is
“NVR”. We recommend that you change the password for
this user after installation. We strongly recommend that, for
normal surveillance operation, you create individual users
with access permissions for only the minimum required
functionality.
• Be sure to remember your password.
•

You cannot add user groups.

Note
Administrator for this software program does not refer to the
Windows administrator.

(3)

(4)
(5)

(1) [Storage Server Group]
Display the Storage Server Group name.
(2) List of users
Displays a list of existing users.
(3) [Add], [Edit], and [Remove]
Add, edit or remove a user.
(4) [User Group Settings]
Add, edit or delete a user group.
(5) [Close]
Closes the dialog box.

57

Add a User

Change the User Information

Use this tab to add a new Viewer user. Also use it to
specify the kind of user (Administrator or Operator).

1

Select a user in the list.

2

Click [Edit] to display the [Edit User] dialog box.

3

Change the user information.

1

Click [Add] to display the [Add User] dialog box.

2

Enter the information required to add the user.

(1)
(2)
(3)
(4)

(1)
(2)
(3)
(4)
(5)
(5)

(1) [User Name]
Enter the name of the user to be added.

(6)

(2) [Password]
Enter the password used to log into the Viewer.

(1) [User Name]
All user names can be changed, except for the default
“administrator” user name.

(3) [Confirm Password]
Enter the password again for confirmation.

(2) [Old Password]
Enter the old password.

(4) [User Group]
Select the user group (“Administrator” or “Operator”).
You can also select an added user group. For details,
see “Add a User Group and Specify Its Access
Permissions” (p. 59).

(3) [New Password]
Enter the new password.

(5) [OK] and [Cancel]
Close the dialog box.

3

Click [OK] to close the dialog box.
The added user appears in the list of users on the
[Users] tab.

(4) [Confirm New Password]
Enter the new password again for confirmation.
(5) [User Group]
Select a user group (“Administrator” or “Operator”).
You can also select an added user group (p. 59).
The default “administrator” user is associated with the
Administrator user group. You cannot change this
user group for the default “administrator” user.
(6) [OK] and [Cancel]
Close the dialog box.

4

58

Click [OK] to close the dialog box.

Add a User

 Specify Individual Access Permissions

Remove a User

Click [Partial Control] and select the check boxes next to
the desired access permissions for each feature.

Select a user in the list.

2

Click [Remove].

3

A message asking if you want to remove the user is
displayed. Click [Yes].

3
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1

Note
You cannot delete the default “administrator” user.

Add a User Group and Specify Its Access
Permissions
You can create additional user groups and specify
access permissions for the group.
In the [Settings] dialog box, click the [User] tab and click
[User Group Settings] to display the [User Group
Settings] dialog box.

(1)
(2)

Access permissions for
each feature

Selected camera tags

Select the check box next to a feature to enable operation
of the feature.
Camera tags are only displayed for [View Live Video],
[Playback Recorded Video], and [View Recording
Schedules]. Click a tag to display a dialog box for
specifying camera tags to narrow down the cameras to
which the access permissions will be assigned.

(3)

(4)

(5)
(1) List of user groups
Displays a list of existing user groups.
(2) [Add], [Edit], and [Remove]
Add, edit or remove a user group.
(3) [Full Control]
Assign all access permissions for the selected user
group.
(4) [Partial Control]
Specify individual access permissions for the selected
user group.
(5) [Close]
Close the dialog box.

Note
You cannot edit or remove the “Administrator” and “Operator”
user groups.
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Chapter

4

Viewer Settings

❏ Configuring the Viewer
❏ Configuring a camera
❏ Creating a layout

Flow for Viewer Settings
Start the Viewer (p. 45)

Configure the Viewer
Display the [Viewer Settings] dialog box (p. 63)

Configure the Viewer display and operation settings (p. 63)

Configure the display/hide mode for each event (p. 64)

Configure event notification and priorities (p. 64)

Configure the camera
Display the [Camera Selector] dialog box (p. 65)

Select a camera (p. 65)

Configure the [Advanced Camera Settings] (p. 68)

Configure the video window (p. 66)

Configure the video window layout
Create a layout (p. 71)

Place a video window (p. 72)

Save the layout (p. 73)

Configure a dynamic layout (p. 73)

Configure a layout sequence (p. 74)

Important
We strongly recommend that only one administrator configure the Storage Servers on each network.
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Configure the Viewer
Start the Viewer and configure it for day-to-day
operations. For details on how to start the Viewer, see
“Start the Viewer” (p. 45).

1

Click [Settings] > [Viewer].

1

Click the [General] tab.

2

Configure each item.

4
Viewer Settings

Display the [Viewer Settings] dialog box

Configure the Viewer Display and Operation
Settings

(1)
(2)
(3)
(4)
(5)
The [Viewer Settings] dialog box is displayed.

(1)

(2)

(3)

(6)
(7)
(8)

(1) [Maximum Live Frame Rate]
Specify the maximum live view frame rate.
(2) [Manual Recording Duration]
Specify the [Record Now] recording time, from 30 to
300 seconds.
(3) [Auto adjust frame rate under heavy load]
Automatically adjust the display frame rate.

(4)
(1) [General] tab
Configure the Viewer screen display settings.
(2) [Event Notification] tab
Configure how the Viewer displays an event.
(3) [Event Display] tab
Specify the types of events to be displayed in the
Viewer.
(4) [OK] and [Cancel]
Close the dialog box.

(4) [Use large captions for video window title bars]
Increase the title bar text size of the video window.
(5) [Confirm when changing to full screen mode]
Display a confirmation message when switching to full
screen mode.
(6) [Prompt to save changes when layouts are closed]
Display a confirmation message when a layout in the
Viewer is closed. The message is not displayed if the
layout is not changed.
(7) [Timeout Before Ending]
Automatically stop two-way audio communication
after the specified period, from 1 to 60 minutes.
You can also specify 0 minutes. However, two-way
audio communication will not stop automatically in
such cases, so you must stop it manually. We
recommend setting an arbitrary timeout duration to
avoid unintentional continuation of audio
communication.
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(8) [Send notification when time is out-of-sync with the
storage server group]
Display a message if there is a time difference of 5
seconds or longer between the Storage Server and
the Viewer computer when connected to a Storage
Server Group.

(4) [Acknowledge Event]
Prompt the operator to acknowledge an event.
[Equal to or higher than]
Specify the priority of events to be acknowledged.
You cannot change the [Show Video Window on
Event], [Operator Notification], and [Acknowledge Event]
settings.

Configure Event Notification and Priorities

1

Click the [Event Notification] tab.

Configure the Display/Hide Mode for Each
Event

2

Configure each item.

Specify the types of events displayed in the [Live Events
Log] dialog box and on the timeline.

1

Click the [Event Display] tab.

2

Specify whether or not to display each type of event.

(1)
(2)

(3)

(4)

(1) [Show Events in Live Events Log and Timeline]
Display an event in the [Live Events Log] dialog box
and on the timeline.
[Equal to or higher than]
Specify the priority of events to be displayed.
(2) [Show Video Window on Event]
Automatically display the camera’s video window
when an event occurs.
[Equal to or higher than]
Specify the priority of events for which a video window
is displayed.
(3) [Operator Notification]
Notify the operator that an event occurred.
[Equal to or higher than]
Specify the priority of events to be notified.
[Flash event indicator for]
Specify the time the event indicator flashes right after
the event occurs, from 1 to 99 seconds.
[Play audio alert]
Beep when an event occurs.
[Display event indicator during playback]
Display an event during playback.
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Select an event to be displayed in the [Live Events
Log] dialog box and on the timeline.

Configure the Camera
Select the cameras to use, using this software, and make
settings related to the individual cameras.

Important

4

When you have a large number of cameras registered,
search for the camera using the camera name or any
associated tags.

1

Viewer Settings

The configuration items and values that are available will vary
depending on the camera and settings used for recording. For
details, refer to the camera manual.

Select a Camera

Click the search button and specify the search criteria.
Search button
Search criteria box

Display the [Camera Selector] dialog box

1

Click [Window] > [Camera Selector].

The following items are displayed when you click the
search button.
The [Camera Selector] dialog box is displayed.

(1)

• [Name, Tag or Status]
Enter a camera name, tag or camera status in the
search criteria box.
• [Camera Name]
Enter the camera name in the search criteria box.
• [Tag]
Select the camera tag to be searched.
• [Camera Status]
Select the camera status to be searched.

(2)

• [Camera Type]
Select the model name to be searched.

(1) [Search for] box
Search for the camera to be used for display.
(2) Camera list
Displays a list of registered cameras.

Note
Each time you select [Window] > [Camera Selector], the display
of the [Camera Selector] dialog box is toggled on or off.

• [Host Name (camera)]
Enter the camera host name or IP address in the
search criteria box.
• [Storage Server Group Name]
Searching by this item is not available.

2

Specify the search criteria and search for the camera.

3

Double-click the camera in the search results to
display the video window.
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Configure the Video Window
You can configure the video window settings, including
the window size and the video format (JPEG or MPEG-4).

 Change the Video Window Size
(1)

(2)

(1) Video window menu button
Click to display a menu for operating the video
window.
(2) Title bar
Displays the camera name and type of video being
displayed.

4

To display video from other cameras, repeat step 3.

Important
• When an error occurs, the corresponding error message is
displayed in the video window. For details, see “Error
Messages in the Video Window” (p. 125).
• The number of video windows that can be displayed in the
Viewer depends on factors such as the graphics card, CPU
performance, frame rate, camera video size, and the video
quality.
• Viewer operation may slow down under high CPU loads.

Note
Depending on the on-screen display function of the camera, you
may need to change the display position if displayed text is
concealed by the title bar or other objects.

1

Click the video window menu button to display the
menu.

2

Click [Video Display Size] and select the video window
size from the submenu.

• [160x120] / [320x240] / [640x480]
Change the size of the video window, selecting from
small ([160x120]), medium ([320x240]) and large
([640x480]).
• [Default]
Adjusts the size of the video window to the received
video size. For the video size during reception, see
“Change the Video Window Resolution” (p. 67).
• [Full Screen]
Display a video on the entire screen. For details, see
“Display the video Full Screen” (p. 67).

Note
• Drag any corner of the video window to resize it.
• If the video window size selected in the [Video Receive Size]
submenu is greater than [640 x 480], the load on the CPU will
increase and the Viewer may operate more slowly.
• Depending on the grid (p. 72) type that is selected, some of
the [Video Display Size] submenus are grayed out and cannot
be selected.

Grid type

Sizes that cannot be selected in [Video
Display Size]

[None]

None (any selection is available)

[Alignment]

None (any selection is available)

[160x120]

[Default]

[320x240]

[160x120], [Default]

[640x480]

[160x120], [320x240], [Default]

[Custom]

[160x120], [320x240], [640x480],
[Default]

• If the video receive size and video display size have a different
aspect ratio, black bands may be displayed along the left/right
edges or top/bottom edges of the video.
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 Change the Video Window Format

1

Click the video window menu button to display the
menu.

2

Click [Video Format] and select the video format
([JPEG] or [MPEG-4], or [H.264]) from the submenu.

A white frame is displayed surrounding the selected
video window.

2

Click [Video Display Size] and select [Full Screen] from
the submenu.

3

A confirmation message is displayed. Click [Yes].

4

Viewer Settings

The video from the selected video window is
displayed full screen.

Important
Live video and audio are not synchronized for [MPEG-4] and
[H.264].

4

To exit full screen display, press the Esc key.

 Change the Video Window Resolution

1

Click the video window menu button to display the
menu.

2

Click [Video Receive Size] and select the resolution
from the submenu.
[160x120], [320x240], [480x270], [640x480],
[960x540], [1280x960], [1920x1080] and [Default] are
available. Select [Default] to use the camera’s
resolution.

Important
• When you display more than one video window for the same
camera, changes to the resolution of one of these windows
are applied to all of the other windows.
• The three video receive sizes in each set, for example
[480x270 (320x180 / 320x240)], in the [Video Receive Size]
submenu are sizes that correspond to the category [1080p
category (720p category / 4:3 category)], respectively.
Which of the three sizes that is used is determined by the
size set in [Video Size Set] for the camera.
•
The video size is set to “480x270” when [480x270 (320x180 /
320x240)] is selected in [Video Receive Size]. To set to
“320x240,” select [320x240].

Note
• If you save the layout (p. 73), the [Video Receive Size] setting
is also saved.
• The size used for [Default] is determined the first time you
display a video from the camera. The size on the Viewer will
not change, even if you change the size setting on the camera.

 Display the video Full Screen
You can display the video full screen.

1

Click the video window menu button to display the
menu.
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Configure the [Advanced Camera Settings]

1

Click [Window] > [Camera Control].

2

Click the video window of the camera you want to
configure and click [Control] on the [Camera Control]
dialog box to get control of the camera.

3

Click [Advanced] on the [Camera Control] dialog box to
display the [Advanced Camera Settings] dialog box.

4

Click the tab that you want to configure.

5

After configuring the settings, click [Close].

[Image Adjustment] tab

(1)

(2)
(3)

(4)

Important
• If camera control is lost while the [Advanced Camera
Settings] dialog box is open, you cannot continue configuring
the settings. Click [Control] on the [Camera Control] dialog
box again to get control and continue configuring the
settings. For details on camera control privileges, see “Get
Control of a Camera” (p. 105).
• [Advanced Camera Settings] is only available while
recording a video when you have camera control privileges.
If camera control is lost, settings will return to the recording
schedule settings.
• If intelligent function detection settings are enabled when the
camera position is fixed, the software cannot obtain camera
control privileges in order to configure advanced camera
settings. In this case, configure the camera on the setting
page of the camera.

(1) [Exposure]
The settings change according to the selected
exposure setting.
• [Auto]
Automatically control the exposure.
• [Auto (Flickerless)]
Reduce flicker from light sources, such as
fluorescent lighting. The shutter speed is
automatically adjusted according to the lighting
conditions.
• [Auto (Shutter Priority)]
Specify the shutter speed.
The following exposure compensation setting is
displayed when [Auto], [Auto (Flickerless)], or [Auto
(Shutter Priority)] is selected.

 Adjust the Video Quality
Adjust the video quality using the [Image Adjustment] tab
in the [Advanced Camera Settings] dialog box.

[Compensation]: Specify exposure compensation.
Select negative values to darken the video and
positive values to lighten the video.
[Metering Mode]: Specify the metering mode setting:
[Center-weighted], [Average], or [Spot].
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Metering mode

Description

[Center-weighted]

Meters the entire scene, with an
emphasis on the center. Correct
exposure is obtained for a subject
near the center of the scene, even
though the periphery may be slightly
darker or lighter. Use for subjects
that are in the center of the scene.

[Spot]

Meters an average of the entire
scene.
A uniform exposure is obtained even
when the scene has significant
differences in brightness.
Use for scenes where, for example,
cars are passing through or people
are entering and exiting.
Meters the center of the scene.
The correct exposure is obtained for
a subject near the center of the
scene, irrespective of the brightness
of the periphery.
Use if the subject is lit by a spotlight
or is backlit, where the exposure
should be adjusted to the center of
the scene.

[Shutter]: Specify the shutter speed when [Exposure]
is set to [Auto (Shutter Priority)].
• [Manual]
Compensate for the exposure manually. The
following exposure compensation settings are
displayed.

(3) [Aperture Mode]
Specify the camera aperture mode.

4

[Night Mode]
• [Disabled]
Disable the night mode function.

Viewer Settings

[Average]

[1] to [7]: Select one of seven strength levels when
setting the smart shade control function
manually.

• [Enabled]
Display live video in night mode.
• [Auto]
The camera automatically switches to night mode.
(4) [White Balance]
Specify the appropriate white balance by selecting
one of the camera’s light source settings displayed in
the list.
If [Manual] is selected, use one of the following two
methods to adjust the white balance.
• [R Gain] and [B Gain]
Specify the white balance parameters by dragging
the sliders. Drag to the right to increase the gain (the
sensitivity to brightness).
• [One Shot WB]
Force white balance adjustment to a light source.
Using a white object (such as piece of white paper)
as a standard, fill the shot with the object and click
this button.

Important
If you select [Enabled] for Night Mode, you will not be able to
set the white balance. If you select [Auto] for Night Mode,
however, you will be able to set the white balance, but those
settings will be cleared when the camera switches to Night
Mode.

[Iris]: Specify the iris setting. Drag the slider to the left
to close down the iris and make the video
darker or to the right to open up the iris and
make the video brighter.
[Shutter]: Specify the shutter speed.
[Gain]: Specify the gain (sensitivity to brightness).
Drag the slider to the left to decrease the gain
and make the video darker or to the right to
increase the gain and make the video brighter.

Note
When [Night Mode] is enabled in [Aperture Mode], both the
displayed and recorded video is in black and white.

Note
The [Auto (Flickerless 2)] setting is not supported.

(2) [Smart Shade Control]
Specify a value to use for the camera’s smart shade
control feature for live video.
[Off]: Display live video using smart shade control
value configured on the camera.
[Auto]: Set smart shade control to automatic.
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 Adjust the Focus and Speed

 Configure External Outputs

You can use the [Focus and Speed] tab in the [Advanced
Camera Settings] dialog box to adjust the focus and the
pan/tilt/zoom speeds.

Use the [External Outputs] tab on the [Advanced Camera
Settings] dialog box to configure output to external
devices connected to the camera.

(1) (2)
[Focus and Speed] tab

(1)
(2)
(3)
(4)
(5)

(1) [Auto], [Auto (for domes)]
Automatically focus the video.
Use [Auto (for domes)] for cameras equipped with an
indoor dome housing. The setting prevents the
camera from focusing onto the dome surface.
(2) [Fixed at infinity]
Fix the focal point at infinity.
(3) [Manual]
Adjust the focus manually by clicking the [Far] or
[Near] button.
Click [One Shot AF] to focus once on the current
subject and then return to manual focus.
(4) [Pan/Tilt]
Specify the pan/tilt speed ([Slow], [Normal] or [Fast]).
(5) [Zoom]
Specify the zoom speed ([Slow] or [Fast]).

When the digital zoom on the camera is set to [Disable],
the zoom speed is unavailable.
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(1) [Off]
Disable the external output.
(2) [On]
Enable the external output.

Configure the Video Window Layout
You can save the size and position of a video window in
the Viewer as a layout.
Configure a layout using the following procedure:

Create a Layout

4

Specify the layout name, layout background and the video
window display conditions and open it as a new layout.

1. Create a layout
Click [Layouts] > [New Layout] to display the [New
Layout] dialog box.

2

Configure each item.

2. Place a video window

Viewer Settings

1
3. Save the layout
The following special layouts are also provided:
• Dynamic layouts
Specify criteria, such as camera tags and events, to
only display video windows that meet the criteria. You
can also select a pre-defined dynamic layout.
• Layout Sequences
Sequence through multiple layouts you have created at
a certain time interval.

Note
When the Viewer starts, it displays the layout that was being
displayed when the program last ended. A new layout with the
name “Untitled” is opened the first time the Viewer is started. You
can save the layout with a name after you place a video window.

(1)
(2)

(3)

(4)
(1) [Layout Name]
Enter the name of the layout.
(2) [Background]
Specify the background of the layout. Click [Browse]
to specify an image (a .bmp file or JPEG file) to be
used for the background.
(3) [Playback Options]
Specify how the video windows are displayed when
the layout is opened.
• [View Live Video]
Display the live view from the camera.
• [Remember playhead positions]
Play back recordings starting from the positions that
were playing when the program last ended.
• [Start at specific time]
Play back a recording starting at a specific time.
• [Start at offset before live]
Start playback from a position a specific amount of
time in the past.
(4) [OK] and [Cancel]
Close the dialog box.
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3

• [None]
Do not display a grid. You can put the video window
where you like.

Click [OK] to close the dialog box.

[Background] and [Playback Options] are
unavailable.

• [Alignment]
Display a dotted grid. You can put the video window
adjusted to the position of the dots.

Important

• [160x120] / [320x240] / [640x480]
Display a solid grid with the specified size.

Following the above steps does not automatically save the
layout. Be sure to enter a name and save the new layout after
configuring it.

Place a Video Window
You can place a video window anywhere in the viewing
area.
You can arrange video windows according to a grid.

 Change the Layout Background Image
You can select an image for the layout background.

1

• [Custom]
Displays the [Custom Grid] dialog box.

Note
If the video receive size and video display size have a different
aspect ratio, black bands may be displayed along the left/right
edges or top/bottom edges of the video. To set a video window
with 16:9 aspect ratio, set a custom grid where [16:9] is specified
for [Aspect Ratio].

Configure a Custom Grid
Selecting [Custom] as a grid type displays the [Custom
Grid] dialog box, where you can configure the size of the
grid.

Click [Layouts] > [Organize Layouts] to display the
[Organize Layouts and Layout Sequences] dialog box.

(1)

2

Click the layout for which you want to specify a
background, and click [Properties] to display the
properties of the layout.

3

Click [Browse] for [Background].

4

Specify the image file to use as the background, and
click [Open].

(3)

Note
• The image that you specify as the background will be
registered to the [Background] list in the layout properties.
• To disable backgrounds, select [(None)] in the [Background]
list of the layout properties.

 Display a Grid
You can display a grid consisting of dots or solid lines in
the viewing area of the Viewer. The video window has a
neat and tidy appearance because it is displayed
according to the grid. When a solid grid is displayed, the
size of the video window can be adjusted to the grid.
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(2)

1

Click [Grids] on the toolbar.

2

Select the type of grid.

(1) [Aspect Ratio]
Specify the aspect ratio of the grid frame ([4:3] or
[16:9]).
(2) [Horizontal] and [Vertical]
Specify the number of horizontal and vertical pixels in
the grid frame.
Changing the value for one of the items changes the
value in the other box to maintain a constant aspect
ratio.
(3) [OK] and [Cancel]
Close the dialog box.

Note
Using a custom grid may increase the load on the CPU.

Configure the Video Window Layout

 Move a Video Window
You can drag a video window to any position.
When the grid is set to [None], the video window remains
in the position to which it is dragged.
For options other than [None], the video window snaps to
the grid position that is nearest to where the window is
dragged.

Configure a Dynamic Layout

1

Click [Layouts] > [New Dynamic Layout] to display the
[New Dynamic Layout] dialog box.

4
Viewer Settings

Important
The number of video windows that can be displayed in the
Viewer depends on factors such as the video card, CPU
performance, video frame rate, camera video size, and the
video quality.

2

Specify the criteria for the video windows displayed in
the dynamic layout.

Note
• When a setting other than [None] is selected for grid, the video
window is automatically adjusted to the grid. When a grid has
just been set it retains its original size, but when the video
window is dragged, window size is adjusted to the grid.
• You can enlarge the video window in multiples of the grid
frame size (2 x 2, 3 x 3, etc.).

(1)

(2)
(3)

Save the Layout
After configuring the display and position of the video
windows, follow these steps to save the layout.

1

Click [File] > [Save Layout].

2

Change the layout name as required, and click [OK].

(4)
(1) [Layout Name]
Enter the name of the dynamic layout.
(2) [Display cameras that]
Specify the display criteria for cameras.
Click a check box to make a set of display criteria
available, and then click each criteria list to select the
criteria.
You can specify up to five sets of criteria.
The criteria are (from left to right), the property,
operator, and status.

Property

Status
Operator

Property

Operator for the
decision

Status

Tags

is
isn’t

Camera tags

Status

is
isn’t

Camera status
(such as
[Recording],
[Idle], or [Error])

Event Type

is
isn’t

Event type (such
as [Motion] or
[Sensor])

Event Priority

is
is equal or higher than
is equal or lower than

Event priority
([Highest], [High],
[Medium], [Low],
or [Lowest])
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Property
Storage
Server Group

Operator for the
decision
is
isn’t

Status
The name of
Storage Server
Group to which
the Viewer is
connected.

Configure a Layout Sequence

1

Click [Layouts] > [New Layout Sequence] to display
the [New Layout Sequence] dialog box.

2

Specify the layouts to be displayed in the sequence.

Select [All of the following are met] to display only
cameras that meet all the criteria. Select [Any of the
following are met] to display cameras that meet any of
the criteria.
(3) [When conditions are not met, continue displaying
cameras for]
Specify how long a video window in the layout will
remain displayed when it does not match the criteria
specified here.
(4) [OK] and [Cancel]
Close the dialog box.

3

Click [OK] to close the dialog box.

4

Click [File] > [Save Layout].

5

Change the layout name as required and click [OK].

(1)
(2)

(3)

(8)

Note
The maximum number of dynamic layout video windows that can
be displayed is 25.

Switch Between Layouts

1

Click [Layouts] on the toolbar to display a menu for
selecting existing layouts.

2

Select a layout.

The menu is separated into two sub-menus:
• Shared layouts
Displays shared layouts under the name of the Storage
Server Group. The [Layouts] menu shows the Storage
Server Groups.
All users have access to the layouts, however, only the
administrator can make changes to them.
• User layouts
Displays layouts created by the currently logged in
user. These layouts are not available to other users.

(4) (5)(6)(7)
(1) [Sequence Name]
Enter the name of layout sequence.
(2) [Type]
Specify the type of layout sequence.
(3) [Available Layouts]
Displays a list of available layouts.

(4) [Add Layout]
Add the selected layout to the [Sequence Layouts]
list.
(5) [Move Up] and [Move Down]
Move the selected layout up or down in the list to
change the sequence order.
(6) [Remove Layout]
Remove a layout from the list.
(7) [Sequence Layouts]
Displays a list of layouts in the order of the layout
sequence.
(8) [Interval]
Specify the display time of each layout in the
sequence, from 5 to 9999 seconds.
(9) [OK] and [Cancel]
Close the dialog box.
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(9)

Configure the Video Window Layout

3

A new layout is displayed for the tab.

Click [OK] to close the dialog box.

 Resume Layout Sequence

2

4

Select a layout and open it in the tab (p. 74).

Viewer Settings

In the following situations, the layout sequence
automatically stops.
• When you click the layout area
• When you obtain camera control privileges
• When you click [Grids] on the toolbar and select a grid
type from the displayed menu
• When you open a menu on the menu bar
• When you switch to another tab or open a new tab
• When a layout property is canceled, e.g., because it
was deleted by a viewer on another computer
When stopped, “Paused” appears in the title bar as
shown below.

Organize Layouts
You can change the display order of menus, classify and
organize layouts in folders, and edit the layouts.

1

Click [Layouts] > [Organize Layouts] to display the
[Organize Layouts and Layout Sequences] dialog box.

(2)
(3)

To resume a stopped layout sequence, click [Layouts]
menu > [Resume Layout Sequence].
During full screen display, right-click anywhere in the
viewing area, outside the video windows, and click
[Resume Layout Sequence], or press Ctrl+R to resume
the sequence.

(4)
(5)
(6)
(7)
(8)
(9)

(1)

(1) Layout tree
Displays a list of created layouts.
The layout tree uses the following icons:
Icon

Description
Custom layout
Dynamic layout
Layout sequence

Open Multiple Layouts Using Tabs

Folder

(2) [New Folder]
Create a new folder.
You can open different layouts using tabs for quick
access.

1

Click [File] > [New Tab] to open a new tab.

(3) [Move to Folder]
Move the selected layout to a folder.
(4) [Move Up] and [Move Down]
Move the selected layout up or down in the list.
(5) [Delete]
Delete the selected layout from the list.
(6) [Rename]
Change the name of the selected layout.
(7) [Properties]
Displays the properties of the selected layout.
The properties displayed will differ according to the
type of layout, as described below.
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(Normal) Layout: Same as the properties displayed in
step 2 on p. 71. You can configure the
background and the video window display.
Dynamic Layout: Same as the properties displayed in
step 2 on p. 73. You can specify the conditions
for displaying cameras.
Layout Sequence: Same as the properties displayed
in step 2 on p. 74. You can specify the layouts
that will be automatically sequenced.
(8) [Copy to Folder]
Copy the selected layout to a folder.
(9) [Close]
Close the dialog box.

Important
• You cannot change the name of the [Shared Layouts] and
[User Layouts] folders.
• Only the administrator (or a user with the required
permissions) can manage shared folders (p. 57).

Note
The settings in the [Organize Layouts and Layout Sequences]
dialog box, such as the order of the layout sequence and the
folder types are also displayed when you click the [Layout] menu,
or when you click the [Layouts] button on the toolbar.
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Chapter

5

Setting a Recording
Schedule

❏ Setting weekly schedules
❏ Configuring recording modes: continuous recording, motion detection
recording, and sensor recording
❏ Setting special day schedules

Flow of Recording Schedule Settings
Display the [Recording Schedules] window (p. 79)

Set a Weekly schedule

Set a Special Day schedule

Select a camera (p. 79)

Name the schedule (p. 94)

Set a schedule (p. 80)

Specify the day (p. 95)

Select a camera (p. 95)

Configure the recording mode (p. 82)
Continuous recording (p. 82)

Intelligent function recording (p. 87)

Motion detection recording (p. 84)

Volume detection recording (p. 87)

Sensor recording (p. 83)

Configure the advanced recording settings (p. 88)
Camera angle (p. 88)

Focus (p. 93)

Recording before or after an event (p. 90)

External outputs (p. 93)

Video quality adjustment (p. 91)

Save the schedule (pp. 81, 95)

Edit, delete or copy from a schedule (p. 96)

The camera supports sensor recording and schedule recording to internal memory (picture recording function). If these
features are enabled, they take precedence over the Storage Server recording schedule. You must disable the feature on
the camera before using the recording schedule on the Storage Server.

If [Restrict Service Time] is enabled on the camera, recording will take place only during the service time, irrespective of the
recording schedule.

Important
Be sure to test recording schedules before using them.
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Record on a Regular Basis (Repeating Weekly Schedules)
You can configure a recording schedule for each day of
the week.

Important
The configuration items and values that are available will vary
depending on the camera and settings used for recording. For
details, refer to the camera manual.

Select a Camera

5

When you have a large number of cameras registered,
search for the camera using the camera name or any
associated tags.

1

Setting a Recording Schedule

Display the [Recording Schedules] window

(5) [Close]
Closes this window.

Click the search button and specify the search criteria.
Search button

1

Click [Window] > [Recording Schedules] to display the
[Recording Schedules] window.

Search criteria box

The [Repeating Weekly Schedules] tab is selected
whenever the [Recording Schedules] window is
displayed.

(1)

The following items are displayed when you click the
search button.
• [Name, Tag or Status]
Enter the camera name, any associated tags, or the
camera status in the search criteria box.

(2)

• [Camera Name]
Enter the camera name in the search criteria box.
• [Tag]
Select the camera tag to be searched.
• [Camera Status]
Select the status to be searched.

(3)

(4)

(5)

(1) [Add Schedule Item], [Edit], [Delete]
Add, edit or delete a schedule item.
(2) [Zoom] slider
Zoom in and zoom out the time line of the schedule
area.
(3) [Search for] box
Find the camera that will be assigned the recording
schedule.

• [Camera Type]
Select the model name to be searched.
• [Host Name]
Enter the camera host name or IP address in the
search criteria box.
• [Storage Server Group Name]
Searching by this item is not available.

2

Specify the search criteria and search for the camera.

(4) Schedule area
Displays the currently registered cameras and their
corresponding weekly schedules, arranged by day of
the week.

79

Set a Weekly Schedule

1

In the schedule area, click the camera that you want to
add the schedule to.

2

Click [Add Schedule Item] to display the [Edit Schedule
Item] dialog box.

Specify the Recording Period and Day of the
Week

1

Specify the recording period.
• To record for the entire day without specifying a
start and end time, click [All Day].
• To specify a recording period, enter the start time
in [Start Time] and the end time in [End Time]. Use
these items when you want to specify a recording
time that goes past midnight, such as when
recording late into the night. Alternatively, select a
duration for the recording (minimum of 15 min.) in
the [Duration] field.

(1)

2

Select the check boxes for the days of the week on
which to repeat the recording in [Repeat On].

Important
To use one Storage Server with more than 32 cameras
connected to it, set the start time of the recording schedule
leaving 15-minute intervals or longer so that the recording
schedules of 33 or more cameras do not start at the same time.

(2)

(3)

(4)

(1) Recording time settings area
Specify the day of the week and the start and end time
of the recording period.
(2) Recording mode list
Select the recording mode.
(3) Recording settings area
Configure the settings for the recording mode
selected in (2).
(4) [OK] and [Cancel]
Close the dialog box.
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Note
• You cannot specify overlapping recording schedules on the
same camera.
• The time of the recording schedules is based on the Storage
Server clock. We recommend that you synchronize the clocks
on all the Storage Server you are using.
• If you set the operating system to automatically handle daylight
saving time, the time will be automatically adjusted on the first
and last days of the daylight saving time period.

Record on a Regular Basis (Repeating Weekly Schedules)

Specify the Recording Mode

1

Select the check box next to the recording mode in the
list that best suits the type of recording you require.
For example, if you want continuously record for the
entire duration of the recording schedule, select the
check box next to [Continuous Recording].

2

Configure the recording mode settings in the recording
settings area.

• Continuous recording
Records continuously for the specified recording
period. For details, see “Continuous Recording
Settings” (p. 82).

• You can specify the priority of the events generated by sensor
recording, motion detection recording, intelligent function
recording and volume detection recording. For details, see
p. 83 and p. 84. When two events occur simultaneously, the
event with the higher priority takes precedence.
•

Only supports continuous recording mode.

Hint

Specify Advanced Settings

• Sensor recording
Starts recording when there is a signal from a sensor
connected to the camera. For details, see “Sensor
Recording Settings” (p. 83).

Advanced settings are available when the [Advanced]
button is displayed in the recording settings area. For
details, see “Configure the Advanced Recording Settings”
(p. 88).

• Motion detection recording
Starts recording when motion is detected. For details,
see “Motion Detection Recording Settings” (p. 84).

Save the Recording Schedule

• Intelligent function recording
Starts recording when motion that meets the intelligent
function detection criteria is detected. For details, see
“Intelligent Function Recording Settings” (p. 87).
• Volume detection recording
Starts recording when the volume detection criteria are
met. For details, see “Volume Detection Recording
Settings” (p. 87).

5

You can specify more than one recording mode at the same time.
For example, you can select motion detection recording and
specify a frame rate that is higher than continuous recording. This
way, a high frame rate is used only when motion is detected.

Setting a Recording Schedule

The settings are different for each recording mode.

Note

1

Click [OK] to close the dialog box.
The schedule that was set is displayed in the
schedule area. The schedule becomes active as soon
as it is displayed in the schedule area.

Use intelligent function recording instead of motion
detection recording.

Intelligent function recording is not supported. Use motion
detection recording.

Volume detection recording is not supported.

Intelligent function recording and motion detection
recording using the camera are not supported.
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Configure the Recording Mode

This can help reduce the effects of non-uniform
network traffic (jitter).

 Continuous Recording Settings

1

Click [Continuous Recording] in the recording mode
list and select the check box.

2

Configure the video recording settings.

Important
• The three video receive sizes in each set, for example
[480x270 (320x180 / 320x240)], in the [Video Receive Size]
submenu are sizes that correspond to the category [1080p
category (720p category / 4:3 category)], respectively.
Which of the three sizes that is used is determined by the
size set in [Video Size Set] for the camera.
•

(1)
(2)
(3)
(4)
(5)
(6)

The video size is set to “480x270” when [480x270 (320x180 /
320x240)] is selected in [Video Receive Size]. To set
“320x240,” select [4:3] in [Aspect Ratio] and select
[320x240] in [Video Receive Size].
• You can save JPEG images of the recorded stream to an SD
memory card in the camera using [Use the recording mode
stream] if the stream could not be distributed due to a
network failure. Images are saved at a frame rate of 1 fps. For
details, see the camera manual.
• The size of the recording data increases as the resolution
and frame rate become higher. Make sure there is sufficient
hard disk space available before specifying a higher
resolution and frame rate.

(7)
(1) [Aspect Ratio]
Specify the aspect ratio ([4:3] or [16:9 (4:3)]).
If you select [Not specified], the camera’s aspect ratio
setting is used for recording.
(2) [Resolution]
Specify the resolution when [Aspect Ratio] is set to
[4:3] or [16:9 (4:3)].
If you select [Not Specified] for the [Resolution], the
camera’s resolution setting is used for recording.
(3) [Video Format]
Specify the video format ([JPEG], [MPEG-4] or
[H.264]).
The available formats depend on the camera model.
(4) [Maximum Frame Rate]
Specify the maximum frame rate (number of frames
recorded in one second) in the range from 0.1 to 30
frames per second (fps).
(5) [Record audio if available]
Select this check box if you want to record audio
together with the video.
(6) [Advanced]
Displays the [Advanced Recording Settings] dialog
box. For details, see “Configure the Advanced
Recording Settings” (p. 88).
(7) [Use the recording-mode stream]
Enable the recording stream function. With this
function, the camera temporarily stores the video in its
own memory before sending it to the Storage Server.
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• If you select [MPEG-4] or [H.264], the [Storage Server] option
in [Detect Motion Using] cannot be selected.
• Even if the [Record audio if available] check box is selected,
audio will not be recorded if the audio sending function has
not been activated on the camera. If you schedule a
recording, make sure the audio sending function on the
camera has been set to [Enable].

Note
• If you select [MPEG-4] or [H.264] for the [Video Format]
setting, the [Aspect Ratio] and [Maximum Frame Rate] settings
cannot be changed. The settings on the camera are used for
recording.
Only supports [JPEG] for the [Video Format].
• It may not be possible to record at the specified frame rate or
recording may pause intermittently, depending on the load on
the Storage Server CPU or the hard disk.
• Recording may be performed at lower than the specified frame
rate, depending on the number of Viewers that are accessing
the camera, the load on the camera and Storage Server,
variation in network traffic, and the environment at the time of
recording.
•

The maximum frame rate is 5 fps.

• Audio recording is enabled when the recording mode is
selected. You cannot schedule audio-only recording.
• If [MPEG-4] or [H.264] recording format is used, the recorded
audio will not be in sync with the recorded video. If [JPEG]
recording format is used, the recorded audio will be in sync
with the recorded video for the most part, however it is not
guaranteed that it will be completely in sync.
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• Recording mode stream operates only with cameras that
support the recording mode stream function and if a stream
has been acquired.
• If an upload function is already being used on the camera, you
cannot use the recording-mode stream function. To use the
recording-mode stream function, select [Upload] > [Upload
Disabled] on the setting page of the camera.

 Sensor Recording Settings

1

Click [Sensor Recording] in the recording mode list
and select the check box.

2

Configure the video and event settings.

• To use recording mode stream, select [Video Format] >
[JPEG], and set [Maximum Frame Rate] to “10” or lower value.

5
(1)
(2)
(3)

Setting a Recording Schedule

• When the recording-mode stream function is used, the
streamed video has a higher priority than the live video.
Depending on the load on the camera, such as the number of
Viewers that are simultaneously connected to the camera,
display of the live video may stop.

(4)

(1) [Do not record]
Select to not record even when there is a signal from
this sensor.

Hint
You can individually enable or disable recording for each sensor.
For example, you may not want to record when there is door
sensor signal, but to start recording when there is a window
sensor signal.

(2) [Start Recording]
Start recording when there is a signal from the sensor.
After selecting the item, configure the recording
settings below the item.
(3) [Priority]
Select the event priority. For details, see “Check
Events” (p. 109).
(4) [Invert this event]
Start recording when the input from the sensor
disappears.
For example, start recording when there is no signal
from the sensor, and stop recording when a signal is
present.
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The other settings are the same as those for continuous
recording. For details, see “Continuous Recording
Settings” (p. 82).

Important
• When you select the [Sensor Recording] check box in the
recording mode list in step 1, [Do not record] is selected for
all of the sensors. You must select [Start Recording] for at
least one sensor to be able to start sensor recording.
• The sensor inputs can generate a large number of events for
the Storage Server, thereby increasing the load on the
server. For reference, if the Storage Server is continuously
receiving more than 10 events per minute, we recommend
that you use continuous recording mode.
• If the recording period for a schedule ends while sensor
recording is in progress, recording will stop.

 Motion Detection Recording Settings
Important
The motion detection feature is not suitable for applications
where high reliability is required. We recommend that you do
not use the motion detection feature in applications such as
surveillance, which require high reliability. Canon cannot take
responsibility for any accidents or damages associated with
using the motion detection feature.

Using the Camera for Motion Detection

1

Click [Motion Detection Recording] in the recording
mode list and select the check box.

2

Select [Camera] from [Detect Motion Using].

3

Configure the recorded video and event settings on
each area tab.

Note
• The number of tabs depends on the number of compatible
external devices (sensors) that are connected to the camera.
• The name of the external device that is registered in the
camera is displayed in the [Sensor Name] box.
• If a sensor recording is triggered with the same priority as one
that is currently recording, the second sensor will be given
priority and begin recording. The remainder of the first
recording sensor, if any, will continue recording after the
second sensor ends.

(1)
(2)
(3)

(1) [Do not record]
Select this item if you do not want recording to start
when motion is detected.

Hint
You can use this setting to individually enable or disable
recording for each area. For example, you may want to record
when motion is detected around a vault, but not record when
motion is detected around an entrance.

(2) [Start Recording]
Start recording when motion is detected.
(3) [Priority]
Select the event priority. For details, see “Check
Events” (p. 109).
The other settings are the same as those for continuous
recording. For details, see “Continuous Recording
Settings” (p. 82).
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[Recording Settings] tab
To use motion detection, you must create a schedule with
motion detection using the camera’s schedule setting
tool.

(1)

Note
• If the camera supports four motion detection areas, tabs
named [Area 1] through [Area 4] are displayed in the
recording settings area. You can specify settings individually
for each motion detection area.

5
Setting a Recording Schedule

• The [Area Name] box displays the name of the area that is
registered in the camera.
• To use a camera for motion detection, you must configure the
motion detection settings on the camera. For details, see the
camera manual.
• When using the camera for motion detection with more than
one motion detection area, you can specify the event priority
for each area.
• Motion detection is suspended when the camera is panning,
tilting or zooming, irrespective of the motion detection settings.
• If motion is detected in multiple motion detection areas that
have the same priority, recording will start with the area having
the lowest number.

Using the Storage Server for Motion Detection

(1) [Priority]
Select the priority of the motion detection events. For
details, see “Check Events” (p. 109).
The other settings are the same as those for continuous
recording. For details, see “Continuous Recording
Settings” (p. 82).

4

Configure the motion detection settings on the
[Settings] tab.

Important
The load on the Storage Server CPU increases when motion
detection is performed on the Storage Server. We strongly
recommend that you use the motion detection on the camera, if
it is available.

Note
If you select [MPEG-4] or [H.264] in [Video Format], the [Storage
Server] option in [Detect Motion Using] cannot be selected. Note
also that if you select [MPEG-4] or [H.264] in other recording
modes besides motion detection recording, the [Storage Server]
option still cannot be selected.

1

Click [Motion Detection Recording] in the recording
mode list and select the check box.

2

Select [Storage Server] in [Detect Motion Using].

3

Configure the recorded video and event settings on the
[Recording Settings] tab.

[Settings] tab

(1)
(2)
(3)
(4)
(5)
(6)

(7)

(1) [Analysis Frame Rate]
Specify the motion detection frame rate (frames per
second).
(2) [Settings Mode]
• [Simple]
[Sensitivity] and [Area Ratio] can only be set using
the sliders. [Duration] is fixed at 0.2 seconds.
• [Advanced]
Makes the [Sensitivity], [Area Ratio] and [Duration]
settings available so that values can be set.
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(3) [Sensitivity]
Specify the motion detection sensitivity within the
range of 1 to 256. Increase the number to increase the
sensitivity.
(4) [Area Ratio]
Specify the area of the preview video that the Storage
Server uses for motion detection. The range is 0 to
100%. The size marker inside the Detection Indicator
changes position depending on the value of this
setting.
(5) [Duration]
Specify the length of time the motion signal must be
present to decide that there is motion. The range is 0
to 5.0 seconds.
(6) [Active Region]
Displays a preview video from the camera used for
motion detection.
Displays a dotted-line frame representing the active
region on top of the preview video. Drag the frame
handles to make it larger or smaller.
(7) [Detection Indicator]
Size marker

Colored bar

The size marker changes position depending on the
value of the [Area Ratio] setting. Adjust the motion
detection settings while viewing the preview video
and the Detection Indicator.
The colored bar changes depending on the value of
the [Sensitivity] and the [Area Ratio] settings.
Color of the
Colored Bar
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Meaning

Green

The detected motion does not exceed the
values specified in [Sensitivity] and [Area
Ratio]. In this case, the colored bar
remains to the left of the size marker.

Red

The detected motion exceeds the values
specified in [Sensitivity] and [Area Ratio].
In this case, the colored bar remains to the
right of the size marker.

Important
• If the recording period for a schedule ends while motion
detection recording is in progress, recording will stop.
• The detection indicator is not affected by the [Duration]
setting. Be sure to take the detection time into account when
adjusting the motion detection settings.
• To perform motion detection on the Storage Server, you must
specify [JPEG] for the [Video Format]. Also, if you
simultaneously use more than one recording mode, all the
[Video Format] settings must be [JPEG]. An error message is
displayed if you try to use a format other than [JPEG] and
motion detection on the Storage Server at the same time.
• Make the [Priority] setting on the [Recording Settings] tab
lower than the priority of any of the other recording settings.
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 Intelligent Function Recording Settings

 Volume Detection Recording Settings

1

Click [Intelligent Function Recording] in the recording
mode list and select the check box.

1

Click [Volume Detection Recording] in the recording
mode list and select the check box.

2

Configure the recording and event settings on each
rule tab.

2

Configure the recording and event settings.

5

(1) [Do not record]
Do not record when the conditions for this rule are
met.
(2) [Start Recording]
Start recording when the conditions for this rule are
met. After selecting the item, configure the recording
settings below the item.
(3) [Priority]
Select the event priority. For details, see “Check
Events” (p. 109).
The other settings are the same as those for continuous
recording. For details, see “Continuous Recording
Settings” (p. 82).

Setting a Recording Schedule

(1)
(2)
(3)

(1)
(2)
(3)

(1) [Do not record]
Do not record when audio is detected.
(2) [Start Recording]
Start recording when audio is detected. After
selecting the item, configure the recording settings
below the item.
(3) [Priority]
Select the event priority. For details, see “Check
Events” (p. 109).
The other settings are the same as those for continuous
recording. For details, see “Continuous Recording
Settings” (p. 82).

Important
Important
If the recording period for a schedule ends while intelligent
function recording is in progress, recording will stop.

If the recording period for a schedule ends while volume
detection recording is in progress, recording will stop.

Hint
Note
• Tabs named [Rule 1] through [Rule 15] are displayed, as
shown. Each tab can be configured individually.

To use volume detection recording, you must first configure the
volume detection recording settings on the camera. For details,
see the camera manual.

• The name of the rule is displayed in [Rule Name].

Hint
To use intelligent function recording, you must configure the
intelligent function recording settings on the camera. For details,
see the camera manual.
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Configure the Advanced Recording Settings

 Specify the Camera Angle for Recording

Click [Advanced] in the recording mode settings area to
display the [Advanced Recording Settings] dialog box
and configure the operation when recording starts.

(1)
(2)
(3)

(1)

(4)

(2) (3) (4)

(1) [Not Specified]
Select this item when you do not want to specify the
camera angle.

(5)

(6)

(2) [Custom]
Specify the camera angle using the [Preview] window.

(1) [Camera Angle]
Specify the camera angle for recording.
(2) [Image Adjustment] tab
Adjust the video quality.
(3) [Focus] tab
Adjust the focus.
(4) [External Outputs] tab
Enable or disable output to external devices
registered on the camera.
(5) [Recording Options]
Specify the duration of recording before and after an
event.
(6) [OK] and [Cancel]
Close the dialog box.

Drag the slider to change the camera zoom and click
or drag inside the video to change the camera angle.
(3) [Presets]
Select the camera angle from the list of preset camera
angles registered in the camera.
(4) [Preset Tour]
Move the camera through a series of preset camera
angles while recording. Click [Settings] to display the
[Preset Tour Settings] dialog box, and then specify the
order of the presets.

[Presets] and [Preset Tour] are unavailable.

[Preset Tour] is unavailable.

If you use the digital zoom when setting the preset angle
with the camera, the viewing angle seen when the setting
is made and the viewing angle that will be recorded may
be different.

88

Record on a Regular Basis (Repeating Weekly Schedules)

If you initialize the head position (the camera points the
head forward, reinitializes, and then returns the head to
the former position) during recording, the video during the
movement of the head will also be recorded.

Configuring a Preset Tour
Select [Preset Tour] in the [Camera Angle] settings and
specify the order of the presets that are registered in the
camera.

1

Click [Settings] to display the [Preset Tour Settings]
dialog box.

When an external camera is connected and [Use External
Video Input] is enabled, the settings on this dialog box are
unavailable.

5

Note
Setting a Recording Schedule

• Clicking the [Settings] button alone does not perform a preset
tour. You must first configure the settings in the [Preset Tour
Settings] dialog box.
• You are not able to specify camera angle settings when
configuring the intelligent function, configuring motion
detection settings with [Detect Motion Using] > [Camera], or
when configuring multiple cameras. You are not able to specify
[Preset Tour] settings when configuring motion detection
settings with [Detect Motion Using] > [Storage Server].

2

Click [Add] to open the [Edit Preset Tour] dialog box.

3

Select a preset from the [Preset] list.

4

Configure the speed and pause settings using the
sliders ([Speed (PT)], [Speed (Z)], and [Pause (sec)]).

5

Click [OK].

6

Repeat steps 2 to 5 for additional presets.

• To be able to select [Presets] or [Preset Tour], you must first
register camera angle presets on the camera. For details, see
the camera manual.
• Changing the preset name on the camera after making
[Presets] or [Preset Tour] settings will be disabled those
settings. If you want to change the preset name, be sure to
repeat the [Presets] or [Preset Tour] settings after you change
the preset name.

Selecting [Return to default focus when the camera is
operated] enables you to restore the focus settings to
the default (“Auto”) during the preset tour.

7

Specify the order of the presets.
The tour starts with the first preset and proceeds
down the list. Change the order by selecting a preset,
and then clicking [Move Up] or [Move Down].
To remove a preset, select the preset and click
[Remove]. To edit a preset in the list, select the preset
and click [Edit].
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8

Click [OK] to close the dialog box.

Important
• Using preset tour with MPEG-4 or H.264 format will consume
a large amount of disk space.
• The preset tour settings can effect the durability of the
camera’s pan/tilt mechanism.

Note
The camera returns to the first preset position after reaching the
last preset position.

Hint
Click [Start Test] to run through the preset tour once to confirm
your settings.

About the Warning Message Displayed During the
Preset Tour
Depending on the preset tour settings, a warning
message about the camera’s pan/tilt mechanism may be
displayed when you click [OK] to close the [Preset Tour
Settings] dialog box. If this happens, consider changing
the settings according to the following guidelines.
A warning will appear when the pan/tilt mechanisms reach
their estimated lifetime of 100,000 round trips over the full
range of motion.

 Specify the Option for Recording Before and/or
After an Event
You can record a number of seconds before and/or after
an event, such as sensor input or intelligent function,
using the [Recording Options] setting.

(1)
(2)
(1) [sec. before event]
Number of seconds to record before an event (max.
30 seconds).
(2) [sec. after event]
Number of seconds to record after an event (max. 999
seconds).

Note
• [Recording Options] cannot be specified when setting
continuous recording.
• Even if [sec. before event] and [sec. after event] are both set to
0, recording will continue when events are continuously
generated.
• The higher the value for [sec. before event], the greater the
memory usage for the Storage Server. If the Storage Server
has insufficient memory, the server will run out of virtual
memory, which consumes hard disk space, significantly
reducing processing performance.
• If you specify a preset camera angle for sensor recording, the
camera angle will change to the preset angle when sensor
recording starts. Therefore, the camera angle of the recording
before the sensor recording event will be different from the one
after the event. If [Recording Options] is set to record a short
time after an event and the sensor input is very short, recording
may stop before the camera reaches the preset camera angle.
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 Adjust the Video Quality
[Image Adjustment] tab

The following exposure compensation setting is
displayed when [Auto], [Auto (Shutter Priority)] or
[Auto (Flickerless)] is selected.

(1)
(2)

5

(3)

Metering mode

Description

Center-weighted

Meters the entire video, focusing on the
center of the video. A correct exposure is
obtained for a subject near the center of the
video, even though the periphery may be
slightly darker or lighter. Use for subjects
that are in the center of the video.

Average

Meters an average of the entire scene.
A uniform exposure is obtained even when
the scene has significant differences in
brightness. Use for scenes where, for
example, cars are passing through or
people are entering and exiting.

Spot

Meters the center of the scene.
The correct exposure is obtained for a
subject near the center of the scene,
irrespective of the brightness of the
periphery. Use if the subject is lit by a
spotlight or is backlit, where the exposure
should be adjusted to the center of the
scene.

(1) [Exposure]
The settings change according to the selected
exposure setting.
• [Not Specified]
Use the camera’s exposure setting.
• [Auto]
Automatically control the exposure.
• [Auto (Flickerless)]
Reduce flicker from light sources, such as
fluorescent lighting. The shutter speed is
automatically adjusted according to the lighting
conditions.
• [Auto (Shutter Priority)]
Specify the shutter speed.

Setting a Recording Schedule

[Compensation]: Specify exposure compensation.
Select negative values to darken the video and
positive values to lighten the video. To disable
exposure compensation, specify [Not
Specified].
[Metering Mode]: Specify the metering mode setting:
[Center-weighted], [Average], or [Spot].

(4)

[Shutter]: Specify the shutter speed when [Exposure]
is set to [Auto (Shutter Priority)] or [Manual].
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• [Manual]
Compensate for the exposure manually. The
following exposure compensation settings are
displayed.

[Iris]: Specify the iris setting. Drag the slider to the left
to close down the iris and make the video
darker or to the right to open up the iris and
make the video brighter.
[Shutter]: Specify the shutter speed.
[Gain]: Specify the gain (sensitivity to brightness).
Drag the slider to the left to decrease the gain
and make the video darker or to the right to
increase the gain and make the video brighter.

Note

(4) [White Balance]
Specify the appropriate white balance by selecting
one of the camera’s light source settings displayed in
the list.
If [Manual] is selected, use one of the following two
methods to adjust the white balance.
• [R Gain] and [B Gain]
Specify the white balance parameters by dragging
the sliders. Drag to the right to increase the gain (the
sensitivity to brightness).
• [One Shot WB]
Force white balance adjustment to a light source.
Using a white object (such as piece of white paper)
as a standard, fill the shot with the object and click
this button.

It may take approximately 30 sec. for exposure, night
mode and white balance settings to be reflected in the
view after recording starts.

The [Auto (Flickerless 2)] setting is not supported.

(2) [Smart Shade Control]:
Specify a value to use for the camera’s smart shade
control feature when recording.
[Not Specified]: Record using smart shade control
value configured on the camera.
[Off]: Record with the smart shade control disabled.
[Auto]: Set smart shade control to automatic.
[1] to [7]: Select one of seven strength levels when
setting the smart shade control function
manually.
(3) [Aperture Mode]
Specify the camera aperture mode.
[Night Mode]
• [Not Specified]
Use the camera’s night mode function settings.
• [Disabled]
Disable the night mode function.
• [Enabled]
Record in night mode.
• [Auto]
The camera automatically decides when to switch to
night mode. When recording ends, the night mode
setting returns to the value before recording started.
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Important
If you select [Enabled] for Night Mode, you will not be able to
set the white balance. If you select [Auto] for Night Mode,
however, you will be able to set the white balance, but those
settings will be cleared when the camera switches to Night
Mode.

Note
When [Night Mode] is enabled in [Aperture Mode], both the
display and recorded video are in black and white.
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 Adjust the Focus

 Configure External Outputs

[Focus] tab

[External Outputs] tab

(1)
(2)

(1)
(2)
(3)
(4)

5
Setting a Recording Schedule

(1) [Not Specified]
Record using the existing focal position of the camera.

Enable or disable output to external devices registered on
the camera when the recording schedule starts.

(2) [Auto] and [Auto (for domes)]
Automatically focus the video.
Use [Auto (for domes)] for cameras equipped with an
indoor dome housing. The setting prevents the
camera from focusing onto the dome surface.

(1) [Not Specified]
Disable the external output.

(3) [Fixed at infinity]
Fix the focal point at infinity.
(4) [Manual]
Adjust the focus manually by clicking the [Far] or
[Near] button.
Click [One Shot AF] to focus once on the current
subject and then return to manual focus.

(2) [On]
Enable the external output.

Note
• You must first specify the external device settings on the
camera. For details, see the camera manual.
• The number of external outputs is different for different camera
models.
• The external outputs are enabled only during recording.

Hint
This feature can be used with sensor recording, motion detection
recording, intelligent function recording or volume detection
recording. For example, by connecting a buzzer to an external
output and enabling the output for motion detection recording,
the buzzer will sound when motion is detected.
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Record at Specific Times (Special Day Schedule Settings)
Use special day schedules to record on exceptional days,
such as public holidays.

Important
When you assign a special day schedule to a number of
cameras, the weekly schedules assigned to the remaining
cameras for the special day are disabled. To reapply the
weekly schedules for that day to the remaining cameras, import
the weekly schedule for the day of the special day schedule.
For details on importing a weekly schedule, see “Import from a
Weekly Schedule” (p. 96).

Display the [Special Day Schedules] Tab

1

Click [Window] > [Recording Schedules] to display the
[Recording Schedules] dialog box.

2

Click the [Special Day Schedules] tab.

(1)

(2)

(3)

(4) [Zoom] slider
Zoom in and zoom out the timeline of the schedule
area.
(5) Days area
Specify the day for the special day schedule selected
in (1).
(6) Camera search
Find the camera that will be assigned the schedule.
(7) Schedule area
Displays the currently registered cameras and their
corresponding recording schedules by day.
This area also has a search function for finding
cameras using search criteria, such as the camera
name or tags. For details, see “Select a Camera”
(p. 79).
(8) [Close]
Close this window.

Note
(4)

A special day schedule takes precedence over a weekly
schedule.

Create a Special Day Schedule
Special Day recording schedules are set by the day.

(5)

(6)

(7)

Click [Add] in the schedule type area.

2

Enter the name of a special day schedule and click
[OK].

(8)

(1) Special day schedule type
Add, edit or delete a special day schedule type.
(2) [Storage Server Group]
Display the Storage Server Group name.
(3) Special day schedule settings
• [Add], [Edit], and [Delete]
Add, edit or delete a special day schedule.
• [Use Repeating Weekly Schedule]/[Not Use
Repeating Weekly Schedules]
Enable or disable the special day schedule for the
applicable day of the weekly schedule registered on
the selected camera.
• [Copy from Repeating Weekly Schedule]
Specify a day of an existing weekly schedule
registered on the selected camera, and import it as
a special day schedule.
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1

The name is added to the schedule type area.

Note
Before deleting a schedule name from the schedule type area,
first delete the applicable day from the days area.

Record at Specific Times (Special Day Schedule Settings)

Specify the Day for the Special Day Schedule

Specify the Recording Settings

Click the schedule name you want to use in the
schedule type area.

1

Select the schedule name in the schedule type area.

2

Click [Add] in the days area.

2

Specify the day to assign to the special day schedule
in the days area.

3

Select the camera you want to use in the schedule
area and click [Add].

4

Specify the special day schedule.

5
Setting a Recording Schedule

1

The setting items are the same as those for the [Edit
Schedule Item] dialog box. For details, see “Set a
Weekly Schedule” (p. 80).

3

Specify the date for the special day schedule on the
calendar and click [OK].

Note
• Special day schedules can only be set for a one-day time
period (00:00 to 24:00). For example, for a three-day long
weekend (Saturday, Sunday and Monday) you will need to set
a separate schedule for each of the three days.
• You cannot apply different special day schedules to the same
day.

Select a Camera

 Specify Advanced Settings
Advanced settings can be configured when the
[Advanced] button is available in the recording settings
area. For details, see “Configure the Advanced Recording
Settings” (p. 88).

 Save the Recording Schedule

1

Click [OK] to close the dialog box.
The schedule is displayed in the schedule area. The
schedule becomes active as soon as it is displayed in
the schedule area.

For details, see “Select a Camera” (p. 79).
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Edit a Recording Schedule
Editing a Recording Schedule

1

Select the recording schedule you want to edit in the
schedule area, and click [Edit].

2

Change the settings of the recording schedule.
For details on the settings in the [Edit Schedule Item]
dialog box, see “Set a Weekly Schedule” (p. 80).

3

Click [OK] to close the dialog box.

Delete a Recording Schedule

Important
• If you use [Use Repeating Weekly Schedule] to import a
weekly schedule to a schedule that already has a special day
schedule, the imported schedule will overwrite the existing
schedule.
• You cannot edit a weekly schedule that was imported using
[Use Repeating Weekly Schedule] on the [Special Day
Schedules] tab. To modify an imported weekly schedule,
make a copy of it by referring to “Import by Specifying the
Day of the Week” (p. 96).

 Import by Specifying the Day of the Week

1

Select the schedule that you want to delete in the
schedule area.

You can copy from a weekly schedule by specifying the
day of the week to copy. Using this procedure, you are
able to edit the recording schedule after making the copy.

2

Click [Delete].

1

Select a camera in the schedule area.

2

Click [Copy from Repeating Weekly Schedule].

3

Select a day of the week and click [OK].

The recording schedule is deleted.

Import from a Weekly Schedule
You can create a special day schedule for any day of the
week by importing it from a weekly schedule.
You can also import a schedule whose day of the week is
the same as the desired day, or you can directly specify
the day of the week.

 Import from a Weekly Schedule with the Same
Day of the Week

1

Select a camera in the schedule area of the [Special
Day Schedules] tab.

2

Click [Use Repeating Weekly Schedule].
When you click the button, its name changes to [Not
Use Repeating Weekly Schedules] and any weekly
schedules registered on the camera become semitransparent. Click [Not Use Repeating Weekly
Schedules] to stop the weekly schedule.
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Hint
Importing by specifying the day of the week can be used to
import the schedule for any of the days of the week contained in
the weekly schedule. For example, you can import the schedule
of a day of the week that is different from the day of the week of
the target day.
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❏ Viewing live video
❏ Playing recordings
❏ Operating a camera
❏ Changing the layout of a video window
❏ Viewing and checking events

Flow of Operations

View recorded video
Record Now (p. 100)

Play a recording (p. 102)

Save a snapshot of the displayed video (p. 100)

Save part of a recording (p. 104)

Search for a recording (p. 101)

Zoom in/out of the Viewer display (p. 103)

View live video
Get control of a camera (p. 105)

Change the camera angle using a panorama image (p. 107)

Use the pan/tilt/zoom feature (p. 106)

Play back audio (p. 107)

Change the camera angle to a preset position (p. 106)

Compensate for dark regions in the video (p. 108)

Check events
View a live event (p. 109)
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Search for events (p. 110)

Viewer Features

(1)

(7)

(2)

6

(8)
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(9)

(10)
(3)

(4)
(5)
(6)
(1) Menu bar and toolbar
Access this software’s functions. The toolbar provides easy access to commonly used functions.
(2) Video window
Display live video from a camera or playback from a recording.
(3) [Panorama]
Change the camera angle using a panorama image.
(4) Viewing area
Place a video window in this area. You can display a grid for arranging video windows.
(5) Timeline
Display the time and date and events that have occurred. Click an event to play back the recording.
(6) Status bar
Displays Viewer status messages and CPU load.
(7) [Audio]
Listen to live audio and transmit audio using the camera’s two-way audio feature.
(8) [Camera Selector]
Display and select cameras added to the Storage Server Group.
(9) [Live Events Log]
Display events that occurred one hour or less after Viewer startup.
(10)[Camera Control]
Get control of the camera and change the camera angle.
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View Recorded Video
Record Now

Save a Snapshot of the Displayed Video

Start recording while watching the live video. The
recording format is JPEG.

You can take a snapshot of the displayed video and save
the still image.

1

Click the video window displaying the video to be
recorded.
A white frame surrounding the selected video window
is displayed.

2

1

Click [Capture] on the toolbar to display the [Capture
Still Frame] dialog box.

2

Set the still image to be saved.

Click [Record Now] on the toolbar.
Recording starts. The upper part of the window is red
when recording. Recording stops automatically after
the set time period.

The maximum frame rate is 5 fps.

(1)
(2)

Important
• [Record Now] records at the maximum frame rate. Be sure to
take into account how much hard disk space is used.
• The recording duration can be specified, however, the actual
duration may depend on various settings and on network
delay.

Note
• Audio is also recorded if audio is available from the camera.
• The [Record Now] duration can be changed. For details, see
“Configure the Viewer Display and Operation Settings” (p. 63).

Hint
You can use [Record Now] to immediately record during a period
where there is no recording schedule set.

(3)

(4)

(1) [Display camera name] check box
Select this check box if you want to add the camera
name to the still image.
(2) [Display timestamp] check box
Select this check box if you want to add the time and
date to the lower right side of the saved still image.
(You cannot specify the position, font, size or color.)
(3) [Save As]
Save the preview video.
(4) [Cancel]
Closes the dialog box.

3

Click [Save As].
The [Save As] dialog box appears.

4

Specify the file name and storage location and click
[Save].
The file is saved in the specified location and the
focus is placed on the [Capture Still Frame] dialog
box again.

5
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Click [Cancel] to close the dialog box.

View Recorded Video

Important

Button

• If the camera is disabled on the [Advanced] tab of the
camera properties, or even if the power of the camera is off, a
still image of the recorded video during playback can be
saved.

Description
Go back one week
Go back one day
Go back 10% of the current time display

• Do not specify the Windows folder or the Program Files folder
on the system drive as the destination. Video cannot be
saved to these folders.

Go forward 10% of the current time display
Go forward one day

Note

Go forward one week

3

6

Click an event in the event display area.
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• You cannot operate the preview when displaying the [Capture
Still Frame] dialog box. You must operate the camera in
advance to set its angle. For details on operating the camera,
see “Operate the Camera” (p. 105).

Events not associated with
the selected camera.

• The .bmp file format is used for still images.
• The camera clock is used for the date and time of the onscreen display function, but the clock on the PC running RM
Viewer is used for the date and time of snapshots.
• If the display position of snapshot text information is too low, it
may overlap the display of the on-screen display function. It is
recommended that snapshots be displayed in the top-left or
top-right corner.

Search for a Recording
Video recorded using a recording schedule or [Record
Now] is displayed on the timeline as events. You can
search through the recordings to find the recording that
you want to play back.

Recording
Events associated with
the selected camera

Events displayed as film icons are videos recorded for
that period. Click the event to play the recording.
Events associated with the selected camera are also
displayed in the event display area. (The color of these
events represents their priority.) Click the event to play the
recording.

Note
• Events in the display area that are not associated with the
selected camera (secondary events) are displayed as
transparent. If you do not select a camera, all events are
displayed as primary events (not transparent).

 Search by Changing the Timeline

1

Click the video window.

2

Drag the timeline to display the time and date for the
recording.

• Click [View] > [Timeline] to display/hide the timeline.

(1)

 Search by Specifying the Time and Date

1

Click a video window.

2

Click [Jump] on the timeline to display the [Jump to
Time] dialog box.

(2)

(3)
(1) Slider
Zoom out or zoom in the timeline.
(2) Event display area
Displays events according to the times they occurred.
(3) Time bar
Drag the bar to scroll through the timeline.
Change the recording period displayed in the timeline
using the buttons at each end.
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3

Specify the date and time and click [OK].

Video Window Display for Playback

(1)

The playhead moves to the specified date and time
and the recorded video starts playing in the video
window.

 Search by Event
Click [Search] on the toolbar or [Search] on the timeline
toolbar to search for an event. Click the event in the
search results to play the associated recording. For
details, see “Play Back an Event” (p. 110).

(2)
(1) Playback indicator
Displays the playback status.
(2) Title bar
Displays the camera name and the time and date of
the recording.

Play a Recording
Use the playback controls on the timeline to control the
video displayed in the video window.

Important
• You cannot use [Fast Reverse], [Previous Frame], and [Next
Frame] for recordings in MPEG-4 or H.264 format.

(1)

• Because video data is being sent from the Storage Server to
the Viewer during playback, playback response and
smoothness depends on factors such as the amount of
network traffic.

(2)

(3)

• The time displayed on the timeline corresponds to the clock
on the computer where the Viewer is running.

(1) Playback controls
Controls for video playback.
Button

Description
Jump to previous event
Fast reverse (each click changes the
speed in sequence: 1x, 2x, 5x, 10x)

• To play back a recorded video, set a time earlier than the
current time that will allow recording 10 frames*. If you try to
simultaneously record and play back video before 10 frames
have been recorded, playback may be momentarily
interrupted.
* At a recording frame rate of 0.1 fps, 10 frames takes
100 seconds.
At a recording frame rate of 1 fps, 10 frames takes
10 seconds.

Go to previous frame
/

Play/pause
Go to next frame
Fast forward (each click changes the
speed in sequence: 2x, 5x, 10x)
Jump to next event

(2) Event display area
Click to move the playhead to the playback position.
(3) Playhead
Drag the playhead to change the playback position.
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Note
• You can play recordings from more than one camera at the
same time.
• You can display recordings from one camera in multiple video
windows. You can also play video recorded at different times
simultaneously.
• Click [Live] on the timeline toolbar during playback to return to
the live video.

View Recorded Video

Zoom the Viewing Area In and Out

3

You can zoom the video window in and out in four levels.

1

Specify the region you want to zoom by clicking or
dragging in the Viewer PTZ panel.
A preview frame (yellow) appears around the
specified region, and the video within the frame is
zoomed in and displayed in the video window.
When the video is displayed zoomed in, a
zoom
icon appears in the bottom right corner of the video
window.

On the toolbar, click [+] next to [Zoom].
Each click zooms further in on the viewing area.

6

2
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4

If also using Viewer PTZ in other video windows,
repeat steps 2 and 3 for each window.

Click [-] to zoom out.
Each click zooms further out of the viewing area.

Important
The quality of the video in the video window decreases when
you zoom in. To increase the video quality, increase the
resolution (p. 67).

Note
• Select [Actual Size] from the [View] menu to return the view to
the actual size.
• You cannot zoom out further than the actual size.

Note
• Viewer PTZ uses the digital zoom function, hence the quality of
the video decreases as the zoom ratio increases.
• Saving a snapshot image of the recorded video saves a
snapshot of the whole video, not the zoomed in region.
• Viewer PTZ can be used in up to five video windows
simultaneously. Using Viewer PTZ in additional windows after
reaching this limit will cause Viewer PTZ to be released from
other windows in sequence from oldest to most recent,
according to the PTZ history.

 Change the Size of the Preview Frame
You can change the size of the preview frame by
dragging the preview frame lines.

Zoom a Region of the Video (Viewer PTZ)
You can zoom a region of the camera video in the video
window using Viewer PTZ (pan/tilt/zoom).
When the camera is fixed in position, you can use this
function to control PTZ in the viewer to zoom in on a region
of the video.
This function is available for live video and for recorded
video during playback.

 Start Viewer PTZ

1

Click [Viewer PTZ] on the toolbar or on the camera
control panel.
The Viewer PTZ panel appears.

2

Click the video window in which to use Viewer PTZ.

Note
The preview frame has the same aspect ratio as the selected
video window.

 Move the Preview Frame
You can move the preview frame to any position within the
video window.
Move by dragging
Click within the preview frame and then drag the frame,
placing it over the subject you want to display zoomed in.
Move by clicking
Click outside the preview frame, on the subject you wish
to display zoomed in, to move the center of the frame to
that position.

A white frame appears around the selected video
window.
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 Exit Viewer PTZ
Double-click anywhere within the Viewer PTZ panel.
The preview frame is cleared, and the display returns to
the original video.
To exit Viewer PTZ from all video windows at the same
time, right-click the Viewer PTZ panel and select [End
Viewer PTZ (all video windows)].

Important
• You can extract a video from only one video window at a
time.
• Do not specify the Windows folder or the Program Files folder
on the system drive as the destination. Video cannot be
saved to these folders.
• You cannot save only audio data.

Note
Even when the Viewer PTZ panel closes, Viewer PTZ operation
continues.

Save Part of a Recording
You can save a part of a recording with a length of up to
one hour to a file.

1

Select a recording on the timeline.

2

Click [Extract] on the timeline to display the [Extract
Video] dialog box.

3

Specify the time range for the video to be extracted.

• When extracting a time range that contains different video
formats (such as JPEG and H.264), divide the range by
format and save each video segment individually.
• When the data size of video being extracted reaches 2 GB,
extraction will stop and the video extracted to that point will
be saved, even if the specified end time has not been
reached.
Play back the .mov file to check if the specified length of
video was saved.
When data size is expected to exceed 2 GB, divide the
extraction time range. Refer to “Data Size and Bit Rate
Estimates” (p. 26), and calculate the estimated data size.
– Calculating time in minutes to 2 GB (JPEG)
2,097,152 KB/(data size per frame (KB) x recording frame
rate (fps) x 60 sec.)
– Calculating time in minutes to 2 GB (H.264/MPEG-4)
2,097,152 KB x 8/(bit rate (Mbps) x 1024 x 60 sec.)
Specify the video extraction time range so it is within the
calculated time estimation.
• Block noise may appear when a video recorded in H.264 and
saved in .mov format is paused during playback using
QuickTime.

(1)
(2)

• Initially, noise may be present when playing back extracted
video recordings that include audio.

(3)
(1) [From] and [To]
Specify the date and time of the start and end
positions.
(2) [Include audio if available] check box
Clear the check box if you do not want to include
audio in the file.
(3) [OK] and [Cancel]
Close the dialog box.

4

Click [OK].
The [Save As] dialog box appears.

5
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Specify the file name and storage location and click
[Save].

Note
Extracted video is saved in QuickTime movies (with the .mov file
extension) and can be played with QuickTime (or other players
that support the .mov file type). We recommend that you use
QuickTime Version 6.5.1 or later.

Operate the Camera
You can change the camera angle or adjust the video
quality for a camera in the video window.

Get Control of a Camera

1

• If you want to move the video window while you are in control
of the camera, drag the title bar.

Click [Window] > [Camera Control] to display the
[Camera Control] dialog box.

(1)

• If the camera is idle for one minute, camera control is released
automatically. A count down message is displayed 10 seconds
before the release. If you want to keep control of the camera,
operate the camera or click [Advanced] before the countdown
ends.

6

• You can also control the camera while recording. If the camera
angle to be used during recording has been set, the camera
returns to the set position when the Viewer releases camera
control.
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2

Click the video window.

Note

(6)

(2)
(3)
(4)
(5)

(7)

(1) Camera angle control buttons
Change the camera angle.
(2) [Select Preset]
Moves the camera to a preset position.
(3) [Panorama]
Displays the [Panorama] window. Move the camera to
a position using the panorama image.
(4) [Viewer PTZ]
Displays a region of the camera video, zoomed in to
fill the video window. For details, see “Zoom a Region
of the Video (Viewer PTZ)” (p. 103).
(5) [Control]/[Release]
Get or release control of the camera.
(6) Zoom slider
Drag to change the zoom position. Drag up to move
toward the telephoto position and down to move
toward the wide-angle position.
(7) [Advanced]
Configure the camera’s advanced settings.

3

Click [Control].
You now have control of the camera for a certain
period.
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Use the Pan/Tilt/Zoom Feature
Zoom is unavailable when the camera’s digital zoom is set
to [Disable].

 Use the Pan/Tilt/Zoom Feature in the [Camera
Control] Dialog Box

Pan/tilt/zoom is unavailable if a fixed camera or an
external camera, such as the VC-C50i, is used.

You can use the pan/tilt/zoom feature in the [Camera
Control] dialog box after getting control of the camera.

Change the Camera Angle to a Preset
Position
(2)

(1)

You can select a preset camera angle in the [Camera
Control] dialog box after getting control of a camera.

(1) Camera angle control buttons
Change the camera angle by clicking the buttons.
Click in the center to point the camera to the front.
(2) Zoom slider
Drag the slider to change the zoom position.
Drag the slider up to move toward the telephoto
position and down to move toward the wide-angle
position.

 Use Pan/Tilt/Zoom from the Video Window
You can also use the pan/tilt/zoom feature from the video
window.

(1)

(2)

(1) Display area
Drag on the area to change the camera angle. Click
on the area to move the camera angle to that point. If
the view does not center on the desired location the
first time, keep clicking the location until it centers.
(2) Zoom slider
Change the zoom position using the slider or [+]/[-].
Click [+] or drag the slider up to move toward the
telephoto position. Click [-] or drag the slider down to
move toward the wide-angle position.
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[Select Preset] is unavailable.

Note
You must first configure the presets on the camera before using
this feature. For details, see the camera manual.

Operate the Camera

Change the Camera Angle Using a
Panorama Image
Change the camera angle by specifying a position on a
panorama image.

1
2

Click [Panorama] in the [Camera Control] dialog box to
display the [Panorama] window.
Change the camera angle and zoom using the frame
displayed on the panorama image.

Play Back Audio
If the audio feature on the camera is used, you can play
audio using the audio panel or send audio using a
microphone.

Important
• You cannot send and receive audio from multiple Viewers
simultaneously.
• The sending and receiving of audio is set to 10 minutes by
default. The set time can be modified in [Viewer Settings]. For
details, see “Configure the Viewer Display and Operation
Settings” (p. 63).

The frame is yellow when you have control of the
camera. Drag the frame to change its size and zoom
the camera in/out.
Drag the center of the frame to move the frame and
change the camera angle.
If you draw a rectangle anywhere on the panorama
image, the frame is redrawn at that location and the
camera angle and zoom change correspondingly.
The frame is blue when you do not have control of the
camera.
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1

6

Click [Window] > [Audio Panel].

The [Audio] panel appears.

(1)
(2)

[Panorama] is unavailable.

Note

(3)
Options view

You must first register a panorama image on the camera before
using this feature. For details, see the camera manual.

(4)
(5)
(6)
(7)
(1) [Listen to Audio]
Starts audio playback.
(2) [Use Microphone]
Starts audio transmission.
(3) Show options button
Displays the options for the [Audio] panel.
(4) [Play audio also while using microphone]
Select if you want to play audio even when using a
microphone.
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(5) [Use silence detection to reduce network traffic]
Select if you want to detect silent segments when
sending audio. Decreases the amount of data
transmitted during silent segments to decrease the
load on network bandwidth.

Compensate for Dark Regions in the Video
Use the viewer shade control to compensate for any dark
regions in the video.

1

Click the video window menu button to display the
menu.

(7) Hide options button
Hides the options of the [Audio] panel.

2

Click [Viewer Shade Control] and select the amount of
shade from the submenu.

 Silence Detection Settings

• [Off]
Disable the shade control.

Select the [Use silence detection to reduce network
traffic] check box on the [Audio] panel to set the silence
detection sensitivity.
Click [Settings] to display the [Silence Detection Settings]
dialog box and adjust the silence detection sensitivity.

• [Low]/[Medium]/[High]/[Very High]
Enable the shade control. View the video window and
select a compensation value that gives the appropriate
brightness.

(6) [Settings]
Displays the [Silence Detection Settings] dialog box.

Note
• You cannot apply this feature to more than one video window.

(1)
(2)
(3)
(1) [Use the default sensitivity settings]
Uses the default sensitivity for silence detection.
(2) [Set the sensitivity manually]
Drag the slider to set the detection sensitivity.
(3) [OK] and [Cancel]
Close the dialog box.
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• The viewer shade control is a feature of the Viewer, not the
camera. Therefore, it can be used for both live and recorded
video playback.

Check Events
View a Live Event

Note

You can display past events in the [Live Events Log]
window.

• You can change the event priority.
• Motion detection recording, sensor detection recording,
intelligent function recording, and volume detection recording
priorities can be specified when setting the recording mode of
a recording schedule. (pp. 83, 84)

6

• Other event priorities can be specified when setting the
Storage Server Group. (p. 48)
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 Acknowledging an Event
By default, when a [Highest] priority event is displayed in
the [Live Events Log] window, an icon is displayed
indicating that you should acknowledge the event.
When the Viewer starts, you can open the [Live Events
Log] window to show all events that occurred within the
last hour. The top row in the list shows item names. You
can sort events in the list by clicking
in a column to
specify the item to sort by and the sorting order.

Important
A maximum of 200 events can be displayed in the [Live Events
Log] window.

Note
• Click [Window] > [Live Events Log] to display the [Live Events
Log] window
• You can change the display priority for the [Live Events Log]
window. For details, see “Configure Event Notification and
Priorities” (p. 64).

 Event Icon Colors

The event will blink until you acknowledge it. Follow these
steps to acknowledge the event.

1

Click the event to be acknowledged in the [Live Events
Log] window.

2

Click [Edit] > [Acknowledge Event].

Important

Different colored icons are displayed for events,
depending on the priority.
Icon color

Priority

Red

Highest

Orange

High

Yellow

Medium

Light Green

Low

Green

Lowest

If [Show Video Window on Event] is enabled in [Viewer
Settings], the corresponding video window is brought to the
front automatically. The size of the video window is always
[320x240] pixels.

Note
You can disable event acknowledgement in [Viewer Settings].
You can also change the priority of events that need to be
acknowledged. For details, see “Configure Event Notification and
Priorities” (p. 64).
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Search for Events

 Advanced Search

You can search past events and play back the event.

Click [Advanced Search] in the [Event Search] dialog box
to specify detailed search criteria.

1

Click [Search] on the toolbar to display the [Event
Search] dialog box.

(1)

(2)
(3)

2

Specify the search criteria.

(4)

(1)
(3)

(2)
(4)
(1) [When]
Select [Specify Date Range] to specify the search
period.

(5)

(6)

(7)

(1) [Description]
Enter the search criteria (event, camera, priority,
camera tag, or host name).
(2) [When]
Specify the period in which the target event occurred
([Today], [Last 2 Days], [This Week], [This Month],
[This Year], and [All Dates]).
(3) [Search] and [Stop]
Start searching or stop a search in progress using
these buttons.
(4) [Advanced Search]
Click to specify detailed search criteria.
(5) [Search Results]
Displays the search results.
(6) [Play Back Video]
Plays back the recording associated with the search
results.
(7) [Close]
Close this panel.

3

(5)

Click [Search] to start searching.

(2) [From] and [To]
Select [Specify Date Range] in [When] to specify the
start and end times and dates for the search period.
(3) [Event]
Select the type of events to be searched.
(4) [Status]
Specify the status of the events ([All Statuses], [On],
[Off]).
(5) [Priority]
Specify the priority of the events to be searched.

 Play Back an Event
If a recording is associated with an event in the search
results, right-click the event and click [Play Back Video] to
play back the recording in the video window of the
corresponding camera.
If the video window is not displayed, clicking [Play Back
Video] will automatically display the window and start
playback.

Important
When a dynamic layout is displayed, the video window is not
automatically displayed.

Note
To display the [Event Search] dialog box when the toolbar is
hidden, click [Search] on the timeline or click [Edit] > [Event
Search].
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Note
Click [Live] in the timeline toolbar after playing in the video
window to display the live view.
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Operation and
Management

❏ Error and warning level events
❏ How to check the status of the Storage Server
❏ Disk space management

Storage Server Health Check
Events Indicating Errors or Warning Levels and Corresponding Actions
You can check events to determine if errors related to the Storage Server status have occurred.
When an event indicating an error or a warning level occurs, it is immediately displayed in the event panel or timeline. Take
the appropriate action for the event.
Event Type

Message

Corresponding Action

Low disk space
notification*1

Warning: Low disk space

Occurs when the free disk space
becomes less than the specified
value, or the disk usage becomes
greater than the specified value. Data
may be deleted before the specified
number of storage days has elapsed.

Starts/stops file deletion
due to low disk space *1

Warning: Files deleted due to
low disk space

Occurs when the free disk space
becomes less than the threshold, or
the disk usage becomes greater than
the threshold.

Pauses/resumes recording
due to low disk space *1

Recording Suspended
(Low Disk Space (<drive
name>)

Occurs when the free disk space
becomes less than the limit level, or
the disk usage becomes greater than
the limit level.

Error connecting to the
camera

Error: Cannot Connect to
Camera

Occurs on an error when connecting
to the camera.

Check the network status.

Error connecting to the
Storage Server

Error: Cannot Connect to the
Storage Server

Occurs on an error when connecting
to the Storage Server registered with
the Storage Server Group.

Check the network status.

Error connecting to the
Storage Server Group

Error: Cannot Connect to the
Storage Server Group

Occurs on an error when connecting
to the Storage Server Group.

Check the network status.

Change in the recording
frame rate

Recording Frame Rate reduced
at high load issues

Indicates that the recording frame
rate has been changed due to
increased server load.

Check the recording mode
settings (p. 82).

*1 See “Disk Space Management (Important)” (p. 114).
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Event Explanation

Check the recording mode
settings (p. 82)

Storage Server Health Check

Status Bar
The status bar displays the Viewer processing status and
load. You can check CPU usage to determine the load on
your computer.
If the status bar is not displayed, you can display it by
clicking [View] > [Status Bar].

[Storage Servers] tab
This tab displays information (Storage Server Group
name, status, CPU usage, recording bit rate, and
playback bit rate) on the registered Storage Server.

7

System Information

Operation and Management

To get the detailed video processing status of the Storage
Server, click [Window] > [System Information] to display
the [System Information] dialog box. If system operation is
unstable or you are not able to record in the way you
intended to, refer to Chapter 1 and reconsider the system
configuration.
The [System Information] dialog box shows the status on
three different tabs.

[Users] tab
This tab displays the users logged into the Viewer and
related information (user group, host name (Viewer),
Viewer version, host name (Storage Server), Storage
Server Group Status).

[Cameras] tab
This tab displays recording settings and processing
information (camera tag, status, specified frame rate,
actual frame rate, receiving bit rate, and recording bit
rate) on the registered cameras.
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Disk Space Management (Important)
The Storage Server monitors the disk space and responds
according to the amount of available space.
Disk Space Status

Explanation

Low remaining disk space
notification level

You can specify a reference
value using [Low Disk Space
Warning Level] on the
[Recording Settings] tab in
the [Storage Server Group
Settings] dialog box.

Threshold level

The Storage Server calculates
a reference value based on
various conditions and
settings.

Limit level

 Action When the Low Remaining Disk Space
Notification Level is Reached
The Storage Server issues an event when the disk space
available for recording (i.e. available space relative to the
maximum disk space used) goes below a certain level.
If [Maximum Disk Space Used] is not set, the drive
capacity of the disk that stores the recording file is
considered to be the maximum disk space.
<Drive Letter>
drive has low free disk
space: Notification

Value for
[Maximum Disk
Space Used]

Notification
Notification
level

Low Remaining Disk Space Notification Level
Conditions and Calculation Method
If one of the following conditions is met, a low remaining
disk space notification level is indicated.
Condition 1: If the Storage Server disk space usage
exceeds the following values:
M x (100 - A)/100
(M: Value specified in [Maximum Disk Space
Used], A: Value specified in [Low Disk Space
Warning Level])
For example, if the value for [Maximum Disk Space
Used] is 100 GB and the value for [Low Disk
Space Warning Level] is 10%, the Storage Server
reaches the low remaining disk space notification
level when the Storage Server disk space usage
becomes 90 GB or more.
Condition 2: If the free disk space falls below the
following values:
Disk space x A/100
(A: Value specified in [Low Disk Space Warning
Level])
For example, if the disk space is 80 GB and the
value for [Low Disk Space Warning Level] is 10%,
the Storage Server reaches the low remaining disk
space notification level when the remaining free
disk space becomes 8 GB or less.

Note
If other applications use the same hard disk, you need to
consider condition 2. Even if the Storage Server uses a small
amount of disk space, it may reach the low remaining disk space
notification level according to condition 2 because other
applications have consumed a portion of the disk space.

Calculation Example
Disk Drive

Important
An event e-mail notification is sent when the priority level of
[Low Disk Space Warning] in the [Events] tab of the [Storage
Server Group Settings] dialog box meets or exceeds the level
specified in the e-mail notification settings. (p. 48).

Note
On receiving an event e-mail notification, an administrator can
act promptly (for example, by removing unnecessary recording
schedules) before a problem occurs due to low disk space.
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D Drive

E Drive

Disk Space

100 GB

200 GB

Free Disk Space

50 GB

200 GB

Value for
[Maximum Disk
Space Used]

40 GB

200 GB

Value for Low
Remaining Disk
Space Notification
Level

Condition 1:
40 GB x (100-10)/
100 = 36 GB
Condition 2:
100 GB x 10/100 =
10 GB

Condition 1:
200 GB x (100-10)/
100 = 180 GB
Condition 2:
200 GB x 10/100 =
20 GB

Disk Space Management (Important)

 Action When the Threshold Level is Reached

 Action When the Limit Level is Reached

Recording continues, however, the Storage Server starts
deleting recording files, beginning with old files, and
issues an event.

The Storage Server stops recording and issues an event
when the free disk space drops to this level.
The Storage Server resumes recording and issues an
event when the free disk space increases above this level
after deleting recording files.

Deleting files on <Drive
Letter> drive due to low
free disk space: Started
Deleting files on <Drive
Letter> drive due to low
free disk space: Started
Delete
oldest first

Notification
Recording
stopped
notification

Threshold
level

• Recording files are deleted, even if they have not reached the
[Maximum Storage Period]. However, if the oldest file is
currently in use by the Viewer (for example, for playback of
recorded video), it will not be deleted and the next oldest file
will be deleted instead. Deletion continues sequentially until
the free disk space meets or exceeds the threshold again. For
details on saving files, see Chapter 8.
• Normally, a recording file for which the minimum storage
period has not elapsed is excluded from deletion. Note that
such files are also deleted if the free disk space cannot meet
and exceed the threshold value by deleting all the other files.

Threshold Level Conditions and Calculation Method
The threshold level is considered reached when the
amount of free disk space drops below the following level.
(Number of cameras + 1) x 64 MB

Notification

7

Limit level

Operation and Management

Note

Delete
oldest first

Limit Level Conditions and Calculation Method
The limit level is considered reached when the amount of
free disk space drops below 64 MB. This value is fixed.

Important
• The threshold level is to protect against reaching the limit
level. We recommend that you take appropriate measures,
such as deleting unnecessary recording data, when the
event for the low remaining disk space notification level
occurs.
• Storing recordings that cause the threshold level to be
exceeded increases the load on the Storage Server and may
cause recording to be interrupted, resulting in incomplete
recordings. We strongly recommend that you operate the
Storage Server at below the threshold level.
• If e-mail notification is specified, an e-mail message is sent
for the event that occurs at each level (p. 48).
• Note that the threshold level conditions may be met before
the low remaining disk space notification level conditions are
satisfied, depending on the circumstances. For example, a
large number of cameras with limited disk capacity may
cause a value for (Numbers of cameras +1) x 64 MB to be
larger than the value of disk capacity x low free disk space
notification setting/100.
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Backup

❏ Types of backup target files and their destinations
❏ Restoring a recording file

Backing up data
Destinations of the Backup Files
The data that is saved during a backup consists of
recording data, event data, and configuration files. The
data is backed up from the Storage Server and saved to
the folders described below, on the drives that are
specified in the drive settings (p. 52).

 Event Data
<Destination drive>:\Canon-NVR\eventfiles
The following event data file is backed up:
NVR3_EVENT_ xxxxxxxx _ yyyymmdd _hhmmss .evt
Camera ID Year, month
Time
and day when
recording
started

 Recording Data
<Destination drive>:\Canon-NVR\videofiles
The following recording data file is backed up:
NVR3_MEDIA_ xxxxxxxx _ yyyymmdd _ hhmmss .edt
Camera ID Year, month
Time
and day when
recording
started
Video being recorded is saved to a temporary file on the
hard disk. By default, a recording file is created and
saved on the destination drive when the temporary file
size reaches 1 GB or when 24 hours have elapsed since
the start of recording. This size can be changed using the
[Maximum File Size/Duration] option on the [Recording
Settings] tab in the [Storage Server Group Settings] dialog
box (p. 47).

Note
• Greenwich Mean Time is used for the time added to the file
name of the recording data.
• This software uses lossy compression for the recording data.
You do not need to compress the recording files further using a
tape drive or other devices.

Temporary Files
The following is a temporary file, before it is made into a
recording data file by the system. This file cannot be
backed up using the standard backup method.
NVR3_UNINDEXED_MEDIA_xxxxxxxx_ yyyymmdd _hhmmss.edt
Camera ID Year, month and
Time
day when
recording started
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Note
Greenwich Mean Time is used for the time added to the file name
of the recording data.

 Configuration Files
The settings for the Storage Server and the Viewer are
saved in the following folders on the computer where the
program is installed. You must back up all of these folders
to completely back up the configuration files.
Configuration file path
<System drive>:\ProgramData\Canon\WebView\NVR30\
<System drive>:\Users\<user name>\AppData\Local\
Canon\WebView\NVR30\

Note
• The configuration file names are not displayed unless [Show
hidden files and folders] is selected in the [View] tab of
Windows Explorer [Folder Options].
• You cannot use the shadow backup feature.

Notes on Backup
• You do not need to stop recording to back up recorded data
that is complete. However, the frame rate may change
because of increased disk I/O load and/or CPU load.
• If you want to restore a backed-up recording file, the computer
you restore the backup to must have the same IP address and
drive configuration as the original Storage Server. For
example, if the original Storage Server includes a system drive
and a recorded data drive, the Storage Server you restore the
backup to must also have a system drive and a recorded data
drive. Determine the hard disk capacity based on the volume
of data to be restored.

How to Restore a Backup
Restoring from Backup Data

 Stopping the Storage Server

Use the following procedure to restore a Storage Server
from backup data:

The Storage Server runs in the background as a Windows
service. When you restore backup data, you must follow
the following steps to temporarily stop the Storage Server.

1

Prepare a new Storage Server for the restore.

2

Install this software.

3

Stop the Storage Server.
See “Stopping the Storage Server”(p. 119) for details
on how to stop the Storage Server.

The following folder is used by default:
Configuration file path
<System drive>:\ProgramData\Canon\WebView\
NVR30\
<System drive>:\Users\<user name>\AppData\Local\
Canon\WebView\NVR30\

5

Restore the recording files to their original location.
The following folder is used by default:
<Destination drive>:\Canon-NVR\videofiles\

6

Restore the event files to their original location.
The following folder is used by default:
<Destination drive>:\Canon-NVR\eventfiles\

7

Start the Storage Server.

8

Make sure that recording is performed correctly. Also
make sure that the restored recording data plays back
correctly.

Click [Start] > [Control Panel].

2

Click [System and Security].

3

Click [Administrative Tools].

4

Double-click [Services].

5

Double-click [RM Storage Server] to display [RM
Storage Server Properties].

8
Backup

4

Restore the configuration file for this software to its
original location.

1

Double-click [RM-Lite Storage Server].

6

Click [Stop].

7

Click [OK] to close the properties.

Note
To restart the Storage Server, follow the same steps and click
[Start] in step 6.

Important
If the [Ensure video is kept for upto] option is set on the
[Servers] tab in the [Settings] dialog box, any restored
recording data that exceeds the specified storage period will
be deleted when the Storage Server starts.
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Troubleshooting

❏ Actions required when recording errors occur
❏ Solutions when Viewer problems occur
❏ Error messages

Actions Required When Recording Errors Occur
When a recording error occurs (e.g., data is missing) during playback, you can troubleshoot the cause by checking the
information in the event log and the Storage Server log file.
Log
Event

Cause

Action

Storage Server

Error: Cannot Connect to
Camera

CameraServer <host name>
disconnected(<error
information>)

A network error may have
occurred. Look for the cause of
the error by checking the
Winsock error code recorded in
the Storage Server log (p. 130).

Check the network (hub, cables,
etc.) for any problems and make
sure that the camera is
operating normally.

Recording Frame Rate reduced
due to high load issues

—

• The effective recording rate is
excessively low (50% or
lower).
• Sensor and motion detection
events may have been issued
too frequently.
• The load on the Storage
Server CPU may be high.

• Modify the recording
schedule and the motion
detection sensitivity.
• Check the current CPU usage
and terminate any
applications that are a heavy
load on the CPU.

Recording Suspended
(Low Disk Space (<drive
name>))

—

The load from writing recorded
data to the hard disk may be too
high.

Shorten the maximum storage
period or consider adding a
hard disk. Additionally, try to
modify the recording schedule.

Solutions When Viewer Problems Occur
If you encounter problems when you use the Viewer, refer to the following solutions:

Viewer and Video windows
Problem
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Solution

I cannot use the pan, tilt or zoom feature of the
camera in the video window.

• Double-click the video window or click [Control] on the [Camera Control] panel
(p. 105).
• If video is being played (the title bar of the video window is gray), you cannot
operate the camera. Click [Live] on the timeline and get control of the camera.

When I click a video window to display the
[Video Window] menu, [Record Now] is gray
(unavailable). But, I can use the feature in
another video window.

Display [<camera name> Properties] for the video window and check on the
[Advanced] tab whether the camera is disabled. If the camera is disabled, click
[Enable Camera]. (p. 55).

When I try to use layouts created by other users,
the [Layout] menu is not displayed. I cannot
select a layout.

Layouts saved in the [User Layouts] folder cannot be seen by other users.
To allow all users to access layouts created by a user, the layouts must be created by
a user with administrator permissions and must be saved in the [Shared Layouts]
folder (p. 71).

The quality of video (live and recorded) in the
video window is low.

Change the receive size and display size settings. Depending on the receive size
and display size, the video quality may decrease. For example, if video with a low
receive size is displayed on a large video window, the video quality will decrease.
You can adjust the quality for recorded video with the advanced recording settings.

None of the cameras will record.

•
•
•
•

Is the network cable for the server properly connected?
Has there been a power failure?
Is “Do not Record” specified for a special day schedule?
If link lamps on the hub (switching hub) and on the network connector on the
server do not light, there may be a defect in the server’s cable, hub (switch), or
network connector.

Solutions When Viewer Problems Occur

Problem

Solution
•
•
•
•
•

Is the power and the network connection for the cameras working?
Do the cameras reply to a ping?
Can you view live video on the camera’s Viewer on the Storage Server computer?
Is “Do not Record” specified for a special day schedule?
Is sensor recording or motion detection recording set?

I cannot connect to the Storage Server from the
Viewer.

•
•
•
•
•

Are the login user name and password correct?
Is the network connection between the server and the Viewer working?
Is the IP address of the destination server correct?
Does the server reply to a ping from the Viewer computer?
Is TCP port 80 being used by another application?

I cannot view live video.

• If “Could not connect to camera” is displayed in the video window, check the
camera’s power supply and network connection.
• If a message is displayed in the timeline of the Viewer indicating that an error
occurred when connecting to the camera, check the camera’s power supply and
network connection.
• If the screen goes blank when the layout is switched, but a video is displayed after
a few seconds, the number of cameras or the live frame rate setting exceeds the
performance capabilities of your computer. Reduce the number of cameras, or
decrease the frame rate.
• In the H.264 or MPEG-4 video format, this may happen because there is not
enough memory. Reduce the number of open video windows or change the video
format to JPEG.

The Storage Server slows down or it takes longer
to perform various configuration changes, such
as registering cameras or recording schedules
from the Viewer (for Windows Vista).

• Make sure that less than 10 cameras are registered on each Storage Server.
• If the Storage Server is running Windows Vista, use Windows Server 2008 instead.

Live video is no longer displayed from any
camera (for Windows Vista).

• Make sure that less than 10 cameras are connected to one Viewer.
• If you are using the layout sequence feature, set the interval to 20 seconds or
longer.
• If the Storage Server is running on Windows Vista, switch to Windows Server 2008.

When the layout sequence feature is used, the
video windows suddenly go blank and the video
from the cameras can no longer be displayed.

When you use the layout sequence feature to switch quickly to a layout where there
are a large number of video windows, the communication resources of the system
may become insufficient. Reduce the number of cameras in a layout, or make the
display interval for the layout sequence longer.

The Viewer slows down.

• The performance of the Viewer depends largely on the specification of your CPU
and graphics card. When the Viewer seems to slow down, try to reduce the
number of cameras in the Viewer or decrease the frame rate.
• If the video size or quality setting for the cameras is high, the large amount of video
data may cause processing to take longer. Try adjusting the video quality and
video size settings on the camera.

9
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Some cameras do not record.
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Timeline
Problem
Nothing happens when I click any of the
playback controls.

Solution
• Move the playhead off of the [Live] position.
• You must select a video window before you can play back video. In addition, the
previous frame and next frame buttons (p. 102) and the [Extract] button (p. 104)
are enabled only when one video window is selected.

[Extract Video]
Problem
I tried to save a recording, but an error message
is displayed telling me that no video can be
found in the selected timeline segment.

Solution
Make sure that a recorded video is included in the selected portion of the timeline
(p. 101).

Recording
Problem

Solution

The [Record Now] feature cannot be used.

Make sure that the camera is not disabled on the [Advanced] tab in [<camera name>
Properties]. If the camera is disabled, click [Enable Camera] (p. 55).

The amount of Storage Server disk space usage
is much higher than the calculated level (pp. 25,
114) and free disk space is low.

When the video size or quality setting of the camera is high, the amount of data per
frame is large. In addition, if you are using anti-virus software, the software records
communication between the Storage Servers and the cameras and the size of that log
may reach several gigabytes. Change the anti-virus software settings to exclude the
Storage Servers from the target list.

Connection Problems
Problem
The screen goes blank and the “Cannot connect
to camera” message is displayed.
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Solution
A network error occurred, the camera was disconnected from the network, or the
camera power was turned off.

Error Messages
Messages Displayed in the Viewer
 Error Messages in the Video Window
Message
Video window

Cause
The Viewer is in the process of connecting to the
camera.

Cannot connect to camera.

The Viewer cannot connect to the camera and live
video cannot be displayed.

Getting camera control.

Displayed after the user tries to get camera control.

Cannot get camera control.

Another user with higher priority is already
controlling the camera when you try to get camera
control.

Control will be lost in <count down> seconds.

Displayed if the camera is idle for one minute;
starts a countdown. The countdown starts at 10
and counts down one second at a time until it
reaches zero.

Camera control lost.

A timeout occurred while the Viewer was
controlling the camera or another user with higher
priority requested camera control. Displayed for
three seconds.

No recorded video.

Displayed when playing back a recording if there
is no recorded video at the current playhead
position.

Cannot Connect to the Storage Server.

Displayed when you cannot connect to the Storage
Server to play back a recording.

Please wait.

Displayed when it may take some time to display
an MPEG-4 or H.264 live/recorded video.

Could not connect to send audio.

A connection for sending audio to the camera
could not be established, so audio cannot be sent
to the camera.

Could not connect to receive audio.

A connection for receiving audio from the camera
could not be established, so audio cannot be
received from the camera.

You do not have permission to view the live video.

The administrator has prohibited the display of live
view.

9
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Connecting to camera.
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 Warning Messages in the Viewer
Message
Viewer window

The time on this machine is out-of-sync with the
time used by the storage server group. This
causes problems with the display of events. To
correct this problem, please synchronize the time
of this machine to the server group.

There is a time difference of 5 seconds or longer
between the Storage Server and the Viewer
computer. Adjust the system time of the Viewer
computer to the time of the Storage Server.
This message is not displayed if the [Send
notification when time is out-of-sync with the
storage server group] checkbox is cleared in the
[Viewer Settings] dialog box (p. 64).

Event notification

Invalid E-mail Address.

Characters other than alphanumeric characters
and the underscore (_) were entered for the e-mail
address.

The SMTP server port is invalid. Please specify a
value between 1 and 65535.

An invalid SMTP server port number was entered.

The POP server port is invalid. Please specify a
value between 1 and 65535.

An invalid POP server port number was entered.

The user name already exists.

Tried adding a user to the Storage Server with a
name that already exists.

Unable to change the user name. The user '<user
name>' already exists.

Tried adding a user name on the Storage Server to
a name that already exists.

Please ensure that the password and confirmation
match exactly.

The password in the [Confirm Password] field does
not match the user password.

Are you sure you want to remove this user?

Tried to delete a user.

The number of connecting viewers has exceeded
the recommended number, and the recording
server is under high load.

Tried connecting 7 or more Viewers at one time.

Configuration

The value for maximum must be greater than or
equal to 1 day.

Tried to specify less than one day for the maximum
storage period.

Adding a recording schedule

Streaming for recording is applied only when the
following conditions are satisfied:
– the video stream format is JPEG
– the frame rate settings do not exceed 10 fps
– there is no existing recording-mode stream in
the camera.

Tried to enable a recording-mode stream.

User management
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Cause

Error Messages

 Error Messages in the Viewer
Message
Recording schedules

Viewer window

Adding and editing a camera

This schedule item overlaps a previously
scheduled item. Please check your settings and try
again.

Recording schedules overlap.

Recording schedule items must be set at least 15
minutes long. Please check your settings and try
again.

Tried to set a schedule with a period shorter than
15 minutes.

Recording schedule items cannot be created for
the following cameras because of a clash with
existing schedules: <camera name>

Tried to drag a recording schedule window to add
multiple recording schedules, but one camera has
a conflicting schedule.

Failed to create multiple recording schedule items.
All selected cameras have recording schedule
items that clash with a schedule time range.

Tried to add a recording schedule to multiple
cameras using the [Edit Schedule Item] dialog
box, but the schedule time range clashes with
schedules that are already set on the cameras.

At least one day must be selected. Please check
your settings and try again.

[OK] was clicked without specifying the day of the
week.

At least one recording mode must be selected.
Please check your settings and try again.

[OK] was clicked without selecting the check box
for a recording mode.

You cannot use digital zoom with “Current Camera
Position”.

Tried to specify the digital zoom range and close
the [Edit Schedule Item] dialog box with [Current
Camera Position] selected.

This schedule type has days set up for it to be
used on. These need to be removed before
deleting the schedule type.

Tried to delete the special day schedule that has
scheduled days.

This day has already been set as special day
schedule '<schedule name>'. Do you want to
delete the day from the special day schedule
'<schedule name>' and use it in this schedule?

Tried to use dates that are already used for another
special day schedule.

Special day schedules cannot be set the end time
which is earlier than the start time.

Tried to register a schedule that goes past 24:00.

A schedule with this name already exists.

Tried to add a special day schedule with a name
that already exists.

Communication with the SSG “<storage server
group name>” has failed. To ensure that event and
video data are available from this SSG, identify and
resolve the problem and then press [OK] to
reconnect to the SSG. If you press [Cancel], then
some event data including all future events for
cameras recording to this SSG will not be
available.

A problem occurred when connecting to the
Storage Server to display a Viewer window.

Do you want to save changes to this layout?

Tried to close a layout that was modified.

Cannot save it in this folder.

The Windows folder or the Program Files folder
was specified as the destination folder for
snapshots.

This will replace an existing layout of the same
name. Are you sure you want to continue?

Tried to save a layout sequence to a folder that
contains a layout or a layout sequence with the
same name.

This layout cannot be saved using the same name
as an open layout. Please try again using a
different name.

Tried to save a layout using the same name as
another layout that is open in another tab or
window.

Could not connect to camera. Please verify that the
host name, port number, user name and password
are correct.

Could not connect to the camera.

Are you sure you want to remove the camera
'<camera name>'? If the camera is removed, you
will not be able to play back recorded video.

Tried to delete a camera.
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Special day schedules

Cause
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Message
Saving the specified video

[Organize Layouts and
Layout Sequences] dialog
box
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Cause

The length of the extracted video must not exceed
1 hour.

Tried to make the time longer than 1 hour.

Unable to extract video. There is no video data in
the specified timeframe.

Could not save video because there was no
recorded video in the selected segment.

Cannot save it in this folder.

The Windows folder or the Program Files folder
was specified as the destination folder for a .mov
file.

You cannot move the layout <layout name>
because it is contained in the current layout
sequence.

Tried to move a layout that is registered to the
layout sequence currently in use.

You cannot move the layout '<layout name>'
because it is the current layout.

Tried to move the current layout.

You cannot delete the layout <layout name>
because it is the current layout.

Tried to delete the folder that contains the current
layout or the current layout and layout sequence.

Unable to change layout name. The name <layout
name> already exists.

Tried to rename a layout using the same name as
an existing layout.

You cannot move the layout sequence <layout
sequence name> because it is the current layout
sequence.

Tried to move a layout that is registered to the
layout sequence currently in use.

You cannot delete '<layout name>' because it is
used by the current layout sequence.

Tried to delete a layout that is part of the current
layout sequence.

You cannot delete the layout sequence '<layout
sequence name>' because it is the current layout
sequence.

Tried to delete the current layout sequence.

You cannot move the folder <folder name>
because it contains an open layout sequence.

Tried to move the folder that contains the layout
sequence currently in use.

You cannot move the folder <folder name>
because it contains an open layout.

Tried to move the folder that contains the current
layout.

You cannot delete the folder <folder name>
because it contains the current layout.

Tried to delete the folder that contains the current
layout.

Unable to create folder. The name <folder name>
already exists.

Tried to create a new folder using the same name
as an existing folder.

Unable to change layout folder name. The <folder
name> already exists.

Tried to rename a folder using the same name as
an existing folder.

You cannot move <folder name> folder because it
contains layout <layout name> used by layout
sequence <layout sequence name> which is
open.

Tried to move a folder that contains a layout
registered to the current layout sequence.

You cannot delete <folder name> folder because it
contains layout <layout name> used by layout
sequence <layout sequence name> which is
open.

Tried to delete a folder that contains a layout
registered to the current layout sequence.

Error Messages

Messages Recorded in the Log Files
 Log File Locations
The Storage Server log files are saved in the following folder on the computer where the server is installed.
<System drive>:\ProgramData\Canon\WebView\NVR30\Log\
Types of Log Files
File Name

Explanation

storage_server_log_0.csv

Log file for the Storage Server

viewer_log_0.csv

Log file for the Viewer

 Error Message List
Messages shown below are recorded in the log file when an error occurs.
Message

Explanation
A temporary file for the configuration file was found, but could not
be renamed.

No configuration file found.

Could not find the Storage Server configuration file.

Cannot delete old config '<file name>', error code <win32 error>

Could not save the configuration.

Cannot rename config from '<temporary file>' to
'storage_server.cfg', error code <win32 error>

Could not save the configuration.

Cannot write to config '{storage server name}

Could not save the configuration.

Configuration file failed consistency check, exiting...

Inconsistency was found in the configuration file. This occurs when
the configuration file is rewritten directly.

Error: Local machine not in the config.

Could not find the IP address or host name of the Storage Server in
the configuration file.

Failed to bind to listen port {port number}

The Storage Server could not bind to the port.

Failed to setsockopt for conditional accept()

Could not apply a socket option to the socket for group
communication.

LS_start_service(apache) failed.

Apache startup failed.

Email Authentication error (<reason>): <host>

An authentication error occurred while sending e-mail.

Email error: recipient is unreachable (<reason>): <host>

A transmission error occurred while sending e-mail.

Email error: server not responding (<reason>): <host>

Could not communicate with the SMTP host while sending e-mail.

Unable to obtain file size on disk, GetFileAttributesEx failed with
error=%d for file %S

Could not determine the size of the media or event file.

CameraServer <host name> disconnected(<error information>)

Could not connect to the camera.
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Cannot rename storage_server.cfg.tmp to storage_server.cfg file
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 Error Codes
Winsock Error Codes
Code

Error Message

Possible Cause

10038

An operation was attempted on something that is not a
socket.

This may occasionally occur. No action is required.

10048

Only one usage of each socket address (protocol/network
address/port) is normally permitted.

All communication resources are in use. This error is
frequently reported when a video can no longer be displayed
in a Viewer layout sequence.

10050

A socket operation encountered a dead network.

Occurs when the computer recognizes that the network is
down because the router or hub closest to the computer is
powered off. Normally, this cannot be recognized, therefore
this error is rarely reported.

10051

A socket operation was attempted to an unreachable
network.

Occurs when other network devices recognize that the
network is down because the router or hub is powered off.
Normally, this cannot be recognized, therefore this error is
rarely reported.

10054

An existing connection was forcibly closed by the remote
host.

The connection was aborted by the camera due to a camera
restart or other causes. This may occur when the camera is
restarted using the restart button on the Setting Page
provided by the camera software. However, this rarely
occurs.

10060

A connection attempt failed because the connected party
did not properly respond after a period of time, or
established connection failed because connected host has
failed to respond.

A timeout occurred in the TCP connection with the camera.
This occurs when the camera is powered off.

10061

No connection could be made because the target machine
actively refused it.

The camera rejected the TCP connection. This occurs when
the port number is incorrect or from another cause.

10064

A socket operation failed because the destination host was
down.

Occurs when the camera is powered off. Normally, 10060
occurs.

10065

A socket operation was attempted to an unreachable host.

There is no route for connecting to the camera. This may also
occur when there is a failure in the network cable connected
to the computer or hub.

10091

WSAStartup cannot function at this time because the
underlying system it uses to provide network services is
currently unavailable.

There is a failure on the computer’s network adapter.

11001

No such host is known.

The host name could not be resolved in the DNS.

11004

The requested name is valid, but no data of the requested
type was found.

The host name could not be resolved in the DNS.

SMTP Error Codes
Code
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Error Message

Possible Cause

421

<domain> Service not available, closing transmission
channel

The communication was terminated because the mail server
was stopped.

450

Requested mail action not taken: mailbox unavailable

The requested mail processing was not performed because
the mailbox is not available.

451

Requested action aborted: local error in processing

The requested operation was canceled because an error
occurred in the mail server.

502

Command not implemented

The mail server does not support the command that was
sent.

550

Requested action not taken: mailbox unavailable

The request was not executed because the mailbox is not
available.

Error Messages

HTTP Error Codes
Code

Error Message

Possible Cause

401

Unauthorized

The user name and password for connecting to the camera
is incorrect.

403

Forbidden

A connection cannot be established due to an IP address
restriction on the camera. This may also be returned by a
proxy server.

500

Internal Server Error

Occurs when the HTTP server is running but the Storage
Server is not started. It may also occur during normal
operation if the camera is restarted.

503

Service Unavailable

Occurs when the camera is temporarily unable to process
requests due to server overload (excessive requests from
multiple clients), or an uncompleted start-up process on the
camera, or other reasons.

wininet Error Codes
Code

Error Message

Possible Cause

The request has timed out.

A request timeout occurred. Indicates that the connection or
request transmission failed.

12005

The URL is invalid.

The URL is incorrect. Normally, this does not occur, however,
it may occur when an attempt is made to connect to an
unsupported camera.

12007

The server name could not be resolved.

The host name could not be resolved. This error is generated
when a host name that is not registered in the DNS is
specified or when a problem occurred in communication with
the DNS itself.

12017

The operation was canceled, usually because the handle on
which the request was operating was closed before the
operation completed.

The communication was canceled. This error does not
indicate a problem and may be generated during normal
operation.

12029

The attempt to connect to the server failed.

The connection to the camera failed. Normally 12002 is
generated.

12030

The connection with the server has been terminated.

The connection to the camera has been aborted. The
disconnect process itself is recorded when it executes
normally.

12031

The connection with the server has been reset.

The connection to the camera has been reset.
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12002

POP Error Messages
Error Message

Possible Cause

ERR never heard of mailbox name

The e-mail address is incorrect.

ERR invalid password

The password is incorrect.

ERR unable to lock maildrop

The mailbox cannot be used. It is already in use by another program.
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Event Information
Event Information

132

Displayed Message

Motion Detection

[Motion On] or [Motion Off]

Sensor Recording

[Sensor On] or [Sensor Off]

Record Now

[Manual Recording Started] or [Manual Recording Stopped]

Intelligent Function

[Intelligent Function On] or [Intelligent Function Off]

Volume Detection

[Volume Detection On] or [Volume Detection Off]

Recording

[Recording Started] or [Recording Stopped]

Change in the recording frame rate

[Recording Frame Rate reduced due to high load issues] or [Reverted to the
Recording Frame Rate due to resolution of high load issues]

Low Disk Space Warning

[Warning: Files deleted due to low disk space]

Delete recorded files (when disk space is insufficient)

[Delete recorded files (when disk space is insufficient) started] or [Delete
recorded files (when disk space is insufficient) stopped]

Delete recorded files (when disk space is low)

[Delete recorded files (when disk space is low) started] or [Delete recorded files
(when disk space is low) stopped]

Suspending/Resuming Recording

[Recording Suspended] or [Fixed: Recording Resumed]

Camera Communications Error

[Error: Cannot Connect to Camera] or [Connection to Camera Fixed]

Storage Server Starting/Stopping

[Storage Server Started] or [Storage Server Stopped]
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❏ Creating a shortcut icon
❏ Camera maintenance
❏ Checking the version
❏ Limitations for MPEG-4 and H.264 formats
❏ Using AXIS models

Create a Shortcut Icon for Starting the Viewer
You can configure the way the Viewer starts up, for
example, to have it bypass the login screen with the user
name and password (pp. 45, 46) by creating a shortcut
icon that specifies Viewer startup options.

2

Right-click the shortcut icon and select [Properties].

3

On the [Shortcut] tab, add a startup option to [Target].

Important
• You cannot reconfigure the shortcut icon that is automatically
created on your desktop when you install this software.
• The login password can be easily viewed in the properties of
the shortcut icon. Make sure to take sufficient security
measures when using this feature.

1

Startup Options

Description

-group nvr://
<username>:<password>@<
storage server group name>

The information in the options
is used to connect to the
server group and start the
Viewer, without displaying the
[Connect to Storage Server
Group] dialog box on startup.

Right-click [Viewer.exe] in the installation folder and
click [Create shortcut].

4

Click [OK] to close the dialog box.

[Viewer.exe] is located in the following folder by
default:
<System drive>:\Program Files\Canon\WebView\
NVR30

5

Move the shortcut icon to a location you prefer.

Note
• <System drive> corresponds to the drive containing the
system files of the operating system. If the operating system is
installed on the C drive, the system drive is the C drive.
• A message may appear asking whether or not you want to
create a shortcut icon on the desktop. Click [OK] if you want to
create the desktop icon.

Changing the Storage Server IP Address
When the IP address of a computer that has a Storage
Server installed on it changes, the IP address of the
Storage Server must also be changed.

1

Select [RM Storage Server] from [Control Panel] >
[System and Security] > [Administrative Tools] and
stop the service.

2

Open the command prompt using [Run as
administrator], enter the “storage_server.exe”
command name and option (-resethost=“IP address”),
and execute the command.
Example: 64-bit OS
“c:\Program Files (x86)\Canon\WebView\NVR30\
storage_server.exe”-resethost=XXX.XXX.XXX.XXX
Example: 32-bit OS
“c:\Program Files\Canon\WebView\NVR30\
storage_server.exe”-resethost=XXX.XXX.XXX.XXX
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Enter the IP address the computer changed to for
“XXX.XXX.XXX.XXX”.

3

Select [RM Storage Server] from [Control Panel] >
[System and Security] > [Administrative Tools] and
start the service again.

• To stop or start the service from the control panel,
select [RM-Lite Storage Server].
• When executing the command, enter
“storage_server_rm_lite.exe”.

Camera Maintenance
About the Latest Camera Firmware
You can find the latest firmware and configuration backup
and restore tools for cameras that are supported by this
program at the Canon Web site.

Update the Firmware
To update the firmware for your camera, you must use the
tool that is specific to your camera model.
Download the latest firmware with the Firmware
Upgrade Tool, and download the Backup Tool and
Restore Tool.

2

Back up the camera configuration using the Backup
Tool.

3

Update the firmware using the Firmware Upgrade
Tool.

Appendix

1

Note
If the firmware update fails, restore the configuration using the
Restore Tool.
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How to Check the Version
The steps below explain how to check the version of this
software.

Checking the Version of the Storage Server

1

Click the Start button > [Control Panel] > [Uninstall a
program] or [Add or Remove Programs].

2

Check the version of the software in the displayed list.

Checking the Version of the Viewer

1

Start the Viewer.

2

Click [Help] > [About].

3

Check the version of the software on the displayed
dialog box.

Functional Limitations for MPEG-4 and H.264 formats
The VB-C60, VB-C500D, and VB-C500VD support
MPEG-4 format, while the VB-S30D, VB-S31D, VB-S800D,
VB-S900F, VB-S805D, VB-S905F, VB-H43, VB-H630VE,
VB-H630D, VB-H730F, VB-H41, VB-H610VE, VB-H610D,
VB-H710F, VB-M42, VB-M620VE, VB-M620D, VB-M720F,
VBM40, VB-M600VE, VB-M600D, and VB-M700F support
the H.264 format. Note that the following limitations apply.
Live View
• The following video window settings cannot be set, and
the frame rate settings on the camera are enabled.
– Maximum Frame Rate
– Auto Adjust Frame Rate
• Synchronization of audio and video is not guaranteed.
Recording
• The frame rate settings on the camera are enabled.
• The [Reduce recording frame rate when disk is under
high load] setting in the Storage Server Group Settings
is disabled.
• The [Record Now] option only supports JPEG format.
You cannot use this option to record video in MPEG-4
format or H.264 format.

Important
Only H.264(1) video can be displayed and recorded. The
software does not support H.264(2) video, even if using a
camera that does support H.264(2).
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Playback
• You can perform the following operations. However,
you cannot use [Fast Reverse], [Previous Frame], and
[Next Frame].
– Specify the playback time on the timeline
– Start playback from the live event display window
and the event search window
– You can use [Pause], [Fast Forward], [Previous
Event], and [Next Event]
• If you change the recording format of a recording
schedule from MPEG-4 or H.264 to JPEG part of the
way through the recording, then when you reverse the
recording, the video disappears when you transition
from the JPEG segment to the MPEG-4 or H.264
segment, and the “No Recorded Video” error message
is displayed.
• Recordings in MPEG-4 and H.264 format recorded with
this software can only be played back with this
software. However, you can use [Extract Video] to save
the recording as a .mov file and use QuickTime or other
compatible software to play back the recording.

Using the AXIS Q7404/Q7401
For setting details for the AXIS Q7404/Q7401, see the user manuals and safety precaution manuals included with each
product.

Supported Firmware
The following firmware is necessary when using the AXIS Q7404/Q7401.
Video Encoder

Firmware

AXIS Q7404

Ver.5.20

AXIS Q7401

Ver.5.20.3

Usage Precautions

Appendix

• When registering the AXIS Q7404/Q7401 in RM-64/25/9, you must enter the host name, and the Administrator group
account user name and password just as with other cameras.
• Register one AXIS Q7404/Q7401 at a time. You cannot search and register them.
• If the number of simultaneous accesses to the AXIS Q7404/Q7401 increases, it may affect the recording or live video
frame rates. Be sure to test sufficiently before beginning operation.
• A maximum of 20 clients can connect to the AXIS Q7404/Q7401. If the number of connecting clients exceeds 20, a
message stating you cannot connect to a camera will appear when you try to open an RM-64/25/9 video window.
• If the AXIS Q7404/Q7401 is not connected to a camera, or if the input signal is lost, such as an interruption of the camera
connection, [NO VIDEO] will appear on the screen of RM-64/25/9.
• Video size and video quality cannot be set with RM-64/25/9. Available video sizes are 160 x 120, 320 x 240, and
640 x 480.
• If [Aspect ratio correction] is not selected in the AXIS Q7404/Q7401’s [Image] tab of the [Video Stream Settings], the
displayed video will be slightly compressed horizontally. We recommend that you select [Aspect ratio correction].
• Reboot the AXIS Q7404/Q7401 if you use it to change settings.

Functional Limitations
The following limitations apply to the AXIS Q7404/Q7401 when using RM-64/25/9.
Recording Schedule and Recording Mode Settings
• Only continuous recording can be used.
• The following functions are disabled in the [Edit Schedule Item] dialog box.
– [Record audio if available]
– [Advanced]
– [Use the recording-mode stream]
Frame Rate
• The AXIS Q7404/Q7401 frame rate setting has no effect on the recording frame rate or live frame rate settings of RM-64/
25/9. Set the frame rate with RM-64/25/9. Only integer values for the frame rate are available in this case (minimum 1 fps).
• When four cameras are connected, you may not be able to record or play back video at the maximum frame rate
(30 fps).
Auto Adjust Frame Rate Function
Regardless of the RM-64/25/9’s setting in [Auto adjust frame rate under heavy load] in [Viewer Settings], the Auto adjust
frame rate function is always not available.
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Video Format
Only JPEG is available for recording or live view.
Camera Limitations
• Even if a camera has pan/tilt/zoom functions, they cannot be operated via the RM-64/25/9 control panel if the camera is
connected to an AXIS Q7404/Q7401.
• The control panel’s [Presets] is disabled.
Audio
• Audio input/output is not supported.
• Even if you select the AXIS Q7404/Q7401’s video window, the audio panel will be disabled.
Text Overlay Settings
The AXIS Q7404/Q7401 text overlay settings (date, time, text, video in video display) cannot be set with RM-64/25/9. In
addition, the text overlay settings time display and RM-64/25/9’s time display are not synchronized.
Sensor Input Terminal
The input terminals for the AXIS Q7404/Q7401 cannot be used.
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